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Form No. 008-42104-00

WARRANTY
MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument manufactured by it to be free from defects in material and workmanship impairing its usefulness
under normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts, when returned prepaid to us, and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for
warranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory
inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary
practice, the repair or replacement of such of his products that may prove defective in workmanship or
materials. Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This
states our entire liability in respect to such products, except as an authorized person of MICROMERITICS
may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the
discretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects.
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or
manufactures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to the implied warranties of merchantability or fitness for use.

One Micromeritics Drive         Norcross, GA 30093-1877   Fax (770) 662-3696

Domestic Sales - (770) 662-3633                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
Rev. 12/95
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Organization of the Manual SediGraph 5120 Operator’s Manual
Organization of the Manual

This manual describes the proper installation and operation of the SediGraph 5120 Particle 
Size Analysis System. It is organized so that all procedures are conveniently located in 
Chapter 3. Chapters 5, 6, 7, and 8 are reference chapters should you need additional 
information while performing these procedures. 

This manual is organized as follows:

Chapter 1 GENERAL INFORMATION

Provides a general description of the SediGraph 5120 analysis 
system, its features and specifications.

Chapter 2 USER INTERFACE

Provides a description of the controls and indicators on the analyzer 
and provides general information about using the 5120 application 
software.

Chapter 3 OPERATIONAL PROCEDURES

Provides procedures for the operations performed with the SediGraph 
5120.

Chapter 4 SOFTWARE AND SETUP MODIFICATIONS

Provides procedures for installing 5120 application software updates 
and for modifying the application setup.

Chapter 5 FILE MENU

Provides a description of the options contained on the File menu.

Chapter 6 UNIT MENU

Provides a description of the options contained on the Unit menu.

Chapter 7 REPORTS MENU

Provides a description of the options contained on the Reports menu.

Chapter 8 OPTIONS MENU

Provides a description of the options contained on the Options menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE

Provides user maintenance and service information.

Chapter 10 ORDERING INFORMATION

Provides ordering information for the SediGraph system components.
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Appendix A ERROR MESSAGES

Lists the error messages displayed by the SediGraph 5120 analysis 
program; includes a cause and action for each.

Appendix B SAMPLE DISPERSION 

Provides methods for dispersing samples.

Appendix C CHEMICAL AIDS FOR PARTICLE DISPERSION

Provides a list of dispersants and their active ingredients.

Appendix D STOKES’ LAW

Provides calculations for Stokes’ Law.

Appendix E SEDIMENTATION THEORY

Provides theoretical information on the sedimentation method.

Appendix F SEDIGRAPH RESULTS RELATIVE TO OTHER METHODS

Provides the relativity of SediGraph results to other methods.

Appendix G LIQUID DENSITY AND VISCOSITY DATA

Provides density and viscosity data for common dispersants.

Appendix H SOURCES OF DISPERSING AIDS

Provides a list of suppliers for common dispersants.

Appendix I SEDISPERSE PARTICLE DISPERSION LIQUIDS

Provides information on Sedisperse dispersing liquids.

Appendix J DATA REDUCTION

Contains the calculations used for producing reports.

Appendix K SEDIGRAPH X-RAY SAFETY INFORMATION

Describes the safety features provided with the SediGraph 5120.

Appendix L MASTERTECH INSTALLATION

Describes how to install a MasterTech for use with the SediGraph.

Index INDEX

Provides quick access to subject matter.
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Conventions

Symbols

This document uses the symbols shown below to identify notes of importance, cautions, and 
warnings.

Commands

Menu Commands

Menu commands are the commands selected from the main menu and its submenus. 

Menu commands are represented in this manual as shown in the following example:

• Select Unit1 > Rinse > MasterTech.

Which means, select Unit1 from the main menu, select Rinse from the Unit 1 menu, then 
select MasterTech from the Rinse submenu.

 Notes contain a tip or important information pertinent to the subject matter.

Cautions contain information to help you prevent actions which could damage the 
instrument.

Warnings contain information to help you prevent actions which could cause 
personal injury.
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Push Buttons

The dialog boxes contain buttons, referred to as push buttons, which execute a command or 
display another dialog. For example, the Cancel button cancels any entries you made in the 
dialog.

In this manual, push buttons are represented by the bold type font shown in the following 
example:

Select Dates to enter a range of dates to be included in the selection criteria.

 

 Push Buttons
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Equipment Description

SediGraph 5120

The SediGraph 5120 Particle Size Analysis System consists of up to two particle size 
analyzers, and a multi-function computer. The particle size analyzer is mounted on adjustable 
feet and contains a level indicator so that accuracy of the analysis process is maintained. It is 
designed for completely automatic operation; however, a sliding transparent door on the front 
panel provides convenient observation of, and access to, the temperature-controlled analysis 
compartment. 

The SediGraph contains an internal fixed-position X-ray source, detector assembly, and a 
vertical cell movement assembly. It incorporates a complete system for circulation of 
sedimentation liquid and particle sample mixture between the cell, the external mixing 
chamber, an external rinse liquid container, and an external waste container. It also contains a 
detachable magnetic stirring assembly.
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MasterTech 052

The MasterTech 052, an automatic sampling device that operates in conjunction with the 
SediGraph 5120, is also available. The MasterTech allows you to “queue up” as many as 18 
predispersed samples to run consecutively and unattended. It allows samples to be redispersed 
either by stirring only or by stirring and disruption with an ultrasonic probe. The MasterTech 
transfers each sample to the SediGraph, then after analysis is complete, rinses the mixing 
chamber, the connecting tubing, and the stirrer.

The MasterTech 052 consists of three main components: the arm assembly, the body, and the 
beaker tray. The arm assembly controls the movement of the stirring rotor, the ultrasonic 
probe, and the transfer tube. The body houses the electronics, the transfer pump, the front 
panel controls, and supports the beaker tray, which holds up to 18 sample beakers.

During operation, the beaker tray is loaded with beakers containing 60 to 80 mL of 
predispersed sample. When the SediGraph is ready for a sample, the tray rotates until the 
correct sample is underneath the head of the arm assembly. The head then lowers until it rests 
on top of the beaker. Stirring action begins and continues for a user-specified length of time. If 
desired, the ultrasonic probe can be activated to aid in redispersion.

When redispersion is complete, the pump transfers most of the sample to the SediGraph, 
where it is loaded into the mixing chamber. Analysis now proceeds as if you had filled the 
mixing chamber manually with predispersed sample. When analysis is complete, the contents 
of the mixing chamber are disposed to the waste container, and a small amount of rinsing fluid 
is back-flushed to the MasterTech to rinse the tubing. The arm rises so that the rinse liquid 
removes the sample residue from the stirrer blades and transfer tube. Once rinsing is complete, 
the arm rises to the Up position. The MasterTech is now ready to proceed to the next sample.

Windows® Interface

The SediGraph 5120 analysis program is designed to operate in the Windows environment. 
This makes operation of the SediGraph 5120 easier and allows you to run other applications 
while an automatic operation is in progress. If you are new to Windows, you should learn 
some basic Windows skills, such as using the mouse and choosing commands. Brief operating 
instructions are provided in “Using the Software” on page 2-9.  More specific instructions are 
provided by Windows in an online tutorial. 
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Online Manual

For your convenience, the Operator’s Manual is available online. You can access the manual 
by selecting Help, then Operator’s Manual from the analysis program main menu. The 
manual appears in an Adobe® Acrobat® Reader®.

Following are some tips to help you quickly locate the information you need in the manual. 
Refer to the Adobe Acrobat Help system (click the Help button on the Acrobat menu) for 
more information on the Acrobat features you can use while viewing the manual.

Using Bookmarks

Click the Bookmarks tab to list and access the topics included in the manual.

You can use the  +  and    buttons next to topics as they are used in Windows Explorer to 
expand or collapse the topic list.

Navigation Pane Topic Pane

Bookmarks

Topics
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To display a topic, click the topic name in the Bookmarks section. The related information 
appears in the topic pane of the window as shown in the following example.

 

 

Click bookmark
to display topic.
1-10                                                    512-42801-01 (Rev L) Apr 2022



Online Manual SediGraph 5120 Operator’s Manual
Using the Table of Contents, Index, and other Links

Links provide direct access to selected information. All links appear in blue type. Links are 
contained in:

• the table of contents
• index entries
• cross-references within the manual 

Table of Contents

To display the table of contents, click Table of Contents in the Bookmarks section. When the 
table of contents is displayed, you can click an entry to display its associated page. For 
example, clicking Using the Software in the table of contents, displays the page containing 
information about the software.

 

Click topic name in 
table of contents to 
display topic.
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Index

To use the index in the online manual, click the Bookmarks tab, scroll down to INDEX (the 
last topic in Bookmarks), then click the + button to expand the index. The letters A through Z 
are displayed. Click a letter to display its corresponding index entries as shown in the 
following example.

After you display the entries, locate the item of interest and click on the page reference to 
access the information.

Cross References

Cross-references work in the same manner. In the example below, clicking on the cross-
reference, FILE MENU (shown on the screen in blue type) will display the first page of the 
chapter describing the commands found on the File menu.

FILE MENU

Provides a description of the commands available on the File menu.

Click a letter to display 
its index entries.
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Using the Find Command

The Adobe Acrobat Find command provides another method of easily accessing specific 
information. For example, suppose you want to know how the Save as command works. You 
could select Edit > Find from the Adobe Acrobat menu, then enter Save as in the Find dialog. 
The following example shows the results.
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Printing

You can print the entire manual, a selected page, or range of pages. There are several options 
for printing. You can:

• Select the printer icon ( ) on the Adobe Acrobat toolbar.

A standard Print dialog is displayed. Select the page(s) to print, then click OK. When using 
this option (or the next one), be sure to enter the page number(s) displayed in Adobe 
Acrobat; do not use the page number(s) listed in the footer(s) of the manual.

• Select File > Print. 

A standard Print dialog is displayed. Select the page(s) to print, then click OK.

• Click the Thumbnails tab.

Thumbnails of manual pages are displayed.

a. Click the pages you want to print.

b. Right-click to display a shortcut menu, then select Print Pages.

c. A standard Print dialog is displayed; click OK.

Enter 
this 
number.

Do not use 
number in 
footer of the 
manual.

Thumbnails 
tab
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Specifications

The SediGraph 5120 Particle Size Analysis System has been designed and tested to meet the 
specifications provided below.

 

Characteristic Specification

                                            
                                                  ANALYZER

Particle Diameter Range 300 to 0.1 m Equivalent Spherical Diameter

Resolution The sedimenting sample is scanned by a narrow x-ray 
beam - less than 0.2% of the total distance scanned - 
permitting high resolution.

Wetted Materials Stainless steel, Teflon® impregnated anodized 
aluminum, nickel plated aluminum, nylon, 
polypropylene, polystyrene, Tygon® tubing, tungsten 
carbide, Ertalyte®, Viton®, Kalrez®, glass, and epoxy.

Sample Size 50 mL of dispersed sample; precise concentration is 
not required

Suspending Liquids Any liquid compatible with sample cell materials and 
not highly absorptive of X-rays (typical liquids are 
water, glycols, mineral oils, Sedisperse®, and 
alcohols)

Voltage 85 to 264 VAC

Frequency 47 to 63 Hz

Power 450 VA

Temperature Ambient +10 to 40 °C, operating; 
-10 to 55 °C, storing or shipping

Humidity Up to 90% relative (non-condensing); 20 to 80% for 
computer and components

Physical Height: 52 cm (20.5 in.)
Width: 50.5 cm (20 in.)
Depth: 58 cm (23 in.)
Weight: 43 kg (95 lb)
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Characteristic Specification

                                            
                                                 COMPUTER

Minimum requirements Pentium 333 MHz or equivalent
One CD-ROM drive
128 megabytes of RAM
1-gigabyte hard drive
SVGA monitor (800 x 600 video display capability)

Windows® XP or 2000
One RS232 serial port for each attached instrument
Mouse

                                            
                                                MASTERTECH

Sample Capacity      18 per tray; continuing indefinitely if tray is
     replenished

Sample Size      0.001 to 4 g powder in 60 to 80 mL of liquid

Suspending Liquid      Any liquid compatible with wetted materials (typical
     liquids are water, glycols, mineral oils, alcohols,

     SediSperse®, (and mineral spirits)

Wetted Materials      Stainless steel, Viton®, Tygon®, silicone rubber,
     polypropylene

Voltage      100, 120, 220 or 240 VAC +10%

Fuse       2A (100/120 VAC); 1A Type T, Slow-Blow (220/
     240 VAC)

Power      250 VA

Frequency      50/60 Hz.

Temperature      10 to 40oC, operating: -10 to 55oC, storing or shipping

Humidity      20 to 80% relative (non-condensing)

Physical      Height: 71 cm (28 in.)
     Width: 46 cm (18 in.)
     Depth: 53 cm (21 in.)
     Weight:18 kg (40 lbs)
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Overview

This chapter contains:

• a description of the controls and indicators located on the SediGraph and the MasterTech. 

• instructions for turning the analyzer on and off. 

• a description of common software features. 

• a description of the accelerator keys that can be used with the SediGraph application. 

• instructions for selecting sample information files.

• SediGraph application file name conventions.

• a description of the SediGraph application menu structure and descriptions of the Win-
dows and Help menus.
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Controls and Indicators

The SediGraph 5120 system is fully automatic. The computer is used to enter operational 
information and view system status. There are, however, controls and indicators on the 
SediGraph and MasterTech with which you should become familiar.

SediGraph 5120

Front Panel

X-RAY STATUS Displays the status of the X-ray system.

  X-Ray STANDBY
  indicator

Illuminates when the SediGraph is on and the X-ray 
keyswitch is turned to the standby position, when the door 
to the analysis compartment is open, or when the fan or 
pump is not operational. 

   X-RAY ON indicator Illuminates when X-rays are being generated. The X-ray 
keyswitch must be turned to the X-RAY ON position. 

X-Ray Keyswitch Sets the X-ray to either the On or Standby position.

X-Ray
Standby
Indicator

X-Ray
On
Indicator

X-Ray
Keyswitch

Pump
Control
Switch

Mixing Chamber
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Side Panel

Pump Control Off/Auto 
switch

Selects the operational mode of the mixing and cell 
pumps.

The Off position turns off power to the pumps. The Auto 
position places the pumps in automatic mode.

Mixing Chamber Contains the sample during an analysis and maintains 
sample dispersion throughout the analysis with a built-in 
stirrer.

ON/OFF switch Turns electrical power to the SediGraph on and off. Place 
the switch in the up ( | ) position to turn on the SediGraph 
and in the down (O) position to turn off the SediGraph.

MasterTech RS232 Used to connect the MasterTech to the SediGraph.

RS232 Used to connect the computer to the SediGraph.

MasterTech
Connector

RS232 Connector

Power ON/OFF
Switch
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MasterTech 052

Front Panel

Power Display Displays the power being generated by the ultrasonic 
probe.

ULTRASONIC PROBE
AUTO/ON switch

LEDs on the switch indicate the mode of operation.

The AUTO position places the probe under automatic 
control.

The ON position turns on the probe. Remove the probe 
from its holder and place it in the liquid before turning on 
the probe.

Never turn the probe on unless the tip is submerged in liquid.

After using the probe, press the switch again to place the 
probe in automatic mode. Then replace it in its holder.

INTENSITY control Turn the control clockwise to increase the intensity of the 
probe. Turn it counterclockwise to decrease the intensity.

ARM AUTO/LOAD switch The LEDs on the switch indicate the mode of operation.

Do not press the ARM AUTO/LOAD switch while an automatic operation is in 
progress.

Power Display
Intensity Control

Pump Auto/Off
Switch

Ultrasonic Probe     Arm Auto/Load
Auto/On Switch       Switch
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Rear Panel

The AUTO position places the arm under automatic 
control.

The LOAD position raises the arm when you want to 
remove or load the tray.

This switch will not work unless the computer is installed 
and the SediGraph software is operating.

The MasterTech will not operate if the arm is in the Load 
position, so be sure to release the LOAD switch when you 
have finished removing or loading the beaker tray.

PUMP AUTO/OFF switch The LEDs on the switch indicate the mode of operation.

The AUTO position places the pump under automatic 
control.

The OFF position turns off power to the pump.

+5 and +24 VDC Indicators

      Power ON/OFF Switch
 

RS232 Connector

POWER ON/OFF switch Turns the MasterTech on and off.

The down (O) position turns off the MasterTech.

The up ( | ) position turns on the MasterTech.

+5 and +24 VDC indicators Illuminate when appropriate power is present in the 
MasterTech.

RS232 connector Used to connect the MasterTech to the SediGraph.
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Turning On and Off the Analyzer

Turning On the Analyzer

1. If not already on, turn on the computer to which the analyzer is connected. 

2. Place the PUMP CONTROL switch (located on the front panel) in the AUTO position.

3. Place the SediGraph ON/OFF switch (located on the side panel) in the ON ( | ) position. 

4. Insert the X-ray key into the X-ray keyswitch. Then turn the switch to the X-RAY ON 
position.

5. Wait 30 minutes for the SediGraph to warm up before performing an analysis. 

Turning Off the Analyzer 

1. Select Close from the System menu or Exit from the File menu.

If an analysis is in progress, the following message is displayed:

               Instrument is busy. Continue program exit? 

Even if you click Yes and the analysis program closes, the analysis continues and data 
continue to be collected. Reports that are queued under the Print Manager will print. If, 
however, a power failure occurs and an uninterruptible power supply (UPS) is not 
attached, the data collected after exiting the analysis program are lost.

2. Place the computer, monitor, and printer ON/OFF switches in the OFF position.

3. Place the SediGraph ON/OFF switch in the OFF (O) position.

It is recommended that the analyzer remain on unless it is going to be idle for a 
period of more than 24 hours. Leaving the analyzer on helps prolong the life of its 
major components.

Always exit the analysis program and Windows before turning off the computer. 
Failure to do so could result in loss of data.
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Using the Software

The SediGraph 5120 analysis program operates in the Windows environment and requires 
familiarity with standard Windows operations such as using the mouse, menus, and dialog 
boxes. This manual provides brief instructions for standard operations; however, you may 
need to refer to your Windows documentation or the Windows tutorial to clarify functions 
which are specific to Windows. Since most SediGraph 5120 operators use a mouse, this 
manual is written for mouse-driven operations. 

Mouse 

Use the mouse to select items displayed on the screen. Simply move the mouse pointer to the 
item you wish to select and click the left mouse button once.

When selecting files, move the mouse pointer to the file you wish to select and click the left 
mouse button twice (double-click). You also may click just once, then click OK or press Enter. 

Use the mouse also to display drop-down menus for items contained on the instrument 
schematic. Move the mouse pointer to the item you wish to select and click the right mouse 
button once.

Keyboard

Accelerator (or shortcut) keys may be used instead of, or in addition to, a mouse. With the 
main menu displayed, simply press the accelerator key(s) for the function desired. For 
example, if you wish to open a Sample Information file, press F2 and the Open Sample 
Information dialog box is displayed. You may also access any function that contains an 
underlined letter by pressing Alt plus the underlined letter. For example, to access the File 
menu, simply press Alt, then F.

The following table lists the accelerator key(s) which you may use for operating the 
SediGraph 5120 Analysis program.
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Accelerator
Key(s)

Function

F1 Access online manual

F2 Open a sample information file

F3 Open an analysis conditions file

F4 Open a liquid properties file

F5 Open a report options file

F6 Tile windows

F7 Cascade windows

F8 Start report

F9 Cancel report

Alt + F4 Exit the analysis program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List liquid properties files

Shift + F5 List report options files
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Dialog Boxes and Subdialog Boxes

Dialog boxes (referred to as dialogs) are displayed when you select a menu item. Subdialog 
boxes (referred to as subdialogs) are displayed when a push button in a dialog box is selected. 
Both types of boxes may contain one or more of the following:

• Data entry field

These fields may be either numeric (numbers only) or alphanumeric (numbers, letters, or 
printable characters). If you make an invalid entry in either of these fields, an error 
message displays.

• List

A list contains selections from which you may choose one or more items. To select an item 
on the list, position the mouse pointer on the desired selection, then double-click (or press 
the Spacebar). An item is selected if it is preceded with a check mark.

• Push Button

A push button is used to display subdialogs in which to enter additional information about 
the subject matter or to execute a command.

 

This button 
displays the
Reference Dialog

This button executes
the Save command
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• Radio Button

Radio buttons are contained within a group box. These buttons are used to select options; 
you may choose only one item.

• Check Boxes

Check boxes also are used to select options. You may select as many items as you wish.

The following push buttons are common to several dialogs.

Displays a dialog which allows you to select a file for the 
subject matter.

Allows you to copy file values from an existing file into 
the one you are creating. You then can edit the values in 
the new file without changing the ones in the original file.

Saves the information you entered in the dialog.

Cancels the entries you made in the dialog.
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Selecting Files

Sample information is stored in files and saved under file names. Certain dialogs contain a 
Files: list box which displays a list of files available for that particular operation. For example, 
the Open Sample Information dialog:

Sometimes a default file name appears in the File name: field. If you wish to use the default 
name, just click OK. Use one of the following methods if you wish to use another file name:

• Enter a name in the File name: field, the extension .SMP is added automatically.

• From the list of files in the Files: list box, move the mouse pointer to the desired file and 
double-click.

You may limit the list of files displayed in the Files: list box by choosing one of the following:

• Use wildcard characters in the path name you enter in the File name: field. 

Wildcard characters such as * and ? can be used to filter file names. For example, you can 
limit the list of files displayed to those containing Sg0 as the first three characters by 
entering Sg0*.smp.

• Enter a range of dates. Click Dates; the Select Dates dialog is displayed.
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Select the Show Date Range: radio button. This enables the From: and To: fields so that 
you may enter a beginning and ending date. You also may double-click in each field to 
display a calendar to set a date. The range of dates remains the default until you change the 
dates or select Show All Dates.

For convenience, the following function keys are available when the Select Dates dialog is 
displayed:

F2 Clears the field

F3 Inserts the current date

F4 Displays a calendar from which you may select a date

• Select a file status from the Status drop-down list.The table below describes each file sta-
tus.

You may change the date format by using the International Date Format function on 
the Windows Control Panel.

Status Description

All All sample information files in the specified directory and within the 
specified range of dates.

Analyzing Sample information files that are currently being used for analysis.

Complete Sample information files that were used in an analysis that has been 
completed.

Entered Sample information files that contain manually entered data.

No analysis Sample information files that have not been used to perform an 
analysis.
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File Name Conventions

For sample information files, a default file name (the next available sequence number) and a 
default extension are displayed. For Analysis Conditions, Report Options, and Liquid 
Properties files, only a default extension is displayed.

The following table shows the file name extensions for the SediGraph 5120 analysis program.

File Type Extension

Sample Information SMP

Analysis Conditions ANC

Report Options RPO

Liquid Properties LIQ

Export to disk (ASCII) EXP

For conversion from non-Windows SediGraph 5100 DAT

Report to disk RPT

Report (saved from the report window) REP

List to disk LST
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Menu Structure

Main Menu Bar

All functions of the SediGraph 5120 are accessed from the main menu bar. Brief descriptions 
are provided below; refer to the chapter given in parentheses for a detailed description of the 
options contained on that menu.

File
Allows you to manage sample and parameter files. 
(Chapter 5, FILE MENU)

Unit [n] Enables you to perform analyses, measure baselines and 
perform other instrument operations. (Chapter 6, UNIT 
MENU)

This menu does not appear if the analysis program is 
being used for offline data manipulation.

Reports Enables you to generate and cancel reports. 
(Chapter 7, REPORTS MENU)

Options Allows you to edit sample defaults, specify the printer for 
reports, and select data presentation formats. 
(Chapter 8, OPTIONS MENU)

Windows Enables you to arrange the windows and icons on your 
screen. It also displays the names of all open windows. 
(This chapter. Windows Menu)

Help Displays Help information. (This chapter. Help Menu)
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Windows Menu

The Windows menu also displays all open files.

Help Menu

Windows Allows you to arrange your open windows and icons. 

Tile resizes all open windows and arranges them side by 
side.

Cascade resizes all open windows and arranges them in a 
stacked fashion. The active window is positioned on top 
of the stack. Each windows title remains visible, making 
it easier to select other windows.

Arrange icons arranges all minimized icons in an orderly 
manner. 

Operator’s Manual Displays the SediGraph 5120 operator’s manual in PDF 
format.

About SediGraph III Displays information about the SediGraph 5120 analysis 
program.
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Overview

This chapter describes the procedures for entering sample information and sample conditions, 
performing analyses, exporting sample files, converting non-Windows sample files, and 
generating analysis reports. For detailed information about each field and the push buttons 
available in the dialog boxes shown in this chapter, refer to Chapters 5 through 8.

Reading Status Displays

The first topic following the Overview in this chapter describes the upper and lower status 
displays that appear in the operational windows of the system. 

Defining the Default Sample Information File

The 5120 is shipped with a default sample information file, which you may customize to meet 
your laboratory’s requirements. 

The following topic describes how to customize the default sample information file.

Creating Sample Information Files

Sample information files are permanent records of analyses performed with the SediGraph 
5120. Prior to performing analyses, you must create sample information files that contain the 
conditions used to control the analyses. After an analysis, the data collected during the 
analysis (or, optionally, manually entered data) are stored in the file, with the analysis 
conditions. 

You can choose to generate specific reports during an analysis. You can also open the stored 
sample information file at anytime after the analysis and generate reports. 

Topic Refer to page

Status Display 3-7

Topic Refer to page

Defining Sample Defaults 3-10
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You must assign a sample information file to every analysis. A sample information file 
consists of five parts:

• sample identification
• material properties
• analysis options
• report options
• collected/entered data 

Parts of the sample file can also exist as parameter files separate from the sample information 
file itself. These parameter files contain frequently used analysis conditions which may be 
conveniently loaded into a new sample information file. They also may be edited as required.

You can create and store any number of sample information files. Sample information files can 
be:

• created and stored for use by laboratory analysts when performing analyses
• created as needed when performing analyses
• created automatically by performing a Quick Start or MasterTech Automatic analysis

The following topics in this chapter describe how to create sample information files and the 
parameter files contained within them:

Preparing for Analyses

Before you can collect baseline data or perform an analysis, the cell and mixing chamber must 
be drained and the sample (or baseline liquid) loaded.

A baseline measurement must be performed before running analyses. It is not necessary to 
measure a baseline for each analysis; it is recommended, however that you perform a baseline 
measurement once per shift and when you change dispersing agents.

The following topics in this chapter describe how to prepare for analyses:

Topic Refer to page

Creating a Sample Information File 3-14

Defining an Analysis Conditions File 3-22

Defining a Liquid Properties File 3-26

Defining a Report Options File 3-28

Topic Refer to page

Performing a Drain and Load Operation 3-30

Performing a Baseline Measurement 3-32
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Performing Analyses

The SediGraph 5120 provides several methods for performing analyses as described in the 
following table:

After performing an analysis, the system must be rinsed to remove any debris or contaminants 
from the analysis cell. Options are provided that enable you to rinse the SediGraph, the 
MasterTech, or both instruments. Refer to “Performing a Rinse Operation” on page 3-46.

Listing, Exporting, and Converting Sample Files

The SediGraph application contains features that enable you to:

• view and print a list of sample information files.

• export tabular data from sample information files in ASCII format.

• convert sample information files created with the non-Windows version of the SediGraph 
5100 analysis program to a file that is compatible with the SediGraph 5120 application.

If you wish to... Then perform this type 
of analysis... 

Refer to 
page

Perform a single sample analysis Sample Analysis 3-35

Perform analyses on multiple samples using 
the same analysis conditions; sample files are 
created automatically.

Quick Start 3-39

Perform multiple analyses on the same sample Repeat Schedule 3-41

Perform analyses on a series of samples of the 
same type with the same analysis conditions; 
sample files are created automatically. 
(Requires a MasterTech)

MasterTech Automatic 3-42

Perform analyses on a series of samples which 
are different in size and shape and 
consequently require different analysis 
conditions. (Requires a MasterTech)

MasterTech Schedule 3-44
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The following topics in this chapter describe how to use these features:

Generating Reports

A number of report types, including tabular and graphical formats are included in the 
SediGraph application. The following topics in this chapter describe how to generate reports:

Topic Refer to page

Generating a List 3-50

Exporting a Sample Information File 3-51

Converting Non-Windows Sample Files 3-52

Topic Refer to page

Tabular and Graphical Reports 3-57

Baseline Reports 3-58

Statistical Process Control Reports 3-59

Regression Report 3-60

Control Chart Report 3-61

PSD History 3-63

Overlays 3-63
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Status Display

All operational windows contain two common status displays; one appearing in the upper 
portion of the window and one in the lower portion. Some status displays may contain more 
items than others, depending on the type of operation in process. The center portion of the 
window contains the activity of the current operation.

In addition, you can display the status of the current operation by selecting Unit [n] > Show 
Status.

Upper Display Items

The following is a typical upper status display.

View Allows you to choose which view you wish displayed in 
the window.

Choices: Operation, Analysis Log, Analysis Results,
Instrument Schematic

Operation displays the current status of an operation, for 
example: analysis, baseline, etc.

Analysis Log displays a list of recent operations and error 
messages for the active analyzer. By default, sample 
analyses and error messages are logged for seven days 
and baselines are logged for 30 days. You may receive a 
printout of the analysis log by clicking Report.

The period for which these entries are retained may be changed in the WIN5120.INI 
file under the Unit section.

Analysis Results displays the results of the current 
analysis.

Instrument Schematic displays a schematic of the 
instrument.

Begins the current operation; the button then changes to 
Stop. This button is disabled if another operation, such as 
rinsing, is in progress.
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Cancels the current operation. In some dialogs, this push 
button appears in the lower status display. When you click 
this push button, the Cancel dialog is displayed.

This dialog is divided into three sections:

Upper: displays the operation status.

Middle: lists the consequences of cancellation.

Lower: requests you to verify cancellation; click Yes to 
cancel or No if you decide to continue the operation.

When you click Yes, the actual operation is cancelled, but 
the operation window remains open.

Performs the same function as Cancel, only the operation 
window closes.

In some dialogs, this button appears in the lower status 
display.
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Lower Display

The following is a typical lower status display.

Mode: Displays the type of operation being performed.

SediGraph: Displays the status of the analyzer, such as Analysis 
operation in progress, Idle, Waiting for load, etc.

Sample: Displays the name of the sample file involved in the 
operation. This field also displays for the MasterTech if 
one is being used. 

MasterTech: Displays the status of the MasterTech. This field is visible 
only when a MasterTech is being used.

Time Remaining: Displays the time remaining in the analysis. This field is 
visible only when an analysis is in progress.

Cell Temp.: Displays the temperature of the liquid in the analysis cell.

X-Ray Counts: Displays the intensity of the X-ray in kilocounts/sec

Mass Percent: Displays the current mass percent in the analysis.

Diameter: Displays the current particle size in the analysis.

Analysis Time: Displays the approximate time for the analysis.
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Defining the Default Sample Information File

The SediGraph 5120 is shipped with a default sample information file. Whenever you create a 
new sample information file, the values in the default file are copied into the file; you can edit 
them if desired.

The contents of a sample information file can be viewed and edited in one of two ways: Basic, 
which displays a limited set of analysis parameters or Advanced, which displays all the 
parameter files contained in a sample information file.

You can customize the default sample information file in either format to meet your 
laboratory’s needs.

Using the Basic Format

Perform the following steps to define the default sample information file using the Basic 
format.

1. Select Options > Option presentation > Basic to select the Basic format.

2. Select Options > Sample defaults; the Default Basic Sample Information dialog is 
displayed.

3. Sample information files contain sequence numbers. The next available sequence number 
is displayed in the Sequence field. This is the number that will appear in the File name 
field when you select File > Open > Sample information.

You may change this number if desired.
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When you accept the next sequence number or enter a new one, the values you enter will 
remain as the default values for all new sample information files until you change the 
default file again.

4. In the right field of the Sample line, enter a format for the identification. Be sure to 
include the $ symbol if you want the sample file number included as part of the 
identification.

5. From the Analysis Conditions drop-down list, choose the analysis conditions file you 
wish to display as the default.

6. From the Report Options drop-down list, choose the reports options file you wish to 
display as the default.

7. In the reports list box, choose the reports you wish to use as the defaults.

8. Click Save, then Close.

 

You can also edit the word Sample. For example, you may prefer to use Test.
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Using the Advanced Format

Perform the following steps to define the default sample information file using the Advanced 
format.

1. Select Options > Option presentation > Advanced to select the Advanced format.

2. Select Options > Sample defaults; the 5120 Sample Defaults dialog is displayed.

3. Sample information files contain sequence numbers. The next available sequence number 
is displayed in the Sequence field. This is the number that will appear in the File name 
field when you select File > Open > Sample information.

You may change this number if desired.

When you accept the next sequence number or enter a new one, the values you enter will 
remain as the default values for all new sample information files until you change the 
default file again.

4. In the right field of the Sample line, enter a format for the identification. Be sure to 
include the $ symbol if you want the sample file number included as part of the 
identification.

5. Edit the Operator and Submitter lines as desired. Or you can have them omitted entirely 
by selecting Omit.

You can also edit the word Sample. For example, you may prefer to use Test.
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6. Specify user parameters (if desired). These fields provide additional sample 
characterization available for SPC reports. For example, you may wish to specify sample 
weight or temperature. If you specify a parameter, enter a default for that parameter in the 
fields on the right. Or, like the operator and submitter prompts, you can have them omitted 
by selecting Omit.

7. Enter comments to be stored in the sample information file in the Comments field if 
desired.

8. Select the Material Properties tab (or Next>>); the Material Properties dialog is displayed.

a.  Choose the options you wish to use as the defaults. (Refer to “Defining an Analysis 
Conditions File” on page 3-22.)

b.  Click Save.

9. Select the Analysis Options tab (or Next >); the Analysis Options dialog is displayed.

a.  Choose desired analysis options. (Refer to “Defining an Analysis Conditions File” on 
page 3-22.)

b.  Click Save.

10. Select the Report Options tab (or Next >); the Report Options dialog is displayed.

a.  Choose desired report options. (Refer to “Defining a Report Options File” on page 3-
28.)

b.  Click Save, then Close.
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Creating a Sample Information File

An analysis must have a sample information file assigned to it. The file consists of information 
groups which, collectively, identify the sample (sample information), guide the analysis 
(analysis conditions, liquid properties), and specify the data reduction (report options). 

After an analysis, the data collected during the analysis (or manually entered data) are also 
stored in the file for future reference or report generation.

A sample file may be created in one of three formats. In each of these formats, the sample 
default information data is copied into the sample file and you may edit it as desired:

• Basic. This format presents a single window in which you select predefined parameter 
files for your analysis. In this format, you can switch to Advanced format if necessary.

• Restricted. This format is identical to the Basic format, except that certain menu options 
become disabled. In the Restricted mode, you cannot convert non-Windows sample files 
or define defaults for SPC reports or sample files. You also cannot switch to Advanced 
format.

• Advanced. This format provides complete access to all parts of the sample file, allowing 
you to edit quickly any parameters as necessary. 

In addition, the application provides another convenient method of creating sample 
information files using the Replace function. In each of the formats listed above, a Replace 
push button is located in the Sample Information dialog box. You can use this command to 
copy the data from an existing sample information file into the one you are creating.

This feature is convenient for creating numerous "default" sample files. For example, you 
could set up a sample information file for each type of material you wish to analyze. Then, 
when performing an analysis, copy the sample file for the desired material into the new file 
and edit if required.

Using the Basic or Restricted Format

The Basic and Restricted formats are the easiest and most direct way to create a sample file 
because you create your file using predefined analysis conditions and report options files. If 
more detailed conditions or custom files are required, you must use the Advanced format 
(discussed later). Even if you begin your sample file in the basic format, you can switch to 
Advanced by clicking Advanced if you need to edit analysis options.

The instructions for creating sample files in the Restricted format are the same as the Basic 
format with the following exceptions:

• Certain menu options become disabled (refer to “OPTIONS MENU” on page 8-1.
• You cannot switch to Advanced mode. 
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Perform the following steps to create a sample information file using the basic format.

1. Make sure that Options > Option presentation > Basic is selected.

2. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

3. Accept the next sequenced file number or enter a new name in the File name field.

4. Click OK; the following message is displayed:

File [name] does not exist. Do you wish to create it?

5. Click Yes; the Basic Sample Information dialog is displayed.
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6. Select the down arrow at the Analysis Conditions field and choose an Analysis 
Conditions set from the drop-down list.

7. Select the Rinse after analysis option.

8. Select the down arrow at the Report Options field and choose a Report Options file from 
the drop-down list.

9. In the Report Options list box, select any reports you wish to have generated. (Reports are 
selected when preceded by a check mark.)

10. In the Full scale mass percent field, enter the percentage of the sample you wish to be 
analyzed. Unless you plan to analyze a portion of the sample by some other method, this 
should be left at 100%.

11. If you wish to merge alternatively collected data with the data to be collected with this file, 
select Merge with external data.

a.  Click External Data...; the External Data dialog is displayed.

b.  Choose whether the external data is particle size or sieve size.

c.  In the table, enter the data (particle size or sieve) collected from the alternative method.

d.  Choose the type of distribution provided by the external analysis method.

e.  Click OK.

12.   Click Save then Close.

It is highly recommended that you leave the Rinse after analysis option selected. 
De-selecting this option may speed up analyses, but inaccurate data may be 
produced.

Using your mouse pointer or the arrow keys, move to the report you wish to 
generate and double-click (or press the Spacebar). You may deselect reports in the 
same manner.

If you wish to merge data collected by another method with the data collected with 
this analysis, skip this step and proceed to the next one for instructions.
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Using the Advanced Format

The Advanced format presents all parts of the sample file in an index-card manner. This allows 
you to customize your sample file. 

1. Make sure that Options > Option presentation > Advanced is selected.

2. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

3. Accept the next sequenced file number or enter a new name in the File name field.

4. Click OK; the following message is displayed:

File [name] does not exist. Do you wish to create it?
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5. Click Yes; the Advanced Sample Information dialog is displayed.

6. In the right field of the Sample line, enter a sample identifier. Be sure to include the $ 
symbol if you want the sample file number included as part of the identifier.

7. Edit the Operator and Submitter lines as desired. 

8. Specify user parameters (if desired). These fields provide additional sample 
characterization available for SPC reports. For example, you may wish to specify sample 
weight or temperature. If you specify a parameter, enter a value for that parameter in the 
fields on the right.

9. Enter comments to be stored in the sample information file in the Comments field if 
desired.

You can also edit the word Sample. For example, you may prefer to use Test.

These fields are not displayed if omitted in the default sample information file.

These fields are not displayed if omitted in the default sample information file.
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10. If you wish to enter information about this sample information file in the sample log, click 
Add Log Entry; the Add Log Entry dialog displays.

Enter your comments, then click OK. Anything you enter in this dialog appears in the 
Instrument Log Report.

11. After you complete the sample information window, click on the next desired tab to open 
its associated dialog. Refer to: “Defining an Analysis Conditions File” on page 3-22 and 
“Defining a Report Options File” on page 3-28.

Using the Replace Command 

The Replace feature enables you to create a new sample information file by copying the 
contents of an existing sample information file and modifying the contents if desired.

1. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

You also can use Next>> and <<Prev to move between tabs.
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2. Accept the next sequenced file number or enter a new name in the File name field.

3. Click OK; the following message is displayed:

File [name] does not exist. Do you wish to create it?

4. Click Yes; the Sample Information dialog is displayed in the format selected in the 
Options menu.

5. Select Replace (in Basic format) or Replace All (in Advanced format); the Open Sample 
Information dialog is displayed.
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6. Select the file you wish to copy from the Files: list; then click OK. The Sample 
Information dialog is displayed with the copied data.

7. You may modify the data if desired. When you have finished making modifications, click 
Save, then Close.
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Defining an Analysis Conditions File

Analysis conditions specify the data used to guide an analysis. Analysis conditions can be 
created in an independent file and used as often as needed. Once you load the analysis 
conditions file into the sample file, you can edit the parameters as desired; the original analysis 
conditions file remains unchanged. This feature is especially useful if you have a certain type 
of sample material that you analyze on a regular basis.

Several analysis conditions files, located in the PARAMS subdirectory, are included with the 
SediGraph 5120 analysis program

Analysis conditions files are comprised of three sets of data:

• Material Properties - define the sample material, the liquid properties, and the type of 
analysis to be performed.

• Liquid Properties - define certain physical characteristics of sedimentation liquids used 
for the analysis.

• Analysis Options - define MasterTech operation and analysis conditions.

Liquid properties reside in an independent file, which can be used in analysis conditions files 
as often as needed. When you load the liquid properties file into an analysis conditions file, 
you can edit the parameters as desired; the original liquid properties file remains unchanged.

This section describes how to enter material properties and analysis options. The next section 
describes how to create liquid properties files.

Perform the following steps to define an analysis conditions file.

1. Choose one of the following:

• Select File > Open > Analysis conditions; the Open Analysis Conditions File dialog is 
displayed.

a.  Enter a name in the File name field, then click OK. The file name may contain up to 
8 alphanumeric characters (letters, numbers, and printable characters).

    The following message is displayed:

File [name] does not exist. Do you wish to create it?

b.  Click Yes.

• In the Advanced Sample Information dialog, click the Material Properties tab.
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The Material Properties dialog is displayed.

2. Enter a description in the Description field. 

3. From the Sample Material list box, select the desired sample material. If your sample 
material does not appear in the list, perform the following steps to add it:

a.  Enter the sample material you wish to use for these analysis conditions in the 
Description field.

b.  Enter the material’s density in the Density field.

c.  Click Add; the sample material is added to the list.

4. From the Analysis Liquid list box, select the desired dispersing liquid. If your dispersing 
liquid does not appear in the list, perform the following steps to add it:

a.  Enter the dispersing liquid you wish to use for these analysis conditions in the 
Description field.

b.  Click Properties and enter the viscosity and density for the liquid.

c.  Click Add; the dispersing liquid is added to the list.

5. Select whether you wish your analysis to be Standard, High Resolution or High Speed. 

Use an intuitive name that will help you identify the type of sample you plan to 
analyze using these analysis conditions. You may wish to use a name which 
contains the type of sample material and dispersing liquid. For example, Garnet/
Water.
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6. Enter the starting and ending diameters. Generally, the starting diameter should be larger 
than the largest particle you expect to be in the sample. The ending diameter must be less 
than the smallest size particle you are interested in.

7. Observe the following on the lower right side of the status display:

• Maximum diameter: should be greater than the starting diameter specified in step 6.

• Reynolds number: should be less than 0.3.

8. Now click the Analysis Options tab; the Analysis Options dialog is displayed.

9. If you have a MasterTech attached to your unit, enter the stirrer time, stirrer speed and 
probe time.

10. Select Stop at selected mass percent if you wish to stop the analysis at a specified mass 
percent finer, then enter the point at which you wish the analysis to stop.

11. Enter the number of tests (analyses) you wish to perform. You may enter up to 8.

If... Then...

The maximum diameter and 
Reynolds number values are not 
attained:

You must use a dispersing liquid with a higher 
viscosity.

The maximum diameter is much 
greater than the starting diameter 
and the Reynolds number is 
much less than 0.3:

A lower viscosity liquid (if available) may be 
used.
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12. Select Leave pump on during analysis if you wish to have the mixing pump operate 
during analysis. Coarse materials tend to settle in the tubing during analysis. Allowing the 
mixing pump to operate during analysis will make rinsing and resuspension more 
thorough. 

13. Select Wait for temperature stabilization if you wish to have the temperature in the 
analysis compartment and mixing chamber stabilize before the analysis begins. Since 
liquid properties are defined from the analysis compartment temperature, analyses are 
more accurate if the mixing chamber and analysis compartment have the same 
temperature range.

14. Enter the speed at which you wish the cell pump to operate during the scanning process.

15. Choose whether you wish bubble detection to be for Coarse, Medium, or Fine samples.

16. Choose whether you wish to have the analysis cell rinsed after each analysis.

•  Select Autorinse to have the analysis cell rinsed automatically.
•  Select Rinses if you wish to specify the number of rinses.

17. Enter the pump speed at which you wish the pump to operate during the rinse operation.

18. Click Save, then Close.

The analysis conditions file you created will now appear in the predefined list of analysis 
conditions files on the Basic sample information window.
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Defining a Liquid Properties File

Liquid properties files provide certain physical characteristics of sedimentation liquids used 
for analysis. The physical characteristics are the density and viscosity of the liquid at different 
temperatures.

Liquid properties files can be created and used as often as needed. When you load one of these 
predefined files into a sample information file, you can then edit the properties as required 
without changing the original file.

Several liquid properties files, located in the PARAMS subdirectory, are included with the 
SediGraph 5120 analysis program. 

Perform the following steps to define a liquid properties file:

1. Select File > Open > Liquid properties; the Open Liquid Properties dialog is displayed.

2. Enter a name in the File name field, then click OK. The file name may contain up to 8 
alphanumeric characters (letters, numbers, and printable characters).

The following message is displayed:

File [name] does not exist. Do you wish to create it?.

3. Click Yes; the Liquid Properties dialog is displayed.

4. Enter a description in the Description field.

Refer to Appendix G LIQUID DENSITY AND VISCOSITY DATA for a list of some 
common dispersants and their density and viscosity values.
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5. Select one of the following:

• Fixed values (ignore temperature)

Enter values in the Viscosity and Density fields. These values will be maintained 
regardless of the cell temperature.

• Interpolate using cell temperature

Enter three sets of values for the temperature, viscosity and density. These values are 
used to interpolate the density and viscosity at the current cell temperature as long as the 
instrument operating temperature remains within these ranges.

The table requires that the entered values be properly ordered, Temperature in 
ascending order for example. Enter values from left-to-right and from top-to-bottom.

6. Select the X-ray intensity:

The Normal selection increases intensity when using high X-ray absorption liquids, such 
as water.

The Low selection decreases intensity when using low X-ray absorption liquids, such as 
hydrocarbons. 

7. Click Save, then Close.
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Defining a Report Options File

Report options files specify the types of reports which can be generated from an analysis or 
from manually-entered data. They also contain details of the reports such as axis scale, axis 
range, and column headings. These report options files may be used to generate reports 
automatically at any time during or after the analysis. Of course, reports generated during 
analysis can only report on data collected up to the time of the report.

Report options files may be created and stored, then used with any sample information file. A 
report options file may contain tabular reports only, graphs only, or both tabular reports and 
selected graphs. It may also contain user defined report tables.

Report options files also may be defined to include overlay options. The SediGraph enables 
you to overlay up to seven graphs of different samples onto an eighth graph of the same type. 
The system also enables you to overlay one graph type onto a different graph type from the 
same sample analysis. For example, a cumulative mass graph may be overlaid with a mass 
frequency graph. 

Several report options files, located in the PARAMS subdirectory, are included with the 
SediGraph 5120 analysis program. 

Perform the following steps to define a report options file.

1. Select File > Open > Report options; the Open Report Options dialog is displayed.

2. Enter a name in the File name field, then click OK. The file name may contain up to 8 
alphanumeric characters (letters, numbers, and printable characters).

The following message is displayed:

File [name] does not exist. Do you wish to create it?

3. Click Yes; the Report Options dialog is displayed.
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4. Enter a description in the Report options field. Enter an identifier which gives a more 
intuitive description of the files contents. For example, Tabular Report using Mass 
Distribution.

5. If you would like to enter a title to appear at the top of the report, click the Show report 
title box and enter the title.

6. If you would like to include a graphic in the header of the report:

a.  Select Show graphic.

b. Enter the name of the graphic file or use the Browse button to select a file. The graphic 
file must be a bitmap (.bmp) or enhanced metafile (.emf) file.

c. Enter the height and width in which the graphic will appear in the report.

7. Choose whether you wish the data distribution to be reported as Mass, Area, or Number.

8. If you wish to compare analysis results for the current sample to those obtained for a 
reference sample, click Reference and choose a file. Results are reflected in the 
Difference from Reference Graph report.

9. If you wish to determine if the results for the current sample are within coarse and fine 
specifications, click Specification and choose a sample file for each boundary. Results are 
reflected in the Out of Specification Graph report.

10. If you wish to overlay graphs, click Overlays and choose the sample file(s) you wish to 
overlay with the current sample.

11. From the Test drop-down list, choose the analysis for which you wish to have a report 
generated. If you select Average, an average for all reports will be generated.

12. From the Reports to Generate list box, choose the reports you wish to have generated. A 
report is selected if it is preceded with a check mark. Remove any unwanted reports by 
highlighting the report, then double-click or press Spacebar. Or, you may add reports in 
the same manner.

13. Edit any reports you wish by highlighting the report, then clicking Edit.

14. Click Save, then Close.
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Performing a Drain and Load Operation

Before you can collect baseline data or perform an analysis, the cell and mixing chamber must 
be drained and the sample (or baseline liquid) loaded. You may perform this operation using 
one of the following methods:

• Prior to a baseline collection or an analysis, select Drain and load from the Unit menu 
(the method explained in this section).

• At the beginning of a baseline collection, select the Prepare SediGraph to load baseline 
liquid check box on the Baseline Measurement dialog (refer to “Performing a Baseline 
Measurement” on page 3-32).

• At the beginning of an analysis, select the Prepare SediGraph to load sample check box 
on the Drain and Load dialog (refer to “Performing an Analysis” on page 3-34).

Perform the following steps to drain the cell and the mixing chamber, then load the sample (or 
baseline liquid) into the mixing chamber:

1. Ensure that the outlet tube is in the waste reservoir.

2. Ensure that the rinse tube is in the rinse liquid reservoir.

3. Select Unit [n] > Drain and load; the Drain and Load dialog is displayed.

4. Choose whether you wish to have liquid remain in the mixing chamber or if you wish to 
leave the mixing chamber empty, then click Continue. 
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A progress message is displayed, then the dialog shown below displays.

5. Make sure the mixing chamber bezel is inserted in the mixing chamber, then load the 
sample (or baseline liquid) into the mixing chamber.

6. You may change the mixing speed if desired using the Increase or Decrease button.

7. Click Continue.The following dialog is displayed.

This dialog allows you to confirm the X-ray intensity reduction over the baseline before it 
completes. 

• If reduction is between 30 and 75%, Good is displayed. This indicates that the 
concentration level is appropriate.

• If the reduction is less than 30%, Low is displayed. This indicates that the concentration 
is too low; sample should be added.

• If the reduction is more than 75%, High is displayed. This indicates that the 
concentration is too high; more dispersant or less sample should be used.

8. When you are satisfied with the X-ray reduction level, click Continue and the cell will 
move to the normal park position and the load operation will be complete.
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Performing a Baseline Measurement

A baseline measurement is required for data collection. It is not necessary to measure a 
baseline for each analysis. Micromeritics recommends that you perform a baseline 
measurement once per shift and when you change dispersing agents. You may measure up to 
seven baselines; however, only the last one may be saved.

Perform the following steps to measure a baseline.

1. Ensure that no sample is present in the system.

2. Select Unit [n] > Baseline; the Baseline Measurement dialog is displayed. 

3. If you have not loaded your baseline liquid into the mixing chamber:

a.  Select Prepare to load baseline liquid. 

b.  Choose whether you wish to have liquid remain in the mixing chamber or if you wish 
to leave the mixing chamber empty.

4. If you wish to have a baseline report generated:

a.  Select Report After Analysis.

b.  Select the report destination.

c.  If you selected Printer, enter the number of copies to be printed.

 

If you plan to use a liquid different from the one you used for rinsing, leave the 
mixing chamber empty.

File cannot be specified as the destination for baseline reports. Only tabular reports 
can be output to a File.
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5. Select the X-ray intensity setting.

The Normal selection increases intensity when using high X-ray absorption liquids, such 
as water.

The Low selection decreases intensity when using low X-ray absorption liquids, such as 
hydrocarbons.

6. Click Next >; a window containing the previous baseline is displayed. This window also 

displays the new (current) baseline as it is measured.

7. Note that the window now contains an upper status display. Click on the down arrow to 
the right of the Baseline to use field; choose Latest to use the current baseline or Previous 
to use the previously saved one, then Click Close. 

If you selected Prepare to load baseline liquid, a drain and load operation is 
performed first.

If this baseline is not satisfactory, you may perform another one by clicking Next >. 
If you do measure another baseline, this one will become inaccessible. You can 
only choose between the latest and previously saved baseline.
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Performing an Analysis

There are five different ways in which an analysis (or analyses) may be performed:

• Sample Analysis: Used to perform a single sample analysis.

• Quick Start Analysis: Used to perform analyses on multiple samples using the same anal-
ysis conditions; sample files are generated automatically.

• Repeat Analysis: Used to perform multiple analyses on the same sample.

• MasterTech Automatic: Used to analyze a series of samples of the same type with the 
same analysis conditions. Functional only if a MasterTech is installed.

• MasterTech Schedule: Used to analyze a series of samples which are different in size 
and shape and, consequently, require different analysis conditions. Functional only if you 
have a MasterTech installed.

Choose the method you wish to use and proceed accordingly.
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Sample Analysis

Perform the following steps if you wish to perform an analysis on only one sample.

1. Select Unit [n] > Sample Analysis; the Sample Analysis dialog is displayed.

2. Click Browse and choose the sample file you wish to use with this analysis; all 
parameters associated with that file are displayed in the Sample Analysis dialog.

3. Ensure that the analysis conditions and report options are suitable; if not, you can select 
another analysis conditions or report options file to use.

4. In the Full scale mass percent field, enter the percentage of the sample you wish to be 
analyzed. Unless you plan to analyze a portion of the sample by some other method, this 
should be left at 100%.

5. If you wish to merge alternatively collected data with the data to be collected with this file, 
select Merge with external data.

a.  Click External Data...; the External Data dialog is displayed.

b.  Choose whether the external data is particle size or sieve size.

c.  In the table, enter the data (particle size or sieve size) collected from the alternative 
method.

If you wish to merge data collected by another method with the data collected with 
this analysis, skip this step and proceed to the next one for instructions.
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d.  Choose the type of distribution provided by the external analysis method.

e.  Click OK.

6. Click Next>>; the following dialog is displayed.

7. If you wish to have a report generated after analysis, check the Report After Analysis 
box and select a destination. 

If you choose File, enter a name in the File name field (or accept the default).

If you choose Printer, enter the number of copies to be printed.
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8. Choose one:

If... Then...

You have loaded your 
sample into the mixing 
chamber:

a.  Ensure that Prepare SediGraph to load sample is 
deselected.

b.  Choose report output options if desired.

c.  Click Next>>.

If you have not loaded 
your sample:

a. Select Prepare SediGraph to load sample.

b.  Choose whether you wish to have liquid remain in the 
mixing chamber or to have the chamber left empty.

c.  Choose report output options if desired.

d.  Click Next>>; a drain operation is performed, then the 
following dialog is displayed.

e.  Load your sample. If you want to change the mixing 
chamber speed, use the Increase or Decrease button.

f.  Click Next;  a dialog indicating the Load operation is in 
progress is displayed.
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9. A dual-paned window is displayed. The left pane of the window contains the current 
baseline and full-scale scan. The right pane contains analysis data in progress.
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Quick Start

Perform the following steps if you wish to perform analyses on multiple samples using the 
same analysis conditions; sample information files are created automatically.  

1. Select Unit [n] > Quick Start; the Quick Start dialog is displayed.

2. If the SediGraph has not been drained, select Prepare SediGraph to load sample to drain 
the mixing chamber. Then choose whether you wish to have liquid remain in the mixing 
chamber after the drain and load operation or if you wish to leave it empty.

3. If you wish to have a report generated after analysis, check the Report After Analysis 
box and select a destination. 

If you choose File, enter a name in the File name field (or accept the default).

If you choose Printer, enter the number of copies to be printed.

4. If you wish to have a different identification string than the one specified in sample 
defaults for this series of samples, enter a new name in the Sample field. Be sure to retain 
the $ symbol if you want the sample file number included as part of the identification.

5. Click Next>>; a dialog prompting you to load the sample is displayed.
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6. Load the sample if you have not already done so.

7. If you wish to change the mixing chamber speed, use the Increase or Decrease button.

8. Click Next>>; analysis of the first sample begins. The current baseline and data as they are 
collected are displayed in the window.

9. When analysis is complete, a window prompting you to load the next sample is displayed. 
Repeat steps 6 through 8 until you have finished your analyses. 

If you selected Prepare SediGraph to load sample, a drain is performed before you 
are prompted to load your first sample.

If you wish to analyze a sample requiring different analysis conditions from the 
ones established for this series of analyses, click Browse, then choose the sample 
file you wish to use. Once this sample is completed, all conditions revert back to 
the ones established for the Quick Start series. 

You may size either pane in the window by positioning the mouse pointer on the 
center vertical bar (separating the panes) and clicking the left mouse button. When 
the cursor changes to a 2-way arrow, pull the pane in the direction you desire. 
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Repeat Schedule

Perform the following steps if you wish to perform multiple analyses on the same sample.

1. Select Unit [n] > Repeat Schedule. The Repeat Schedule dialog is displayed.

2. Click Insert; the Repeat Schedule Insert dialog is displayed.

a.  Click Browse and choose the sample file you wish to use for the analysis.

b.  Enter the number of tests (analyses) you wish to perform using this sample file.

c.  Change the type of analysis if you wish.

d.  Click OK.

3. Repeat step 2 for as many analyses you wish to perform using this sample.

4. Click Edit if you wish to edit any file parameters of the selected file.

5. Click Report Settings if you wish to have reports generated after each analysis.

a.  Select a report destination. 

    If you choose File, enter a name in the File name field.
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     If you choose Printer, enter the number of copies to be printed.

b.  Click OK.

6. Click Start to begin the analyses. 

MasterTech Automatic

Perform the following steps to analyze a series of samples of the same type, using the same 
analysis conditions. When you use this method, sample files, containing the default analysis 
conditions, are created automatically and used for all analyses. 

1. Select Unit [n] > MasterTech Automatic; the MasterTech Automatic dialog is displayed.

2. In the Start with beaker field, enter the position number of the beaker containing the first 
sample you wish to analyze.

3. Enter the stirrer time, stirrer speed and probe time you wish to use for sample 
resuspension. Samples tend to settle in the beaker while waiting for analysis, especially if 
several samples are prepared ahead of time. This option allows you to redisperse samples 

When the analysis begins, the Start button changes to Stop. The Stop button 
cancels the remaining analyses. The analysis that is currently in progress will be 
completed.

This option is functional only if you have a MasterTech connected to your analyzer. 
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before analysis. Coarse materials and less stable dispersions may need a higher speed and 
more stirring and probe time than finer samples.

4. If you wish to have a report generated after analysis, check the Report After Analysis 
box and select a destination. 

If you choose File, enter a name in the File name field.

If you choose Printer, enter the number of copies to be printed.

5. In the Sample field, enter a default string for this series of samples.

6. Click Start; the analysis begins.

You can have the beaker number containing the sample included in the sample 
identification by entering # within the name you specify. For example, Garnet in 
beaker #.

When the analysis begins, the Start button changes to Stop. When you press Stop, 
the current analysis and the next queued analysis will be performed, then the 
remaining analyses in the queue will be canceled.

If you wish to view the analyses in progress, select Analysis Results from the View 
drop-down list.
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 MasterTech Schedule

This mode of operation is used to analyze a series of samples that are different in size and 
shape and, consequently, require different analysis conditions. You also can schedule baseline 
measurements between samples. 

Perform the following steps to use this mode of operation.

1. Select Unit [n] > MasterTech Schedule; the MasterTech Schedule dialog is displayed.

2. Click Insert; the MasterTech Schedule Insert dialog is displayed.

a.  Enter the position number of the beaker containing the current sample.

b.  Select Sample analysis or Baseline measurement.

•  If you select Baseline measurement, select the X-Ray intensity.
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The Normal selection increases intensity when using high X-ray absorption liquids, 
such as water.

The Low selection decreases intensity when using low X-ray absorption liquids, such 
as hydrocarbons.

•  If you select Sample analysis, click Browse, then choose the sample file you wish to 
use with the sample in this beaker position.

The values contained in the fields for Stirrer time, Stirrer speed, and Probe time are 
copied from the sample file you selected. You may change them if you wish.

c.  Click OK; the MasterTech Schedule dialog again is displayed. Note that the beaker 
information you just entered is shown in the list box.

3. Repeat step 2 for each beaker containing sample. 

If you plan to change dispersing liquids at any time during this series, you should perform 
a baseline measurement using the beaker position preceding the one containing the sample 
with the new liquid. For example, if you change dispersing liquids with the sample 
contained in beaker position 4, insert a Baseline measurement for beaker position 3. 

4. Click Report Settings if you wish to have reports generated after each analysis.

a.  Select a report destination. 

     If you choose File, enter a name in the File name field.

     If you choose Printer, enter the number of copies to be printed.

b.  Click OK.

5. Click Start to begin the analyses.

When the analysis begins, the Start button changes to Stop. When you press Stop, 
the current analysis and the next queued analysis will be performed, then the 
remaining analyses in the queue will be canceled.

If you wish to view the analyses in progress, select Analysis Results from the View 
drop-down list.
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Performing a Rinse Operation

A rinse operation should be performed to rinse any debris or contaminants from the analysis 
cell. It is best to perform a rinse operation after each analysis. The Analysis Options dialog 
contains a choice that allows you to specify that a rinse be performed after an analysis (refer to 
“Defining an Analysis Conditions File” on page 3-22). 

Alternately, you can choose Rinse from the main menu. When you choose Rinse from the 
main menu, three choices are presented: 

• SediGraph - rinses the analysis cell, the mixing chamber, and the tubing
• MasterTech - rinses the MasterTech tubing into a specified beaker
• Both - rinses the analysis cell, the mixing chamber, and all tubing

SediGraph 

Perform the following steps to rinse the analysis cell and the tubing in the SediGraph:

1. Pour approximately 10 liters of water containing a small amount of surfactant into the 
rinse container. For example, you may wish to use 0.05% sodium metaphosphate (W/W) 
in deionized water.

2. Insert the rinse tube into the rinse container. Insert the waste and overflow tubes into the 
waste container. Turn the caps clockwise to secure.

The rinse container should be rinsed thoroughly or replaced after each use.

Make sure that tube weights are attached to the rinse and waste tubes.
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3. Select Unit [n] > Rinse > SediGraph; the SediGraph Rinse dialog is displayed.

4. Choose one of the following:

• Autorinse if you wish to have the analyzer automatically determine how many rinse 
cycles to perform. 

• Rinses if you wish to specify the number of rinses. If you select Rinses, enter the 
number of rinse cycles to be performed in the field next to the radio button.

5. Enter the speed at which you wish the cell pump to operate. A speed of 2 usually is 
sufficient unless you find your material is difficult to rinse; then you may need to use a 
higher speed.

6. Click Continue; progress messages are displayed until rinsing is complete, then the dialog 
closes.

Rinse 
Container

Waste
Container

Rinse Tube
Overflow Tube

Waste Tube

       Tube
    Weight 

Autorinse, in an effort to reestablish baseline conditions, performs three cycles of 
three rinses per cycle (default setting) before displaying an error message that 
baseline conditions cannot be reestablished.
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MasterTech 

Perform the following steps to rinse the MasterTech tubing:

1. Pour approximately 10 liters of water containing a small amount of surfactant into the 
rinse container. For example, you may wish to use 0.05% sodium metaphosphate (W/W) 
in deionized water.

2. Insert the rinse tube into the rinse container. Insert the waste and overflow tubes into the 
waste container. Turn the caps clockwise to secure.

3. Select Unit [n] > Rinse > MasterTech; the MasterTech Rinse dialog is displayed.

4. Enter the position number of the beaker you wish to catch the rinse liquid (make sure the 
beaker is empty).

5. Click Continue; progress messages are displayed until rinsing is complete, then the dialog 
closes.

Make sure that tube weights are attached to the rinse and waste tubes.

Rinse 
Container

Waste
Container

Rinse Tube
Overflow Tube

Waste Tube

       Tube
    Weight 
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Both

Perform the following steps to rinse the analysis cell, the mixing chamber, and the tubing for 
the SediGraph and the MasterTech.

1. Pour approximately 10 liters of water containing a small amount of surfactant into the 
rinse container. For example, you may wish to use 0.05% sodium metaphosphate (W/W) 
in deionized water.

2. Insert the rinse tube into the rinse container. Insert the waste and overflow tubes into the 
waste container. Turn the caps clockwise to secure.

3. Select Unit [n] > Rinse > Both; the SediGraph and MasterTech Rinse dialog box is 
displayed.

4. In the SediGraph box, choose one of the following:

• Autorinse if you wish to have the analyzer automatically determine how many rinse 
cycles to perform. 

• Rinses if you wish to specify the number of rinses. If you select Rinses, enter the 
number of rinse cycles to be performed in the field next to the radio button. 

5. In the MasterTech box, enter the position number of the beaker you wish to catch the rinse 
liquid (make sure the beaker is empty).

6. Click Continue; progress messages are displayed until rinsing is complete, then the dialog 
closes.

Make sure that tube weights are attached to the rinse and waste tubes.
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Generating a List

You can generate a list of the following information on one or more files:

• File name
• Date the file was created or last edited
• Time the file was created or last edited
• File identification
• File status

Perform the following steps to generate a list:

1. Select File > List.

2. From the List drop-down menu, select the type of file on which you wish information. A 
dialog similar to the one shown below is displayed.

3. From the Files list box, choose the files you wish to include in the list by holding down 
Ctrl and clicking on the desired files. If you wish to include all files in the list, leave all 
files deselected. 

4. At the Destination: field, click on the down arrow and choose a destination for the list 
output. If you choose File as the destination, enter a name in the File name field.

5. Click OK, a list for the requested files is sent to the specified destination.
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Exporting a Sample Information File

The tabular data from a sample information file can be copied and exported as unreduced data 
in ASCII format. This data may be exported in a smoothed form (as used in reports) or an 
unsmoothed form (as collected by the instrument). Refer to Appendix J DATA 
REDUCTION for a description of the smoothing technique. If exported and saved as a file, 
the data can be imported into applications (such as spreadsheets) accepting ASCII format. 
Refer to Appendix K SEDIGRAPH X-RAY SAFETY INFORMATION for exporting 
format.

Perform the following steps to export a sample information file in ASCII format:

1. Select File > Export; the Export Sample File dialog is displayed.

2. From the Files list box, choose the files you wish to export by holding down and clicking 
Ctrl on the desired files. 

3. From the Settings group box:

a.  Choose whether you wish the data to be exported as Smoothed or Unsmoothed data.

b.  Choose a destination for your exported file. If you choose File as the destination, enter 
a name in the File name field. If you choose Printer or Printer/Plotter enter the 
number of copies to be printed.

4. Click OK, the requested file is exported and sent to the specified destination.
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Converting Non-Windows Sample Files

You can convert a sample information file created with the non-Windows version of the 
SediGraph analysis program to a file that is compatible with Windows.

Perform the following steps to convert a sample information file:

1. From the File menu, select Convert; the File Convert Sample Selection dialog is 
displayed.

2. Using the Directories list box, navigate to the location where the non-Windows data files 
are stored.

3. From the Files list box, choose the files you wish to convert by holding down Ctrl and 
clicking on the desired files. 

4. You are not required to enter anything in the Samples: and Parameters: fields unless you 
wish to change the name or directory.

5. In the System directory field, enter the source directory of the non-windows parameter 
files.

If you wish to display only files created within a designated time frame, click Dates 
and specify a date range.

As sample files are converted, the liquid properties and user-defined report tables 
they reference also are converted. The Parameters: field gives the destination for 
the converted parameter files.
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Two types of parameter files are associated with a non-Windows sample file: Liquid 
Properties and User-Defined Report Tables. These files are required for a complete 
conversion. If you fail to enter a directory in this field, the conversion proceeds but all files 
may not be found. A warning message is displayed in the Status window if parameter files 
are not found.

6. Click OK; a window is displayed reporting the status of the conversion. If the conversion 
was unsuccessful, possible reasons are given.

7. Select the system menu in the upper left corner and then Close to close the status window, 
or you may press Ctrl and F4.

Generating Reports

The following types of reports are available with the SediGraph 5120 analysis program:

• Tabular 
• Graphical
• Baseline
• Statistical process control 
• Overlays

Entering a Report Title

The report dialogs contain a Show report title check box and data entry field, shown below, 
which enable you to enter a title to be included in the report header.

If you would like to include a title in the report header:

1. Click the Show report title box to insert a check mark. You can also deselect the Show 
report title option by clicking the box to remove the check mark.

2. Enter the title in the field next to the check box. You may enter up to 40 characters.

You may stop a conversion in process by selecting Close.
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Including a Graphic in the Report Header

The report dialogs contain a Graphic group box, which enables you to select a graphic file to 
be included at the top of the report header. You may, for example, choose to include your 
company logo as shown in the following example.

 The Graphic group box, shown below, enables you to select the graphic and its size.

If you would like to include a graphic in the report header:

1. Click the Show graphic box to insert a check mark. You can also deselect the Show 
graphic option by clicking the box to remove the check mark.

2. Enter the name of the graphic file or use the Browse button to select a file. The graphic 
file must be a bitmap (.bmp) or enhanced metafile (.emf) file.

3. Enter the height (in inches) at which the graphic will appear in the report in the Height 
field.

4. Enter the width (in inches) at which the graphic will appear in the report in the Width 
field.
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Selecting the Report Destination

The report dialogs contain a Report Settings group box, which enables you to select the 
report’s destination.

Choose the report’s destination from the Destination drop-down list. The choices are Printer, 
Printer/Plotter, Screen or File. 

Printer or Printer/Plotter This option prints up to four copies of a report on a printer 
or plotter.

If you choose Printer or Printer/Plotter as the destination, 
select the number of copies to be printed in the Copies 
field. The report is sent to the default printer.

Range: 1 to 4

If you wish to change the default printer, select Options > System Configuration, 
then choose a printer.

Screen This option displays a report on the screen.

While viewing the report, you can also print it if desired. 
(Refer to Reports Displayed on the Screen in 
Chapter 7).
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File This option saves a report to a file on your computer.The 
file includes column headers and report data. Columns are 
tab-delimited, allowing easy alignment when imported 
into another program.

If you choose File as the destination, enter a file name or 
accept the default value in the File field.

If you accept the default, when files are created, they are 
named as described below:

For standard sample file reports:
Each report will include the name of the sample file 
selected for the report and the .RPT extension.

For baseline reports:
The file name will include the instrument’s serial number 
and the .RPT extension

For SPC reports:
The file name will include the name of the first sample 
file selected for the report and the .RPT extension.

If the report is a graph, only the data on the graph are included in the file, the 
graphical elements (X- and Y-axes representation and curves) are not.
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Tabular and Graphical Reports

Tabular and graphical reports are generated automatically (if requested) after an analysis. If 
you wish to print additional copies, or change parameters and then reprint, you also may 
generate them manually. 

Perform the following steps to generate reports manually. 

1. From the Reports menu, select Start report; the Start Report dialog is displayed.

2. From the Files list box, click on the name of the file(s) for which you wish to have reports 
generated.

3. Select the destination in the Settings group box (refer to “Selecting the Report 
Destination” on page 3-55).

4. Click OK; the Reports to Generate dialog is displayed.

5. Select the report(s) you wish to generate. A report is selected when it is preceded by a 
check mark. Reports may be selected (or deselected) by double-clicking (or pressing the 
Spacebar) on the desired report.

6. Click OK; the selected reports are generated and sent to the specified destination.
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Baseline Reports

A graphical report can be generated on an instrument’s baseline. This report generates a graph 
illustrating the X-ray intensity versus the cell height. The header of this report also contains 
baseline statistics, such as the unit serial number, date the baseline was performed, etc.

Perform the following steps to generate a baseline report.

1. Select Reports > Baseline; the Start Baseline Report dialog is displayed.

2. From the Instrument drop-down list, select the instrument on which you wish to have the 
baseline report generated. 

3. Select the destination (refer to “Selecting the Report Destination” on page 3-55).

4. Click OK; the baseline report is generated and sent to the specified destination. 
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Statistical Process Control Reports

Statistical process control (SPC) reports allow you to maintain control of a manufacturing 
process. 

There are two types of SPC reports: Regression and Control Chart. Before you can generate 
either report, you must specify the calculation parameters to be used. These selections 
determine what values are available for SPC reporting. For efficiency, it is best to choose only 
the variables you actually intend to use, since all variables selected are computed for each 
sample file used in an SPC report.

Perform the following steps to specify calculation parameters:

1. Select Reports > SPC report options; the SPC Calculations dialog is displayed.

2. From the Test drop-down list, click the analysis on which you wish to report. If you select 
Average, an average of all analyses for the specified sample file is reported.

3. Select the type of distribution you wish to apply.

4. Select whether you wish to have arithmetic (linear) or geometric (logarithmic) type of 
statistics.

5. From the Statistics group box, select the statistics you wish to be included in SPC 
reporting.

6. Click Sample to choose the sample parameters you wish to report.

7. Click Analysis to choose the analysis conditions you wish to report.

8. Click Percentiles to specify the diameters for corresponding percentiles.

9. Click Sizes to specify percentiles for the corresponding diameters.

10. Choose the peaks to include in the SPC calculations; you can choose up to five. Use the 
field below to enter the minimum percentage of the distribution to report.

11. Click OK to save these options.
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Regression Report

Perform the following steps to generate a regression report.

1. Select Reports > Regression report; the Regression Report Options dialog is displayed.

2. Select whether you want to show the report title and enter a title if you wish.

3. Select whether you would like to include a graphic in the report header. (Refer to 
“Including a Graphic in the Report Header” on page 3-54.)

4. Select your X- and Y-axes variables.

5. Deselect Autoscale if you do not wish to have data scaled automatically; then enter the 
desired ranges.

6. Select Tabular if you wish to have a table, as well as graphical data, of the included 
samples generated.

7. Select Label data to have the points on the graph correspond with the sample files from 
which they came.

8. Click Samples to choose the files you wish to have reported.

The variables displayed in these drop-down lists are the ones specified in SPC 
report options.
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9. Select Recalculate archived SPC results if you wish to have the SPC statistics 
recalculated for each of the included sample files. You may wish to use this option when a 
statistic you have selected is labeled N/A (not available) on the tabular report.

10. Select the destination in the Report Settings group box (refer to “Selecting the Report 
Destination” on page 3-55). 

11. Click Report; the regression report is generated and sent to the specified destination.

Control Chart Report

Control chart reports can be generated to illustrate process variations. Perform the following 
steps to generate a control chart.

1. Select Reports > Control chart; the Control Chart Options dialog is displayed.

2. Select whether you want the report to include a title and enter a title if desired.

3. Select whether you would like to include a graphic in the report header. (Refer to 
“Including a Graphic in the Report Header” on page 3-54.)

4. Choose whether you wish to have files listed in order by file name or by the time they 
were created.

You can click Save as Default if you wish to have the selected options become the 
defaults for Regression reports.
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5. If you wish to edit the summary statistics displayed in the report, click Summary 
Statistics. The Control Chart Summary Statistics dialog is displayed.

a.  Check the statistics you want to display in the report. You may select:

•  Mean

•  Standard Deviation

•  Coefficient of Variation - the Standard Deviation divided by the Mean

•  Confidence Interval - the confidence interval of the mean value shown on the same 
line below the graph on the report

b.  If you selected Confidence Interval, enter the percent in the Confidence Level field.

c.  If you wish to have the number of samples analyzed included in the report, check the 
Number of Samples box.

d.  Click OK to save your selections and close the dialog.

6. Click Graph [n] to select Y-axis labels.

7. Select Tabular report if you wish to have tabular, as well as graphical, data generated.

8. Select Recalculate archived SPC results if you wish to have the SPC statistics 
recalculated for each of the included sample files. You may wish to use this option when a 
statistic you have selected is labeled N/A (not available) on the tabular report.

9. Click Samples to choose the files you wish to have reported.

10. Select the destination in the Report Settings group box (refer to “Selecting the Report 
Destination” on page 3-55).

11. Click Report; the control chart report is generated and sent to the specified destination.

You can click Save as Default if you wish to have the selected options become the 
defaults for Control Chart reports.
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PSD History

The PSD History option enables you to report a sequence of full particle size distribution 
graphs. 

1. Select Reports > PSD History; the PSD History Options dialog is displayed.

2. Select whether you want the report to include a title and enter a title if desired.

3. Select whether you would like to include a graphic in the report header (refer to “Including 
a Graphic in the Report Header” on page 3-54).

4. Select whether to order the X axis by time or file name.

5. Click Samples to select the files to include in the report.

6. Select the destination in the Report Settings group box (refer to “Selecting the Report 
Destination” on page 3-55).

7. Click Report; the PSD report is generated and sent to the specified destination.

Generating Overlays

Use the overlay function when you wish to compare multiple graphs. Overlays may be 
generated in three ways:

• from the same sample file, you can overlay multiple graphs. 

• from multiple sample files, you can overlay the same type of graph(s). 

• from the same sample file, you can overlay the same type of graph for all analyses (tests) 
for which you used this sample file.

Varying symbols are used to differentiate the graphical lines and reported in a legend at the top 
of the output. If color output is available, different colors are used instead. 
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It is much easier to generate overlays if you have predefined report options files created for 
specific overlay functions. For example, if you frequently compare Out of Specification 
graphs, define a report options file containing the desired options and assign an identification 
such as Out of Spec Overlays. Then you can use Replace to load the predefined file into the 
sample file. You do not have to save the file to have overlays generated, so the report options 
for your original sample file remain intact.

To overlay multiple graphs from the same sample file:

1. Select File > Open, Sample information; the Open Sample Information dialog is 
displayed.

2. Select the file you wish to use, then click OK.The Sample Information dialog displays.

If your window is presented in Basic format, click Advanced to display the Advanced 
format window.
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3. Select the Report Options tab; the report options dialog is displayed.

4. Use one of the following methods:

5. From the Reports menu, select Start report; the Start Report dialog is displayed. The 
sample information file you chose in step 2 will be highlighted in the Files list.

If... Then...

You are using a predefined Report 
Options file:

Click Replace and choose the report options 
file you wish to use.

You are defining report options: a.  Select which test you wish to use.

b.  In the Reports to Generate list box, select 
the graph(s) you wish to overlay with other 
graph(s).

c.  Click Edit for each requested graph; a 
Graph Options dialog is displayed.

d.  From the Overlay drop-down list, choose 
the type of graph you wish to overlay; then 
click OK.

You do not have to save these options before generating overlay reports. If you do 
save, the report options for your original sample file will be replaced with the new 
ones.
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6. Select a destination (refer to “Selecting the Report Destination” on page 3-55).

7. Click OK; the Reports to Generate dialog is displayed, allowing you to change report 
selections if you wish.

8. Click OK; requested overlays are generated and sent to the specified destination.

To overlay the same type of graph(s) for multiple samples:

1. Select File > Open, Sample information; the Open Sample Information dialog is 
displayed.

2. Select the file you wish to use, then click OK. The Sample Information dialog displays. If 
your window is presented in Basic format, click Advanced to display the Advanced 
format window.
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3. Select the Report Options tab; the Report Options dialog is displayed.

4. Use one of the following methods:

If... Then...

You are using a predefined Report 
Options file:

Click Replace and choose the report options 
file you wish to use.

You are defining report options: a.  From the Test drop-down list, select the 
test (analysis) of this sample file for which 
you wish to have results reported.

b.  The graph(s) you select for this report will 
be overlaid with the corresponding 
graph(s) of the test designated in the 
Report Options file(s) of the sample file(s) 
you select in step 7.

c.  In the Reports to Generate list box, select 
the graph(s) you wish to overlay.

d.  Click Edit for each selected report; a Graph 
Options dialog is displayed

e.   Ensure that Samples is selected in the 
Overlay field. 

f.   Click OK; the Report Options dialog again 
is displayed.
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5. Click Overlays; the Graph Overlay Sample dialog is displayed.

6. Click Browse; the Graph Overlay Sample File Selection dialog is displayed.

7. Choose the file you wish to use; then click OK. You may choose up to eight files in this 
manner.

8. From the Reports menu, select Start report; the Start Report dialog is displayed. The 
sample information file you chose in step 2 will be highlighted in the Files list.

9. Select a destination, refer to “Selecting the Report Destination” on page 3-55. 

10. Click OK; the Reports to Generate dialog is displayed, allowing you to change report 
selection if you wish.

11. Click OK; requested overlays are generated and sent to the specified destination.

To overlay the same type of graph for all tests from the same sample file:

1. Select File > Open, Sample information; the Open Sample Information dialog is 
displayed.

2. Select the file you wish to use, then click OK.The Sample Information dialog is displayed. 
If your window is presented in Basic format, click Advanced to display the Advanced 
format window.

You do not have to save these options before generating overlay reports. If you do 
save, the report options for your original sample file will be replaced with the new 
ones.
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3. Select the Report Options tab; the report options dialog is displayed.

If... Then...

You are using a predefined Report 
Options file:

Click Replace and choose the report options 
file you wish to use.

You are defining report options: a.  In the Reports to Generate list box, select 
the graph(s) you wish to overlay.

b.  Click Edit for each selected report; a 
Graph Options dialog is displayed.

c.  Ensure that Tests is selected in the 
Overlays field.

d.  Click OK; the Report Options dialog again 
is displayed. 

You do not have to save these options before generating overlay reports. If you do 
save, the report options for your original sample file will be replaced with the new 
ones.
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4. From the Reports menu, select Start report; the Start Report dialog is displayed. The 
sample information file you chose in step 2 will be highlighted in the Files list.

5. Select a destination, refer to “Selecting the Report Destination” on page 3-55. 

6. Click OK; the Reports to Generate dialog is displayed, allowing you to change report 
selections if you wish.

7. Click OK; requested overlays are generated and sent to the specified destination.
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Overview

Initially, your SediGraph 5120 will be installed and verified for operation by an authorized 
Micromeritics service representative or a representative of a Micromeritics distributor. 

This chapter contains instructions for installing the 5120 software should you want to install 
the software on a computer other than the one controlling the analyzer. When you install the 
software on another computer you can create or edit sample and parameter files, and generate 
reports on sample files on that computer.

Review the Micromeritics PROGRAM License Agreement for restrictions on the use of 
another copy.

This chapter also contains instructions for installing software updates and changing the 5120 
application setup.
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Installing the 5120 Analysis Program 

The installation CD shipped with the analyzer contains the 5120 analysis software. To install 
the software: 

1. Insert the Micromeritics 5120 analysis software CD into your CD-ROM drive.

2. Select Start from the Status bar, then Run from the Start menu.

3. Enter the name of the drive designator, followed by setup. For example: e\:setup.

4. Click OK; the New Installation dialog is displayed.

5. The Destination Folder group box displays the amount of current disk space, the amount 
of disk space required for the Micromeritics software, and the folder into which the 
application will be installed. 

If the default location is not acceptable, click Browse to choose the folder.

6. If you want to run the Micromeritics software from the desktop, select the checkbox just 
below the Destination Folder group box to add an icon to the desktop.

7. The Micromeritics software icon is added to the Micromeritics folder by default. If you 
prefer a different folder, enter or select one from the drop-down list.

8. The Install this application for All Users check box indicates whether users other than 
the installer will be able to access the application from the Windows Start menu. 

You may cancel the installation at any time by selecting Exit. If you do so, you must 
start the installation program from the beginning to install the Micromeritics 
software.
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If the box is checked, the application can be accessed from the Windows Start menu by all 
users who are logged onto Windows. If the box is not checked, the application can be 
accessed from the Windows Start menu only by the user who installed the application.

9. Click Next; the Analyzer Configuration dialog is displayed.

10. In the Step 1 group box, click the radio button for the number of analyzers to be attached 
to this computer. 

11. In the Step 2 group box, enter the serial number(s). 

12. If the computer connection to the analyzer is via a serial communications port, the 
Communication Port field is displayed. Enter the communications port(s) for the 
analyzer(s) you are attaching to this computer.

If the connection is by some other means, such as Ethernet, this field does not display.

13. Click Next. The Calibration File Installation dialog is displayed.

14. Choose one of the following: 

• If you have only one analyzer attached to the computer, the source location will be the 
setup CD currently in the CD-ROM drive, which is the default location. Press Finish 
and proceed to step 16.

• If you have two analyzers attached to the computer, the application checks the current 
setup CD for the calibration files for the analyzer whose serial number you entered for 
Unit #1 in the previous dialog. 

Choose 0 (zero) if you are installing this program for data reduction on a computer 
other than the one controlling the analyzer.
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a.  If the files are found, the source location will be the setup CD currently in the CD-
ROM drive, which is the default location. Press Finish and proceed to step 15.

b.  If the files are not found, the message shown below is added to the Calibration File 
Installation dialog.

c.  Remove the current setup CD and insert the CD containing the calibration files in 
the CD-ROM drive.

d.  When the CD drive light stops blinking, press Finish.

e.  The files are loaded, then this message is displayed:

Since the calibration files for analyzer (serial number) were on a separate CD 
please remove the calibration CD for (serial number) and insert the original 
setup CD.

Remove the CD and insert the original setup CD in the CD-ROM drive, then press 
OK.

15. The Calibration File Installation dialog for the second analyzer is displayed.

Repeat steps 14 a  or 14 b through 14 e, then proceed to step 16.
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16. The Installation Complete dialog box is displayed..

17.  Click Finish to close the dialog.

18. Remove the Setup CD and store in a safe place. The original Setup CD contains 
calibration files specific to your instrument. Upgrade CDs do not contain calibration files. 
Therefore, it is important that you maintain your original Setup CD in a secure location in 
the event calibration files need to be reinstalled.
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Changing the Application Setup

During instrument installation, the instrument’s application software was installed and 
configured to meet your laboratory’s requirements. If it becomes necessary to change your 
application configuration, for example, to add an analyzer or move an analyzer from one 
computer to another computer, you can use the application setup features on the 5120 Setup 
CD.

The application Setup CD contains these features: 

• Upgrade software
• Add an analyzer
• Move an analyzer from one computer to another computer
• Remove an analyzer from the computer
• Change the analyzer setup
• Reinstall calibration files
• Uninstall the analysis program

Starting the Application Setup Program

To start the application setup program:

1. Ensure that the Micromeritics software is not operating.

2. Insert the program CD into your CD-ROM drive.

3. Select Start from the Status bar.

4. Select Run from the start menu.

5. Enter the drive designator of the CD-ROM drive, followed by setup. For example: 
e:\setup.

Alternatively, you can click Browse, navigate to your CD-ROM drive, and select 
setup.exe.
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6. Click OK; the setup Welcome screen showing the options available is displayed.

7. Select the operation you wish to perform. Procedures for performing each operation are in 
the following sections of this manual.

8. After the requested operation is completed, the setup Welcome screen is again displayed. 
A confirmation message indicating completion of the operation is shown in the lower 
section of the dialog.

9. After you have completed all desired operations, click Exit to close the dialog.

Installing New Software Versions

When you install a software upgrade, the system installs all of the application files and any 
status files that do not already exist on the computer. Existing analyzer status files are not 
affected and default and data files are not overwritten.

There are three types of subsequent installation; the software version controlled by the setup 
program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Turn off the analyzer (follow the steps in “Turning Off the Analyzer ” on page 2-8); the 
analyzer must be off when installing software upgrades.
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2. Start the Setup program (refer to “Starting the Application Setup Program” on page 4-8). 
Choose the software option; remember, only the applicable option will display; it will be 
one of the following:

•   Upgrade software to version (number) from version (number)
•   Reinstall software version (number)
• Downgrade software to version (number) from version (number)

3. Click Start file installation; the application installs the software and displays the 
Installation Complete dialog.

4.  Click Finish; the application redisplays the setup Welcome dialog.

5.  If no other operations are desired using this dialog, click Exit to close the dialog.

6. Turn on the analyzer (follow the steps in “Turning On the Analyzer” on page 2-8), then 
start the SediGraph application.
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Adding an Analyzer

Add an analyzer to the existing application as follows:

1. Start the Setup program (refer to “Starting the Application Setup Program” on page 4-8). 
Select Add an analyzer, then click Next; the Setup analyzer dialog is displayed.

2. Enter the serial number of the analyzer being added, then the port to which it is to be 
connected.

3. Click Next. 

4. The setup Welcome dialog is redisplayed. If no other operations are desired using this 
dialog, click Exit to close the dialog.
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Moving an Analyzer from one Computer to another Computer

You can move an analyzer from one computer (Source PC) to another computer (Destination 
PC).

1. Choose one of the following:

• Install the Micromeritics software on the destination computer if it is not already 
installed. Refer to “Installing the 5120 Analysis Program” on page 4-4. Be sure to select 
0 as the number of instruments; all related instrument information will be transferred in 
the Move operation.

• If the Micromeritics software is already installed on the destination computer, proceed 
to Step 2.

2. Start the application setup program on the source computer. (Refer to “Starting the 
Application Setup Program” on page 4-8).

3. In the Setup dialog, select Move an analyzer from one PC to another PC, then click 
Next; the Move analyzer operation dialog is displayed.

This operation does not move sample or parameter files. To move these files, use a 
file management program such as Explorer.
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4. Select Source PC, then click Next; the following dialog is displayed.

5. In the Step 1 group box, select the analyzer that is to be moved.

6. In the Step 2 group box, choose a location in which the moved files will be stored. If 
possible, choose a disk drive or a shared network drive. If this is not possible, select a local 
folder. After the files are placed there, use a folder transfer utility to copy this folder from 
the Source PC to the Destination PC.

7. Click Finish; the files are moved and the setup Welcome screen is displayed.

8. Start the application setup program on the destination computer.

9. In the Setup dialog, select Move an analyzer from one PC to another PC; the Move 
analyzer operation dialog is displayed (shown on previous page).

10. Select Destination PC, then click Next; the following dialog is displayed.
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11. In the Step 1 group box, enter the serial number of the analyzer being moved and the 
communications port to which it will be attached.

12. In the Step 2 group box, click Browse and choose the location of the moved files.

13. Click Finish; the files are moved and the setup Welcome dialog is displayed.

Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, the 
status files are removed as well.

1. Start the Setup program. Refer to “Starting the Application Setup Program” on page 4-8.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an 
analyzer dialog is displayed.

3. From the drop-down list, choose the serial number of the analyzer you want to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the dialog.
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Changing an Analyzer Setup

Use this option to change the communications port to which the analyzer is attached.

1. Start the Setup program. Refer to “Starting the Application Setup Program” on page 4-8.

2. From the Setup dialog, select Change analyzer setup, then click Next; the Change 
analyzer setup dialog is displayed.

3. From the drop-down list, choose the analyzer you want to change.

4. Enter the new port number in the space provided.

5. Click Finish; the change is completed and the Welcome dialog is again displayed.

6. Click Exit to close the dialog.
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Reinstalling the Calibration Files

You can reinstall the files containing an analyzer’s factory calibration data or updated 
calibration as follows.

1. Start the Setup program. Refer to “Starting the Application Setup Program” on page 4-8.

2. From the Setup dialog, select Re-install calibration files for an analyzer, then click 
Next; the Re-install calibration files dialog is displayed.

3. Select the analyzer whose calibration files you wish to reinstall from the drop-down list. If 
you have only one analyzer installed, a drop-down list is not included.

4. Choose one of the following:

• To install the factory calibration data, insert the CD containing the calibration files; 
ensure that the CD drive is displayed as the calibration file source location. If not, click 
Browse and choose the CD drive.

• If the instrument has been recalibrated since installation, click Browse and select the 
location of the updated calibration data file. 

5. Click Finish; the calibration files are reinstalled and the Welcome dialog is again 
displayed.

6. Click Exit to close the dialog.
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Uninstalling the 5120 Analysis Program

When you uninstall the analysis program, the application removes the Micromeritics software, 
status files, analyzer setup files, and resulting empty directories. It does not remove data files. 
Perform the following steps to uninstall the program:

1. Start the Setup program. Refer to “Starting the Application Setup Program” on page 4-8.

2. From the Setup dialog, select Uninstall, then click Next; the Uninstall dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.
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4. Choose one of the following:

• Automatic: click Next; the system uninstalls the Micromeritics software automatically 
and the setup Welcome dialog redisplays.

• Custom: click Next; a series of dialogs is displayed, allowing you to choose the files 
you wish to uninstall. After all files are selected and uninstalled, the setup Welcome 
dialog redisplays.

5. Click Exit to close the Welcome dialog.
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Description

The File menu contains options which allow you to manage sample and parameter files.

Listed below are brief descriptions of the File menu options. Detailed descriptions follow this 
section.

Open Opens an existing file or creates a new file. When you 
select this item, a drop-down menu is displayed 
containing four types of files: Sample information, 
Analysis conditions, Liquid properties, and Report 
options.

Save Saves the file in the active window.

Save As Allows you to save the file in the active window under a 
different name. It also can be used to save a subset of the 
file as a parameter file.

Save All Saves all open files.

Close Closes the file in the active window.

Close All Closes all open files.

Print Prints the entire contents of the selected file.
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List Generates a list of certain information for specified 
sample files or parameter files.

Export Exports a sample file in ASCII format.

Convert Converts a sample file created with a non-Windows 
version of the SediGraph analysis program to a file 
compatible with Windows.

Exit Exits the analysis program.
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Open

Select Open to create a file or edit an existing one. The following file types are available:

• Sample information
• Analysis conditions
• Liquid properties
• Report options

Regardless of which file type you select, a dialog similar to the one shown below is displayed. 

Refer to "Selecting Files" in Chapter 2 for a description of the other fields in this dialog.

File name: For sample information files, this field contains the next 
sequenced file name generated by the system. 

For parameter files, the file name displayed includes the 
wild card (*) and the default extension as follows:

*.ANC for analysis conditions

*.LIQ for liquid properties

*.RPO for report options

If you are creating a new file, enter a name in the File 
name field. If you are editing an existing file, select a file 
from the list.

File names can contain up to 8 alphanumeric characters.
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Sample Information

Sample information files contain information used to control the analysis, as well as collected 
or manually entered data. You must assign a sample information file to every analysis. You 
also can edit an existing sample information file. A sample information file consists of five 
parts:

• sample identification
• material properties
• analysis options
• report options
• collected/entered data 

Sample information files are stored in directories (also called folders). For efficiency and 
organization purposes, it is recommended that no more than 400 files be stored in a single 
directory. A good way for organizing and storing files is to create a new directory for each 
month; for example, jan2003, feb2003, etc. 

Parts of the sample file can also exist as parameter files separate from the sample information 
file itself. These parameter files contain frequently used analysis conditions which may be 
conveniently loaded into a new sample information file. They also may be edited as required.

Sample information files are presented in three different formats: 

• Advanced 

Presents all five parts of the sample information file in a single, tabbed dialog. Each tab 
opens its associated dialog. Use this format to set up standard defaults and to customize 
standard analysis conditions and report options files.

• Basic 

Presents each part of the sample information file as a separate dialog. With this format, 
you can quickly create a sample information file using previously defined analysis 
conditions and report options. 

• Restricted

Displays in the same manner as the Basic format. However with this format, certain menu 
functions are disabled and you cannot switch to the Advanced format. This format also 
requires a password.

Select Options > Option presentation to choose the format you wish to use.
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Basic

When you open an existing sample information file or create a new one using the Basic 
format, all parts of that file are contained on a single dialog. With the Basic format, you can 
quickly create a sample information file using predefined parameter files. Chapter 3 provides 
step-by-step instructions for creating a Basic sample information file.

Sample Contains the next sequenced file description based on the 
format you specified in Sample defaults (refer to "Sample 
Defaults" in Chapter 8). You may enter a new description 
or add to the existing one if you wish.

Range:50 alphanumeric characters

Analysis Conditions Displays a drop-down list containing previously defined 
analysis conditions files supplied with the analysis 
program, as well as any you may have created on your 
own.

This list is disabled for files which have been used for an 
analysis.

Sample 
Liquid

Displays the type of sample and dispersing liquid used 
with the analysis conditions file you selected from the 
Analysis Conditions drop-down list.
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Sample Density
 

Displays the density of the sample specified in the 
Analysis conditions file. You may edit these properties as 
long as the sample file is not complete (used in an 
analysis). If, however, significant adjustments are 
required, you should switch to advanced mode and define 
a new type of sample material.

If the sample file is complete, density properties may be edited by selecting 
Advanced. Then select the Material Properties tab and Update Properties.

Number of tests Enter the number of analyses you wish to perform with 
this sample file; you may enter up to seven.

Rinse after analysis Rinses the cell, the tubing, and the mixing chamber after 
each analysis. It is highly recommended that this option 
remain selected. If you deselect this option and rinses are 
not performed after analysis, inaccurate results may be 
obtained.

Report Options Displays a drop-down list containing previously-defined 
report options files supplied with the analysis program, as 
well as any you may have created on your own.

Reports List Box Displays the specified reports from the file you select 
from the Report Options drop-down list. You may change 
the report selection if you wish.

Merge with external data Allows you to merge data collected using manual 
methods with the data collected for the current analysis.
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Enabled only if you selected Merge with external data. 
Allows you to enter the data you wish to have merged, the 
External Data dialog is displayed.

Allows you to enter new data in the table. If this is a 
particle size table, you may enter the particle size and 
cumulative percent for the particle. If this is a sieve table, 
a set of sieves is displayed so that you may enter the 
percent passed through each size.

Removes the selected row from the table.

Deletes all but one entry of the table (one entry is 
required). So that it is not deleted in error, a warning 
message is displayed.

Size Type
Allows you to specify the type of size data.

Distribution Type
Allows you to specify the type of distribution data.

This type of table displays if 
you choose Sieve size for the 
size type.
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Autoscale percent of total sample
When this option is selected, the overlapping regions of 
the collected data and the merged data are used to rescale 
the collected data so that the regions match. 

When this option is deselected, the percentages you enter 
for the merged data are used and the nonoverlapping 
portion of the collected data is scaled to be the percent 
passing through the smallest sieve. 

Full scale mass percent: Allows you to specify the weight percent of the sample 
actually analyzed by the SediGraph versus the percent 
that is manually analyzed. The data are scaled 
accordingly.

Use this option if you analyzed part of the sample by 
another method but you do not wish to merge those 
results with the reports for the current analysis.
This field is disabled if Merge with external data is 
selected.

Allows you to copy values from an existing file into the 
one you are creating. A dialog is displayed so that you 
may choose the file containing the values you wish to 
copy. Choose the desired file, click OK; the values are 
copied into the new file automatically. You may then edit 
these values without changing the file you copied them 
from.
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Advanced

When you open an existing sample information file or create a new one using the Advanced 
format, all parts of the sample file are displayed in a tabbed dialog. The Advanced format 
allows you to customize sample files. Chapter 3 provides step-by-step instructions for creating 
an Advanced sample information file.

The prompts for the Sample, Operator, Submitter, and User Parameter fields may be 
customized by selecting Options, Sample defaults. Refer to "Sample Defaults" in Chapter 8 
for instructions on customizing these prompts.

Sample Contains the next sequenced file description based on the 
format you specified in Sample defaults (refer to "Sample 
Defaults" in Chapter 8). You may enter a new description 
or add to the existing one.

Range:50 alphanumeric characters

Operator
Submitter

Displays the Operator and Submitter names if specified in 
Sample Information default file. Generally, these fields (if 
used) are completed when the sample file is created.

Range:40 characters
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Type of Data Allows you to choose whether data are to be collected 
automatically or manually entered.

User Parameters These fields are used specifically for SPC (Statistical 
Process Control) reporting. These user-specified 
parameters are defined in the Default Sample Information 
file. If SPC reporting is not desired, the fields can be 
omitted from the sample information dialog using the 
Omit checkbox in the default file. Refer to "Sample 
Defaults" in Chapter 8. 

Comments Enables you to enter comments in the sample information 
file.

Enables you to enter comments to be included in the 
instrument log. The Add Log Entry dialog is displayed. 

Enter your comments, then click OK. Anything you enter 
in this dialog appears in the Instrument Log Report.

Allows you to copy values from an existing file into the 
one you are creating. A dialog is displayed so that you 
may choose the file containing the values you wish to 
copy. Choose the desired file, click OK; the values are 
copied into the new file automatically. You may then edit 
these values without changing the file you copied them 
from.
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Analysis Conditions

Analysis conditions files specify the data used to guide an analysis. They contain two parts of 
the sample file: Material properties and Analysis options. When you select to open an existing 
analysis conditions file or create a new one, a two-tabbed dialog is displayed. 

Material Properties

This dialog allows you to specify properties for the sample and analysis liquid. 

Description If you are opening an existing analysis conditions file, 
this field contains the description.

If you are creating an analysis conditions file, this field 
allows you to enter a name. You should use an intuitive 
name which characterizes the materials analyzed.

Range:40 alphanumeric characters
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Allows you to copy values from an existing file to the one 
you have open. A dialog is displayed so that you may 
choose the file containing the values you wish to copy. 

Select the desired file, click OK; the values are copied 
automatically into the new file. You may then edit these 
values if you wish; the file you copied them from will not 
be affected.

Sample Material Group 
Box

Displays an alphabetical list of available sample 
materials. Once you select a sample material from this 
list, its description and density are displayed.

   Description Displays the sample material you select from the list. This 
field also is used to enter the name of sample materials 
you wish to add to the list.

   Density Displays the density of the sample material you selected 
from the list.

 

Allows you to add sample materials to the list. In the 
Description field, enter the name of the material you 
wish to add, then click Add.

This button also is used to change the density for a sample 
material. Select the sample material and enter the new 
density. Move the mouse pointer to another field; note 
that Add changes to Change. Click Change; the values 
are changed.

  

Allows you to delete sample materials from the list. 
Select the sample material you wish to delete, then click 
Delete.

Analysis Liquid Group Box Displays a list of the Liquid Properties files defined in the 
Default Parameters directory, as well as any you have 
created.

   Description Displays the analysis liquid you select from the list. This 
field also is used to enter the name of analysis liquids you 
wish to add to the list.
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X-Ray Intensity Displays the X-ray intensity selected for the analysis 
liquid. The intensity is selected in Liquid Properties 
dialog.

Allows you to edit the properties of the analysis liquid 
you select from the list. The Liquid Properties dialog is 
displayed.

Description
Contains the name of the Liquid Properties file.

 Current Cell Conditions
Displays the cell conditions of the analysis unit. These 
conditions are based on the temperature of the cell and are 
used in computing the analysis statistics displayed on the 
Material Properties dialog.
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Liquid Properties Values
Allows you to choose between fixed values or 
interpolated values based on the cell temperature.

If you select Fixed values, you must enter a value in the 
Viscosity and Density fields. These values will be 
maintained regardless of the cell temperature.

If you select Interpolate using cell temperature, you must 
enter three sets of values in the Temp., Density, and 
Viscosity fields. These values will be used to interpolate 
the density and viscosity at the current cell temperature.

The table requires that the entered values be properly 
ordered. Temperature in ascending order for example. 
Enter values from left-to-right and from top-to-bottom.

X-Ray intensity
Enables you to select the X-Ray intensity:

The Normal selection is optimized for most applications 
when using high X-ray absorption liquids, such as water.

The Low selection decreases intensity when using low X-
ray absorption liquids, such as hydrocarbons. 

Allows you to add analysis liquids to the list and change 
values for an analysis liquid.

To add analysis liquids: In the Description field, enter the 
name of the liquid you wish to add, then click Add.

To change values of an analysis liquid: Highlight the 
liquid, then click Properties. Enter the new values, then 
click OK. Note that Add changes to Change; click 
Change.

Deletes the selected liquid from the list.

Analysis Type Allows you to specify whether you wish your analysis to 
be a Standard, High Speed or High Resolution.

Standard provides good resolution and average analysis 
time. High speed allows a faster analysis, but a little lower 
resolution. High resolution provides high resolution at the 
smallest diameters, but takes a longer time.
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Starting diameter
Ending diameter

Allows you to specify the range of sizes you wish to be 
included in the analysis. 

The starting diameter generally should be larger than the 
largest particle expected to be in the sample.

The ending diameter must be less than the smallest size 
particle you are interested in.

Each time you change the values in these fields, the 
analysis statistics are updated automatically. A note also 
is added to the report header indicating changes have been 
made since the first analysis was performed.

Analysis Unit Displays a list of the attached units and their 
temperatures. The displayed temperature is used to 
compute analysis statistics.

Reynolds number: The Reynolds number is calculated for the starting 
diameter using the sample’s density and the liquid’s 
density and viscosity. If this number is greater than 0.3, 
large particles falling through the liquid may create 
turbulence, affecting both their velocity and the velocity 
of neighboring smaller particles. This results in an 
incorrect particle size distribution.

Maximum diameter: The maximum diameter is calculated to have a Reynolds 
number equivalent to the one you entered as a default 
(from the Options menu). If your sample has more than a 
couple percent mass of particles larger than this diameter, 
the sample should be analyzed in a liquid with a higher 
viscosity.

Analysis time: Time is calculated based on the sample density, liquid 
density and viscosity, and ending diameter. The actual 
analysis time may vary slightly if the analysis 
compartment temperature is different when the analysis 
takes place.

The Reynolds number, Maximum diameter, and Analysis 
time fields display analysis statistics. These values are 
updated automatically whenever a parameter affecting 
their computation is changed.
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Allows you to update the material properties of a 
completed analysis. This allows the collected data to be 
reprocessed based upon the new properties.

The material properties for the original analysis remain 
unchanged. A note is added to the report header 
describing the change.

When you select this push button, the Update Material 
Properties dialog is displayed.

The contents of the Sample Material and Analysis 
Liquid group boxes are described in “Material 
Properties” on page 5-13.

Allows you to apply a baseline different than the one 
active in the original analysis; the Select Baseline dialog 
is displayed.
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From the drop-down list, choose the instrument 
containing the baseline you wish to use. Then select Use 
alternate baseline. The original baseline is preserved if 
you decide to use it.

Select this button to apply all changes to the material 
properties.

This message displays: 
All test data will be converted to the new data 
reduction options. Do you wish to continue?

Click Yes.

The data are converted and this message displays:
Application of new reduction options (file name) is 
complete.

Click OK to close the message box.
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Analysis Options

This dialog allows you to edit analysis options as long as 1) an analysis is not in progress, and 
2) the sample file does not contain manually entered data. Any changes you make to analysis 
parameters (after an analysis is complete) are noted in the report header.

Select the Analysis Options tab to display its dialog.

MasterTech Treatment 
Group Box

Allows you to specify the stirrer time, stirrer speed, and 
probe time. (Available only if you have a MasterTech.)

Samples tend to settle in the beakers while waiting for 
sample analysis, especially if samples are prepared ahead 
of time, as in most cases when using a MasterTech. With 
the options in this group box, you can program the 
MasterTech stirrer and probe to redisperse the sample.

Stirrer time Allows you to enter the number of seconds to have the 
stirrer operate during resuspension.

Stirrer speed Allows you to choose stirrer speed. Coarse materials and 
less-stable dispersions may require more high-speed 
stirring than finer materials.

Range: 1 to 10, with 1 being the slowest
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Probe time Allows you to enter how long to have the ultrasonic probe 
operate during resuspension. Coarse materials and less-
stable dispersions may require more high-speed stirring 
than finer materials.

Other Options Group Box Stop at selected mass percent
Allows you to stop the analysis at a specified mass 
percent finer.

If you are unsure of the smallest size particle present in 
your sample, it may be difficult to determine an ending 
diameter which will include all desired data. With this 
option, you can choose to end mass percent at 0%, after 
having set the ending diameter at a small value of 
approximately 0.1 m. Using this method, you do not 
have to wait any longer than necessary for the end of the 
analysis.

Ending percent finer 
Enabled only if you selected the previous option. Enter 
the point at which you wish the analysis to stop. 

Number of tests
Allows you to enter the number of analyses you wish to 
be performed on the sample. You may enter up to 8.

Leave pump on during analysis 
Coarse materials tend to settle in the tubing during 
analysis. This option allows you to have the pump operate 
during analysis, enabling easier rinsing and resuspension 
of the sample.

Wait for temperature stabilization 
Select this option if you wish to have the temperature in 
the analysis compartment and mixing chamber stabilize to 

within + 0.5 oC of the setpoint before the analysis begins.

Mixing chamber stirrer speed
Adjusts the speed of the magnetic stirring bar, which stirs 
the mixture in the mixing chamber. Select a number 
between 1 and 10. 1 represents the lowest speed and 10 
the highest.
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Full Scale Scan Group Box Pump speed

Allows you to enter the speed at which you wish the cell 
pump to operate during the full-scale scan. 

Use a pump speed of 2 or 3 if analyzing fine samples 
since they pump through the tubing easily. If coarse 
particles are being analyzed, especially if dispersed in 
higher viscosity liquids, a higher pump speed of 4 to 5 
should be used.

If your SediGraph has the smaller 5-mm (3/16-in.) OD 
tubing, higher speeds may be required for finer particles 
also.

Bubble detection
This drop-down list allows you to choose the type of 
bubble detection you wish to use.

The presence of most bubbles in the cell can be detected 
during the full-scale scan that takes place at the start of 
the analysis. Detecting bubbles, however, is somewhat 
sample-dependent. Samples which contain very large 
particles may appear to have bubbles near the top of the 
cell, when actually the sudden change in X-ray intensity 
is due to incomplete filling of the topmost portion of the 
analysis cell. For samples of this type, you should use 
coarse bubble detection.

If only small particles are present in your sample (less 
than 1 mm), use fine bubble detection. For samples 
between these two ranges, use medium bubble detection.

Rinse Group Box Rinse after analysis
Select this option if you wish to have the analysis cell 
rinsed after each analysis. Then select whether you wish 
to have the cell rinsed automatically or a specified 
number of rinses.

Pump Speed
Allows you to enter the speed at which you wish the cell 
pump to operate during the rinse operation.
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Liquid Properties

This dialog is used to:

• edit the properties of an analysis liquid
• specify properties for a new liquid properties file

The liquid properties also may be edited by selecting the Materials Properties 
dialog.

Description If you are editing an existing file, this field contains the 
name of the file you selected.

If you are defining a new file, you must enter a name in 
this field.
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Liquid Properties Values Allows you to choose between fixed values or 
interpolated values for liquid properties.

If you select Fixed values, enter a value in the Viscosity 
and Density fields. These values are maintained 
regardless of the cell temperature.

If you select Interpolate using cell temperature, enter 
three sets of values in the Temp., Density and Viscosity 
fields. These values are used to interpolate the density and 
viscosity at the current cell temperature.

The table requires that the entered values be properly 
ordered, Temperature in ascending order for example. 
Enter values from left-to-right and from top-to-bottom.

X-Ray intensity Allows you to select the X-ray intensity.

The Normal selection is optimized for most applications 
when using high X-ray absorption liquids, such as water.

The Low selection decreases intensity when using low X-
ray absorption liquids, such as hydrocarbons. 
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Report Options

This dialog is used to:

• Edit report options
• Specify report options for a new file

Report options ID

 

If you are editing an existing file, this field displays the 
identification of the report options file. You may change 
this name if you wish.

If this is a new file, enter a name of up to 50 characters.

Allows you to copy values from an existing file to the one 
you have open. A dialog is displayed so that you may 
choose the file containing the values you wish to copy. 
Select the desired file, click OK; the values are copied 
automatically into the new file. You may then edit the 
new values without changing the original file.

Show report title Allows you include a title in reports.

To include a title, click the checkbox, then enter a title of 
up to 50 characters in the field next to it.
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Show graphic Enables you to select a graphic to appear in the report 
header. For example, you may wish to include your 
company logo.

To include a graphic, click the checkbox, then enter the 
pathname of the graphic file, or click Browse and select a 
file.

Height:
Width:

Enables you to enter the height and width of the graphic, 
in inches, if you selected Show graphic.

Distribution Type Allows you to select the type of distribution data you wish 
to report.

Allows you to specify a sample file with which to 
compare analysis results of the current sample; the 
Reference Sample dialog is displayed.

Click Browse to display the Reference Sample File 
Selection dialog containing a list of sample files from 
which to choose. Choose a file, click OK; the file name is 
copied into the Reference Sample dialog.

Allows you to specify the sample files to be used for the 
coarse and fine specification boundaries. You then can 
quickly determine if the results of the current sample are 
within the specified boundaries. The Specification 
Samples dialog is displayed.
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Select Browse to the right of each field to display the 
Specification Sample File dialog containing a list of 
sample files from which to choose. Choose a file, click 
OK; the file name is copied into the Specification 
Samples dialog.

Allows you to choose the sample files you wish to overlay 
onto selected plots; the Graph Overlay Samples dialog is 
displayed.

Click Browse to the right of each sample number field to 
display the Graph Overlay Sample File dialog containing 
a list of files from which to choose. You may select up to 
eight files. Refer "Generating Overlays" in Chapter 3 for 
instructions on generating overlays.

Test Use this drop-down list to specify the analysis you wish to 
have a report generated for.

Reports to Generate Contains a list of available reports.

Using the mouse pointer or the arrow keys, move to the 
desired report and click the left mouse button, or press the 
Spacebar. When a report is selected, it is preceded with a 
check mark. You may deselect it in the same manner.
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Allows you to edit the options of the reports in the 
Reports to Generate list box. Highlight the report you 
wish to edit and click Edit.

To Edit a Table

If you wish to edit a table, a dialog similar to the one 
shown below is displayed.

Column [n]
Allows you to specify the type of data you wish to display 
in that column. The choices, based on the table chosen, 
may include some or all of the following:

None
High Particle Diameter
Low Particle Diameter
Average Particle Diameter
Cum. Mass (Percent Finer)
Mass Freq. (Percent)
Cum. Mass Std. Dev for all tests
Diff. from ref. (Percent Finer)
Out of spec (-%<,+%)
Surface Area Coarser
Area in Interval
Number Coarser
Number in Interval
Particle Size (Phi)
Settling Velocity

Order of Sizes
Allows you to choose between ascending or descending 
order for your data.
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Truncate table at distribution limits
Allows you to shorten the table to the limits of the 
distribution.

Data Points Table
Allows you to enter the values at which you wish the data 
to be reported (or accept the defaults).

Allows you to insert points into the table. Highlight the 
point at which you wish to enter a new one, then click 
Insert. If no points are highlighted, the new point is 
inserted at the beginning.

You may use Ctrl + Up to add points at the beginning and Ctrl + Down to add points 
at the end.

Allows you to delete points in the table. Highlight the 
point you wish to delete, then click Delete.

Allows you to delete all points in the table at one time.
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To Edit a Graph

If you wish to edit a graph, a dialog similar to the one 
shown below is displayed.

Plot Type
Allows you to choose between curve or histogram for 
your plotted graphs.

Autoscale Options
Select the options in this group box if you wish to have 
the X- and/or Y-axes automatically scaled. Both axes 
begin at zero, and the system uses the highest values 
collected during analysis as the ending points. The Axis 
Range fields are disabled if you choose to autoscale data.

If you choose not to autoscale data, you must enter the 
ranges for the X- and Y-axes.

X-Axis
Allows you to select the how the X-axis values are to be 
displayed. Click the appropriate radio button to select one 
of the following:

Standard Particle Size
Size in Phi Units
Settling Velocity
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Overlay
This drop-down list displays the type of overlays 
available.

Choose Samples if you wish to overlay the same type of 
curve from a different data reduction. Then click 
Overlays on the Report Options dialog to make your 
choice(s).

Choose Tests if you plan to overlay the same type of curve 
from all tests performed with this file.

Axis Range
This group box allows you to specify beginning and 
ending values for the X- and Y-axis ranges. Data collected 
outside these ranges are not included in the plot.

The values entered in the To fields must be greater than the values entered in the 
From fields.
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Collected/Entered Data

This dialog displays only when your option presentation is selected as Advanced. Depending 
on the type of data selected on the Sample Information screen, this dialog displays as either 
Collected Data or Entered Data.

Collected Data

Table Displays the data collected for the current test.

Test Displays the current test for this sample file. If you wish 
to view data for another test, click on the down arrow to 
select the desired test.

Merge with external data Select this option to merge data collected by manual 
methods with the collected data.
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Enabled when you select Merge with external data. 
Displays the External Data dialog so that you can enter 
the data you wish to have merged.

Allows you to enter new data in the table. If this is a 
particle size table, you may enter the particle size and 
cumulative percent for the particle. If this is a sieve table, 
a set of sieves is displayed so that you may enter the 
percent passed through each size.

Removes the selected row from the table.

Deletes all but one entry of the table (one entry is 
required). So that it is not deleted in error, a warning 
message is displayed.

This type of table displays if 
you choose Sieve size for the 
size type.
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Size Type
Allows you to specify the type of size data.

Select Particle size to enter the particle diameter and 
cumulative percent for the sample. 

Select Sieve size to enter the percent passed through each 
sieve.

Distribution Type
Allows you to specify the type of distribution data.

Autoscale percent of total sample
When this option is selected, the overlapping regions of 
the collected data and the merged data are used to rescale 
the collected data so that the regions match. 

When this option is deselected, the percentages you enter 
for the merged data are used and the nonoverlapping 
portion of the collected data is scaled to be the percent 
passing through the smallest sieve. 

Full scale mass percent: Allows you to specify the weight percent of the sample 
actually analyzed by the SediGraph versus the percent 
that is manually analyzed. The data are scaled 
accordingly.

Use this option if you analyzed part of the sample by 
another method but you do not wish to merge those 
results with the reports for the current analysis.

This field is disabled if Merge with external data is 
selected.

Distribution Type These options are disabled on this dialog. The distribution 
type can be selected from the Report Options dialog.
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Entered Data

You cannot enter data if the analysis program is being used for offline data 
manipulation on a computer other than the one controlling the analyzer.

This type of table displays if
you choose Sieve size for the
size type.

Table Allows you to enter pertinent data.

Allows you to enter new data in the table. If this is a 
particle size table, you may enter the particle size and 
cumulative percent for the particle. If this is a sieve table, 
a set of sieves is displayed so that you may enter the 
percent passed through each size.

Removes the selected row from the table.

Deletes all but one entry of the table (one entry is 
required). So that it is not deleted in error, a warning 
message is displayed.

Size Type Allows you to specify the type of size data.

Select Particle size to enter the particle diameter and 
cumulative percent for the sample. 

Select Sieve size to enter the percent passed through each 
sieve.

Distribution Type Allows you to specify the type of distribution data.
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Save

Save enables you to save any changes you have made to the file in the active window. The file 
is saved under its current name.

Save As

Save As enables you to save the sample file or parameter file in the active window under a 
new name. Saving the file under a new name allows you to make modifications without 
changing the original file. 

You may save a sample information file as another sample information file or as any parameter 
file. Parameter files, however, may be saved only as another parameter file of the same type. 
For example, you may save a sample information file as an analysis conditions file, liquid 
properties file, or a report options file. But an analysis conditions file may be saved only as 
another analysis conditions file.

When you select Save As with a sample information file open, four choices are presented: 
Sample information, Analysis conditions, Liquid properties, and Report options. Select the 
desired file type, a dialog similar to the one shown below is displayed.

File name: Choose one of the following options:

• Enter a name of up to 8 alphanumeric characters.

• Select a file from the Files: list box. If you select an 
existing file as the new name, the data contained in 
that file are overwritten.
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Save All

Save All enables you to save all open files under their current names. This option provides a 
faster way to save all open files at one time and avoids having to perform a Save operation on 
each individual file. 

Close

Close enables you to close the file in the active window. The following message is displayed 
if changes have been made to the file:

(File name) has been changed.
Save changes before closing?

• Yes saves any changes and closes the active window
• No discards any changes and closes the active window
• Cancel leaves the file active

Close All

Close All enables you to close all open files under their current names. The following message 
is displayed for each file in which changes have been made:

(File name) has been changed.
Save changes before closing?

• Yes saves any changes and closes the active window
• No discards any changes and closes the active window
• Cancel leaves the file active

Files:
Directories:

This push button and the contents of these list boxes are 
explained in Selecting Files in Chapter 2.
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Print

Print enables you to print the entire contents of a file. When you select File > Print from the 
main menu, four choices are presented: Sample information, Analysis conditions, Liquid 
properties, and Report options. Regardless of which file type you select, a dialog similar to the 
one shown below is displayed.

File name: The name of the file you select from the Files: list box is 
copied to this field.

Files:
Directories:

This push button and the contents of these list boxes are 
explained in Selecting Files in Chapter 2.

Destination: Contains a drop-down list of the available print 
destinations.

If you select Screen, the file is displayed on the screen.

If you select Printer or Printer/Plotter, select the number 
of copies to be printed. The requested file is sent to your 
default printer.

If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. You also 
must enter a name in the File name: field of the Settings 
group box.
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List

List enables you to generate a listing of the following information on a selected file:

• file name
• date the file was created
• time the file was created
• file identification
• file status

When you select File, List from the main menu, four choices are presented: Sample 
information, Analysis conditions, Liquid properties, and Report options. 

Regardless of which file type you select, a dialog similar to the one shown below is displayed.

File name: If you select only one file from the Files: list box, the 
name is copied to this field. If multiple files are selected, 
the last one selected displays in this field.

You may request a list of multiple files by holding down Ctrl while selecting files. If 
no files are selected, a list is generated for all files.

Files:
Directories:

This push button and the contents of these list boxes are 
explained in Selecting Files in Chapter 2.
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Export

Export allows you to copy data in a sample information file and reformat it in ASCII format 
as either smoothed or unsmoothed data. The ASCII data then can be imported into other 
applications, such as spreadsheets, accepting ASCII format. You may select multiple files by 
holding down and clicking the left mouse button once on each file.

Select File, Export from the main menu; the Export Sample File dialog is displayed.

Destination: Contains a drop-down list of the available print 
destinations.

Choices:Screen, Printer, Printer/Plotter, File

If you select Printer or Printer/Plotter, enter the number 
of copies to be printed.

Settings, File name: Enabled only if you select File as the destination. Enter a 
name in the File name: field.

File name: The name of the file you select from the Files: list box is 
copied to this field.
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Files:
Directories:

This push button and the contents of these list boxes are 
explained in Selecting Files in Chapter 2.

Settings Group Box
   Export Type

Drop-down list containing the types of data export 
available.

Choices: Raw ASCII, Smoothed ASCII, Unsmoothed 
ASCII

Raw ASCII is time, height, and mass fraction.
Smoothed ASCII exports data in a form as used in reports. 
Unsmoothed ASCII exports data in a form as collected by 
the instrument. Refer to Appendix J for a description of 
the smoothing technique.

Destination: Contains a drop-down list of the available destinations.

Choices: Screen, Printer, Printer/Plotter, File

If you select Printer or Printer/Plotter, enter the number 
of copies to be printed.

Settings, File name: Enabled only if you select File as the destination. Enter a 
name in the File name: field.
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Convert

Use this option to convert sample information files created with a non-Windows version of the 
SediGraph analysis program to sample information files that are compatible with Windows. 
You may select multiple files by holding down Ctrl and clicking the left mouse button once on 
each file.

After a sample file has been converted to the Windows version, it and its parameter files can 
be used with any analysis as long as the analysis has not been completed. You cannot, 
however, update material properties.

Select File > Convert from the main menu; the File Convert Sample Selection dialog is 
displayed.

File name: Use this field to limit the list of file names displayed in 
the Files: list box. For example, in the dialog shown 
above, file names have been limited to those beginning 
with SG by entering SG*.DAT in the File name: field.

Refer to "Selecting Files" in Chapter 2 for instructions on 
using this push button.
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Destination, 
Samples:

Defaults to the appropriate directory in the WIN5120 
directory. You may change this destination if you wish.

Destination, 
Parameters:

Defaults to the appropriate directory in the WIN5120 
directory. You may change this destination if you wish.

System directory: Enter the directory containing the parameter files. 

Two types of parameter files are associated with a non-
Windows sample file; Liquid Properties (lp<table 
number>.dat) and User-Defined Report Table (ud<table 
number>.dat). These files are required for a successful 
conversion. 

If you are converting files using the same computer on 
which the files were created, all required files will be 
located automatically during conversion.

If you plan to use a different computer for converting 
files, it is imperative that the required files for each 
sample file be copied to complete the conversion. It is 
best to zip the entire directory from the source computer 
and then unzip on the destination computer, especially if 
you have numerous files to convert. This way, you are 
ensured that all required files accompany the sample file.

If you fail to enter a directory in this field, the conversion 
proceeds, but is incomplete since all files may not be 
located. A warning message is displayed in the Status 
window if all parameter files are not found.
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Exit

Exit enables you to exit the SediGraph analysis program. Select File > Exit from the main 
menu. Even if an analysis is in progress, it will continue until completion; analysis data are 
collected and stored in the analyzer.

• If a window containing a modified file is open, the following message is displayed:

(file name) has been changed. Save changes before closing?

-  Yes saves any changes and exits the analysis program
-  No abandons any changes and exits the analysis program
-  Cancel leaves the analysis program active

• If an analysis is in progress, the following message is displayed:

You tried to exit the WIN5120 analysis program while an analysis is in 
progress. While this is possible, the data collected while the WIN5120 
analysis program is inactive will not be permanently recorded until the 
analysis program is re-started. A power failure to the instrument could 
cause some data to be lost.

-  Yes exits the analysis program
-  No leaves the analysis program active and allows the analysis to finish

• If a report is being printed, the following message is displayed:

CAUTION: A report is currently printing. If you exit the program the report will 
be canceled. Do you want to cancel the report and exit the program?

-  Yes cancels the report and exits the analysis program
-  No leaves the analysis program active and allows the reports to finish 

If the MasterTech is being used, the current analysis continues until it is finished; 
subsequent analyses are postponed and resumed when the analysis program is 
restarted.

Although data are stored in the analyzer when you exit the program, data are not 
saved to disk in the computer until you reenter the program. If a power failure 
occurs and the analyzer does not have an Uninterruptible Power Supply (UPS), any 
data not saved are lost.
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Overview

The Unit menu contains the operations which can be performed with the SediGraph 5120. The 
main menu contains a Unit menu for each attached analyzer. For example, if you have two 
attached analyzers, the main menu contains two Unit menus. 

For easy differentiation, the status displays associated with each individual unit are displayed 
in different colors. The unit number and the serial number also are displayed in the title bar of 
the operational windows. 

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are found 

The Unit menu does not appear on the menu bar if the analysis program is being 
used for offline data manipulation.
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later in this chapter.

Sample Analysis Use this mode of operation to perform single sample 
analyses. This option is disabled if analyses are being 
performed in another mode.

Quick Start Use this mode of operation to perform successive sample 
analyses. 

Repeat Analysis Use this mode of operation to perform multiple analyses 
on the same sample.

MasterTech Automatic Use this mode of operation to analyze a series of samples 
of the same type with the same analysis conditions. 
Sample files are created automatically. Enabled only if a 
MasterTech is installed.

MasterTech Schedule Use this mode of operation to analyze a series of samples 
which may be different in size and shape and, 
consequently, require different analysis conditions. 
Enabled only if a MasterTech is installed.

Baseline Allows you to perform a baseline measurement.

Drain and Load Allows you to perform a drain and load operation

Rinse Allows you to perform a rinse operation.

Choose SediGraph to rinse the analysis cell, the mixing 
chamber, and the tubing of the SediGraph.

Choose MasterTech to rinse the MasterTech tubing into a 
specified beaker.

Choose Both to rinse the analysis cell, the mixing 
chamber, and the tubing for both the SediGraph and 
MasterTech.

Initialize MasterTech Allows you to start the MasterTech or realign the 
MasterTech turntable if it has been disturbed.

Enable Manual Control Allows you to control the system manually when the 
analyzer is idle.

Show Instrument Schematic Displays a schematic of the analyzer.
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Show Status Displays the status window of the operation in progress.

Unit Configuration Displays the configuration of the analyzer.

Calibration Enables you to enter calibration data. This option is 
enabled only with the direction of a Micromeritics service 
representative.

Service Test Enables you to perform certain troubleshooting 
procedures. This option is enabled only with the direction 
of a Micromeritics service representative.
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Sample Analysis

Use this mode of operation to perform individual sample analyses. When you select this option 
from the Unit menu, the Sample Analysis dialog box is displayed.

Displays the Select Sample Information dialog box, 
allowing you to select a sample file for your analysis.

Select the sample, then click OK.
6-6                                                    512-42801-01 (Rev L) Apr 2022



Sample Analysis SediGraph 5120 Operator’s Manual
Sample Displays the sample identification string of the sample.

Analysis Conditions Displays the analysis conditions file in the selected 
sample information file. 

The drop-down list enables you to select another analysis 
conditions file if desired.

This list is disabled for files which have been used for an 
analysis.

Sample:
Liquid:

Displays the type of sample and dispersing liquid used 
with the analysis conditions file you selected from the 
Analysis Conditions drop-down list.

Sample Density Displays the density of the sample specified in the 
Analysis conditions file. You may edit these properties as 
long as the sample file is not complete (used in an 
analysis). If, however, significant adjustments are 
required, you should switch to advanced mode and define 
a new type of sample material. 

If the sample file is complete, density properties may be edited by opening the 
sample file and selecting Advanced, then selecting the Material Properties tab and 
Update Properties.

Number of tests Allows you to enter the number of analyses you wish to 
perform using this sample file; you may enter up to eight.

Rinse after analysis Allows you to rinse the cell, the tubing, and the mixing 
chamber after each analysis. It is highly recommended 
that this option remain selected. If you deselect this 
option and rinses are not performed after analysis, 
inaccurate results may be obtained.

Report Options Displays the report options file in the selected sample 
information file. 

The drop-down list enables you to select another report 
options file if desired.

Reports List Box Displays the selected reports from the file you select from 
the Report Options drop-down list. You may change the 
report selection if you wish.
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Merge with external data Allows you to merge data collected using manual 
methods with the data collected for the current analysis.

Enabled when you select Merge with external data. 
Displays the External Data dialog so that you can enter 
the data you wish to have merged.

Allows you to enter new data in the table. If this is a 
particle size table, you may enter the particle size and 
cumulative percent for the particle. If this is a sieve table, 
a set of sieves is displayed so that you may enter the 
percent passed through each size.

Removes the selected row from the table.

Deletes all but one entry of the table (one entry is 
required). So that it is not deleted in error, a warning 
message is displayed.

This type of table displays if 
you choose Sieve size for the 
size type.
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Size Type
Allows you to specify the type of size data.

Select Particle size to enter the particle diameter and 
cumulative percent for the sample. 

Select Sieve size to enter the percent passed through each 
sieve.

Distribution Type
Allows you to specify the type of distribution data.

Autoscale percent of total sample
When this option is selected, the overlapping regions of 
the collected data and the merged data are used to rescale 
the collected data so that the regions match. 

When this option is deselected, the percentages you enter 
for the merged data are used and the nonoverlapping 
portion of the collected data is scaled to be the percent 
passing through the smallest sieve.

Full scale mass percent: Allows you to specify the weight percent of the sample 
actually analyzed by the SediGraph versus the percent 
that is manually analyzed. The data are scaled 
accordingly.

Use this option if you analyzed part of the sample by 
another method but you do not wish to merge those 
results with the reports for the current analysis.

This field is disabled if Merge with external data is 
selected.

Allows you to copy values from an existing file into the 
one you are creating. A dialog box is displayed so that 
you may choose the file containing the values you wish to 
copy. Choose the desired file, click OK; the values are 
copied into the new file automatically. You may then edit 
these values without changing the file you copied them 
from.
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When you select Next>> on this window, all selections are saved; then the following view 
of the Sample Analysis dialog box is displayed.

View Allows you to choose which view you wish displayed in 
the window from a drop-down list.

Choices: Operation, Analysis Log, Instrument Schematic

Operation displays the data points as they are collected 
during analysis.

Analysis Log displays a list of recent operations and error 
messages for the active analyzer. By default, sample 
analyses and error messages are logged for seven days 
and baselines are logged for 30 days. You may receive a 
printout of the analysis log by clicking Report.

Instrument Schematic displays a schematic of the 
instrument.

Prepare SediGraph to load 
sample

Select this option if the sample has not been loaded into 
the mixing chamber. If you select this option, a drain and 
load operation is performed.

Leave liquid in mixing 
chamber
Leave mixing chamber 
empty

Allows you to leave liquid in the mixing chamber or leave 
the mixing chamber empty.
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Report Options

   Report After Analysis

This group box is used to designate report options. 

Allows you to have a report(s) generated automatically 
after each analysis.

   Number of Reports Allows you to specify the number of reports you wish to 
have printed if you select Printer or Printer/Plotter for 
destination.

   Destination Choose a destination for report output.

Choices: Screen, Printer, Printer/Plotter, File

   File name This field is enabled only if you choose File as the 
destination. Enter a file name.

When you click Next>> from this window, a view of the analysis in progress is displayed. 
A baseline graph and a full-scale scan are displayed in the left side of the window, while 
sample data (as they are collected) are displayed in the right side of the window. Proceed to 
page 6-13 unless you checked the Prepare Sedigraph to load sample box.

If you selected Prepare SediGraph to load sample, a drain and load operation 
(described below) is performed, before the analysis begins. 

a.  Load your sample. If you want to change the mixing 
chamber speed, use the Increase or Decrease button.
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b.  Click Next. The following dialog is displayed.

c.  This dialog allows you to confirm the X-ray intensity 
reduction over the baseline before it completes. It 
shows the percent reduction in baseline intensity. 

• If reduction is between 30 and 75%, Good is 
displayed. This indicates that the concentration 
level is appropriate.

• If the reduction is less than 30%, Low is displayed. 
This indicates that the concentration is too low; 
sample should be added.

• If the reduction is more than 75%, High is 
displayed. This indicates that the concentration is 
too high; more dispersant or less sample should be 
used.

When you are satisfied with the concentration level, click 
Next>>. A view of the analysis in progress is displayed. A 
baseline graph and full-scale scan are displayed in the left 
side of the window, while sample data (as they are 
collected) are displayed in the right side of the window. 
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If you have not specified to rinse after analysis, you may check the Rinse after 
analysis option any time while the analysis is in progress.

This window contains the results of the last sample analyzed. The left pane of the window 
displays the current baseline and full-scale scan, while the right pane displays a graph of 
mass % vs. particle size.

You may size either pane in the window by placing the mouse pointer on the center 
vertical bar and clicking the left mouse button. When the cursor changes to a 2-way 
arrow, pull the pane in the desired direction.

Displays the report(s) selected in the report options file.
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Quick Start

Use this mode of operation to analyze a series of samples of the same type which contain the 
same analysis conditions; sample files are created automatically. When you select this option 
from the Unit menu, the Quick Start Mode dialog is displayed.

 

View Allows you to choose which view you wish displayed in 
the window from a drop-down list. Refer to "View" on 
page 6-10.

Prepare SediGraph to load 
sample

Select this option if you have not loaded the sample. If 
you select this option, an initial drain and load operation 
is performed.

Analysis Liquid Level Allows you to leave analysis liquid in the mixing chamber 
or leave the mixing chamber empty between samples.

Report Settings

   Report After Analysis

This group box is used to designate report options. 

Allows you to have a report(s) generated automatically 
after each analysis

  Destination Contains a drop-down list of the available print 
destinations.

If you select Screen, the file is displayed on the screen.

If you select Printer or Printer/Plotter, select the number 
of copies to be printed. The requested file is sent to your 
default printer.
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If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. You also 
must enter a name in the File name: field of the Settings 
group box.

Sample If you wish these automatically generated sample files to 
have a different string than the one specified in sample 
defaults, enter a name. Be sure to include the $ symbol if 
you wish to have the sample number included as part of 
the name.

When you click Next>> on this window, a dialog prompting you to load the sample is 
displayed.

If you selected Prepare SediGraph to load sample, a drain operation is performed 
before the following dialog is displayed.

Filename: Defaults to the next sequenced sample number for the 
next analysis.

Displays the Select Sample for Analysis dialog box, 
allowing you to select a sample file to use with your 
analysis. This option is used in the event you need to 
interrupt your sequence of samples to analyze a different 
sample.

Sample: Allows you to enter a name for the sample.
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When the analysis is finished, the start next analysis view is displayed automatically so that 
you may proceed with the next analysis.

Mixing chamber speed Allows you to specify the mixing chamber stirrer speed 
using the Increase and Decrease push buttons.

When you click Next>>, a view of the analysis in progress is displayed. A baseline graph 
and full-scale scan are displayed in the left side of the window, while sample data (as they 
are collected) are displayed in the right side of the window. 
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Repeat Schedule

Use this mode of operation to perform multiple analyses on the same sample. When you select 
this option from the Unit menu, the Repeat Schedule dialog box is displayed.

 View Allows you to choose which view you wish displayed in 
the window from a drop-down list. Refer to "View" on 
page 6-10.

An additional choice is also included in the drop-down 
list: Analysis Results, which displays the results of the 
current operation.

 Sample File Window Displays the sample files you select for your analyses.

Begins the analysis. 

When the analysis begins, the Start button changes to 
Stop.The Stop button cancels the remaining analyses. 
The analysis that is currently in progress will be 
completed. 
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Allows you to select the sample files you wish to use for 
the analyses.The Repeat Schedule Insert dialog box is 
displayed.

Displays a list of sample files. Select the file you wish to 
use, then click OK. The file is added to the list in the 
Repeat Schedule dialog.

Number of Tests
Enables you to enter the number of analyses you wish to 
perform using the selected sample information file.

Type of Analysis
Enables you to select either Standard, High Speed or High 
Resolution. 

Allows you to edit the selected file. To select a file, click 
on the file in the list displayed in the Repeat Schedule 
dialog, then select Edit. The Repeat Schedule Edit dialog 
box is displayed.

You can change the number of tests or the type of 
analysis. Make your changes, then click OK.
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You may view the analyses in progress by selecting Analysis Results in the View drop-down 
list.

Allows you to delete unwanted files. Simply select the 
file you wish to delete, then click Delete. This push 
button is disabled if no file is selected.

Allows you to remove all of the entries in the window at 
one time. They do not have to be selected.

Displays the Report Settings dialog box from which you 
may choose report options. Selected report options will be 
generated automatically after each analysis.
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MasterTech Automatic

Use this mode of operation to analyze a series of samples of the same type which contain the 
same analysis conditions; sample files are created automatically. When you select this option 
from the Unit menu, the MasterTech Automatic Mode dialog box is displayed.

 

This option is functional only if you have a MasterTech connected to your analyzer. 

Start with beaker Allows you to enter the position number of the beaker 
containing the first sample to be analyzed. This field is 
disabled if an analysis is in progress.

Sample resuspension Group 
Box

This group box is used to enter resuspension parameters. 
All fields in this group box are disabled if an analysis is in 
progress.

Samples tend to settle in the beaker while waiting for 
analysis, especially if samples are prepared ahead of time, 
as in most cases when using a MasterTech. The options in 
this group box allow you to program the MasterTech 
stirrer and probe to redisperse the sample before analysis.

   Stirrer time Allows you to enter the number of seconds to have the 
stirrer operate during resuspension.
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   Stirrer speed Allows you to choose stirrer speed. Coarse materials and 
less-stable dispersions may require more high-speed 
stirring time than finer materials.

   Probe time Allows you to enter how long to have the ultrasonic probe 
operate during resuspension. Coarse materials and less-
stable dispersions may require more probe time than finer 
materials.

Report Settings Group Box This group box is used to designate report output. The 
fields contained on this group box are disabled if analyses 
are in progress.

   Report After Analysis Allows you to have a report(s) generated automatically 
after each analysis.

   Number of Reports If select Printer or Printer/Plotter for destination, allows 
you to enter the number of reports you wish to have 
printed.

   Destination Specify a report destination.

Choices: Screen, Printer, Printer/Plotter, File

   File name If you selected File at the Destination prompt, enter a file 
name.

Sample Allows you to enter the name and default string you wish 
to have applied to the sample files of the current series of 
analyses.

You can include the beaker number containing the sample 
in the sample identification by entering # within the name 
you specify. For example, Sample in beaker #.

Begins the analysis. 

When the analysis begins, the Start button changes to 
Stop. When you press Stop, the current analysis and the 
next queued analysis will be performed, then the 
remaining analyses in the queue will be canceled.
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MasterTech Schedule

Use this mode of operation to: 

• Analyze a series of samples which may be different in size and shape and, consequently, 
require different analysis conditions

• Perform a series of baseline measurements

• Analyze samples and measure a baseline alternately

When you select this option from the Unit menu, the MasterTech Schedule Mode dialog is 
displayed.

 

This option is functional only if you have a MasterTech connected to your analyzer. 
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Allows you to select the sample files you wish to use for 
the analyses; the MasterTech Schedule Insert dialog box 
is displayed.

If you have a sample file selected in the Sample File 
window, the new file will be inserted before the selected 
file; otherwise it will be inserted at the end of the list.

Beaker Number
Allows you to enter the beaker number containing the 
selected sample (or baseline liquid).

Baseline measurement or Sample Analysis
Allows you to specify either a baseline measurement or 
sample analysis for the specified beaker.

If you select Baseline measurement, select the X-Ray 
intensity.

The Normal selection increases intensity when using 
high X-ray absorption liquids, such as water.

The Low selection decreases intensity when using low X-
ray absorption liquids, such as hydrocarbons.

If you select Sample analysis, click Browse, then choose 
the sample file you wish to use with the sample in this 
beaker position.
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You may wish to use this option if you plan to change dispersing agents with one of 
the samples. This way you could schedule a baseline measurement using the 
beaker preceding the one containing the different dispersant. For example, if you 
plan to change dispersing liquids in beaker position #4, schedule a baseline 
measurement in beaker position #3.

Stirrer time
Allows you to enter the number of seconds to have the 
stirrer operate during resuspension.

Stirrer speed
Allows you to choose stirrer speed. Coarse materials and 
less-stable dispersions may require more probe time than 
finer materials.

Probe time
Allows you to enter how long to have the ultrasonic probe 
operate during resuspension. Coarse materials and less-
stable dispersions may require more high-speed stirring 
time than finer materials.

Sample 
Displays the sample identification string of the selected 
sample file.
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Allows you to edit a sample file or dispersion conditions. 
The MasterTech Schedule Edit dialog box is displayed.

The fields on this dialog box are identical to the fields on 
the MasterTech Schedule Insert dialog box explained on 
above. The only difference is the Sample File field, 
which displays the sample file you are editing.

Allows you to delete any unwanted files. Simply select 
the file you wish to delete, then click Delete. This push 
button is disabled if a file is not selected.

Removes all of the files listed in the window. The files do 
not have to be selected

Allows you to choose report options. Reports are 
generated automatically after each analysis. When you 
click on this push button, the Report Settings dialog box 
is displayed.

   Report After Analysis
Allows you to have a report(s) generated automatically 
after each analysis.
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 Number of Reports
If select Printer or Printer/Plotter for destination, allows 
you to enter the number of reports you wish to have 
printed.

  Destination
Specify a report destination.

Choices: Screen, Printer, Printer/Plotter, File

  File name
If you select File for destination, enter a file name.

Begins the analysis. 

When the analysis begins, the Start button changes to 
Stop. When you press Stop, the current analysis and the 
next queued analysis will be performed, then the 
remaining analyses in the queue will be canceled 
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Baseline

Before you can perform an analysis, you must have a baseline measurement for data 
collection. It is not necessary to measure a baseline for each analysis. Micromeritics 
recommends that you perform a baseline measurement at the change of each shift or if you 
change dispersing agents. You may perform up to seven measurements; however, you may use 
only the last one obtained. 

When you select Baseline from the Unit menu, the Baseline Measurement dialog is displayed. 

Prepare to load baseline 
liquid

Select this option if you have not loaded your baseline 
liquid.

Leave liquid in mixing 
chamber
Leave mixing chamber 
empty

Choose whether you wish to leave liquid in the mixing 
chamber or if you wish to leave the mixing chamber 
empty.

Report After Analysis Allows you to have a report(s) generated automatically 
after each analysis.

   Number of Reports If select Printer or Printer/Plotter for destination, allows 
you to enter the number of reports you wish to have 
printed.

   Destination Specify a report destination.

Choices: Screen, Printer, Printer/Plotter, File
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   File name If you selected File at the Destination prompt, enter a file 
name.

X-Ray intensity Select the X-ray intensity setting.

The Normal selection increases intensity when using 
high X-ray absorption liquids, such as water.

The Low selection decreases intensity when using low X-
ray absorption liquids, such as hydrocarbons.

When you click Next>> on this dialog box, the baseline measurement begins; a window is 
displayed so that you may view the baseline in progress.

If you checked Prepare to load background liquid, a drain and load operation is 
performed before the baseline measurement begins. Load the baseline liquid when 
prompted, then press Next>>; the baseline measurement begins.

When the baseline measurement is finished, a window containing the baseline is displayed.
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Baseline to use Select whether you wish to use the latest or the previous 
baseline. 

Choose Latest to use the last baseline performed.

Choose Previous to use the baseline which was active 
before the last series of baselines were performed.

Advances to the Start baseline window so that you may 
perform another baseline
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Drain and Load

Before you can collect baseline data or perform an analysis, you must drain the SediGraph 
5120 of any previous sample (or baseline liquid), then reload a sample (or baseline liquid). 
You may perform this operation using one of the following methods:

• Prior to a baseline collection or an analysis, select Drain and Load SediGraph from the 
Unit menu (the method explained in this section).

• At the beginning of a baseline collection, select the Prepare to load baseline liquid check 
box on the Baseline Measurement dialog box.

• At the beginning of an analysis, select the Prepare SediGraph to load sample check box 
on the Select Drain and Load dialog box.

When you select Drain and Load from the Unit menu, the Drain and Load dialog is 
displayed.

Mixing chamber 
radio buttons

Allows you to choose whether you wish to leave liquid in 
the mixing chamber or if you wish to leave the mixing 
chamber empty.

Select this push button to continue the operation.
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 Mixing chamber speed You can specify the speed of the mixing chamber stirrer 
using the Increase and Decrease buttons.

Select this push button to continue the operation. 

This dialog allows you to confirm the X-ray intensity 
reduction over the baseline before it completes. 

• If reduction is between 30 and 75%, Good is 
displayed. This indicates that the concentration 
level is appropriate.

• If the reduction is less than 30%, Low is displayed. 
This indicates that the concentration is too low; 
dispersant should be added to the sample.

• If the reduction is more than 75%, High is 
displayed. This indicates that the concentration is 
too high; less dispersant or more sample should be 
used.

When you are satisfied with the X-ray reduction level, 
click Continue and the cell will move to the normal park 
position and the load operation will be complete.
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Rinse

A rinse operation should be performed to rinse the analysis cell, mixing chamber, and tubing 
of any contaminants or sample materials from the previous analysis.

When you select Rinse from the Unit menu, three choices are available:

• SediGraph - rinses the analysis cell, mixing chamber, and the SediGraph tubing.

• MasterTech - rinses the MasterTech tubing.

• Both (SediGraph and MasterTech) - rinses the analysis cell, mixing chamber, the Sedi-
Graph tubing, and the MasterTech tubing.

SediGraph

Select SediGraph; the SediGraph Rinse dialog box is displayed.

 

This option cannot be performed when an analysis is in progress.

Rinse Cycles Autorinse (by default) performs up to three cycles of three 
rinses each (a total of nine rinses) in an attempt to 
reestablish baseline conditions. If conditions are not 
reestablished after nine rinses, an error message is 
displayed. Refer to "Autorinse" in Chapter 8 to change 
Autorinse defaults.

Rinses allows you to specify the number of rinses to be 
performed. You may choose up to five rinses.
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MasterTech

Select MasterTech; the MasterTech Rinse dialog box is displayed.

Cell Pump Speed Allows you to enter the speed for the cell pump to operate 
during rinsing. The range is 1 to 5, with 1 being the 
slowest.

Begins the rinse operation; a message is displayed 
indicating a rinse operation is in progress. When rinsing is 
complete, the dialog box closes.

This option is available only if you have a MasterTech connected to your analyzer 
and analyses are not in progress.

Rinse beaker 
number

Allows you to enter the position number of the beaker you 
wish to rinse into. Make sure the beaker is empty.

Range:1 to 18

Begins the rinse operation; a message is displayed 
indicating a rinse operation is in progress. When rinsing is 
complete, the dialog box closes.
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Both

Select Both; the SediGraph and MasterTech Rinse dialog box is displayed.

SediGraph 
Group Box

Autorinse allows you to have the analyzer automatically 
determine how many rinse cycles to perform.

Rinses allows you to specify the number of rinses to 
perform. You may choose up to five rinses.

Cell Pump Speed field Allows you to enter the speed at which you wish the cell 
pump to operate during rinsing. The range is 1 to 5, with 1 
being the slowest.

MasterTech
Group Box

Allows you to enter the position number of the beaker you 
wish to rinse into. Ensure that the beaker is empty.

Begins the rinse operation; a message is displayed 
indicating a rinse operation is in progress. When rinsing is 
complete, the dialog box closes.
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Initialize MasterTech

Select this option if:

• You wish to perform manual operations with the MasterTech
• The MasterTech beaker tray has been disturbed

When the MasterTech is initialized, the tray is aligned so that beaker #1 is in the starting 
position.

Select Initialize MasterTech from the Unit menu; the Initialize MasterTech dialog box is 
displayed.

Begins initialization; a message is displayed indicating 
that initialization is in progress. When initialization is 
complete, the dialog box closes.
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Enable Manual Control

Select this option to manually control your system. If the instrument schematic is not 
displayed, select Unit [n] > Show Instrument Schematic.

When you enable manual control, the symbols for valves and pumps change color on the 
control screen to indicate manual operation. 

• Valves: Closed = Yellow Open = Green

• Pumps: Off = Yellow On = Green         Disabled by front panel switch = Red

Use one of the following options to move among the system components depicted on the 
control screen:

• Mouse operation: move the pointer to the desired component and click the left mouse 
button once.

• Keyboard operation: move to the desired component using the arrow keys or Tab.

Each component has a pop-up menu displaying the operations available for that paticular 
component. These menus may be accessed by selecting the desired component, then clicking 

 

Manual Control is disabled if an automatic operation is in progress.

Displayed only 
if you have a
MasterTech
Installed
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the right mouse button. You also may use the shortcut keys: Shift + F9.

The options available for the components on the instrument schematic are:

Temp Set Set Temperature
Enables you to set the target temperature. The Set 
Temperature dialog is displayed.

Set point
Enter a temperature set point.

Range 25.0 to 50.0oC

The set point must be at least 10oC above ambient temperature for accurate control.

Mix Pump Turn On
Turn Off
Enables you to turn the mixing pump on or off.

Waste Valve To Waste
To Mixing Chamber
Allows you to set the waste valve position.

Rinse Valve From Rinse
From Mixing Chamber
Allows you to set the rinse valve position.

Mixing Chamber The speed of the mixing chamber magnetic stirrer can be 
set from 1 to 10, with 1 being the lowest speed. 

Increase Speed
Decrease Speed
Enables you to increase or decrease the mixing stirrer 
speed. Each time you click Increase Speed or Decrease 
Speed the setting is incremented or decremented by one.
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Set Speed
Displays the Mixing Chamber Speed dialog.

Speed
Enables you control the stirrer speed by entering a value 
from 1 to 10.

Turn On
Turn Off
Enables you to turn the stirrer on or off.

Air Valve Top
Bottom
Enables you to set the position of the air valve.

Cell Pump Turn On
Turn Off
Enables you to turn the cell pump on or off.

Flow Up in Cell
Flow Down in Cell
Enables you to change flow direction. When you change 
the direction, the arrows in the pump symbol change to 
show the current direction.

Increase Speed
Decrease Speed
Enables you to change the speed of the cell pump. 
The speed of the cell pump can be set from 1 to 5, with 1 
being the slowest speed.

Each time you click Increase Speed or Decrease Speed 
the setting is incremented or decremented by one.
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Cell Move Up Slow
Move Up Fast
Move Down Slow
Move Down Fast
Move to Zero
Move to Load
Enables you to control the movement of the analysis cell. 
An arrow in the cell symbol indicates the direction of cell 
movement.

Move Cell Position
Enables you to enter the cell position. When you choose 
this option, the Move Cell Position dialog displays.

Absolute
Enables you to move the cell position to an absolute 
(relative to the last beamsplit location) number of steps. 
For example, an absolute move of 100 steps moves the 
cell 100 steps above beamsplit.

Relative
Enables you to move the cell position to a relative 
(relative to current positon) number of steps. For 
example, a relative move of 100 steps moves the cell up 
100 steps from its current position.

Cell Position
Enables you to move the cell to the position you enter in 
this field.

Range: -32767 to 32767
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Stop Motion
Stops cell movement.

X-Ray Intensity Normal
X-Ray Intensity Low
Enables you to select the X-ray intensity setting.

Find Beamsplit
Zeros the cell position at the proper beamsplit location. 
The Find Beamsplit dialog is displayed. 

Click Start. Progress messages are displayed, then a 
dialog similar to the one shown below is displayed.

Click Done to close the dialog.

MasterTech 
(shown only if a MasterTech 
is installed)

Move Arm Up
Move Arm Down
Enables you to control the movement of the MasterTech 
arm.

Ultrasonic On
Ultrasonic Off
Enables you to turn the ultrasonic probe on or off.
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Stirrer On
Stirrer Off
Enables you to turn the stirrer in the beaker on or off.

Stirrer Speed Fast
Stirrer Speed Slow
Enables you to control the stirrer speed.

Move to next beaker
Enables you to move the MasterTech arm to the next 
beaker position.

MasterTech Pump
(shown only if a MasterTech 
is installed)

Turn On
Turn Off
Enables you to turn the MasterTech pump on and off.

Flow Direction Rinse
Flow Direction Load
Enables you to set the flow direction of the MasterTech 
pump. When you change the direction, the arrows in the 
pump symbol change to show the current direction.
512-42801-01 (Rev L) Apr 2022                                                    6-41 



SediGraph 5120 Operator’s Manual Show Instrument Schematic
Show Instrument Schematic

Select this option to display a schematic of the SediGraph 5120 and the MasterTech (if one is 
being used). 

You can determine the state of the valves and pumps by color.

• Valves Closed = White Open = Green

• Pumps: Off = White On = Green           Disabled by front panel switch = Red

 

Mixing Chamber             Cell Pump
Stirrer Speed                  Speed

                 
             

Analysis Cell:
Arrow indicates
direction of 
movement

MasterTech Arm

    Ultrasonic Probe Beaker

Arrows in pumps
show flow
direction

Shown only if a
MasterTech is
installed
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Show Status

Select this option to show just the status display of an operation in progress; a status window 
similar to this one is displayed.

You may wish to use this option if:

• You have an automatic operation in progress and you decide to edit a sample file, for 
example. This way, you can keep up with the status of your operation while performing 
another task.

• You have two units attached to your computer. You can select Show Status on each unit 
menu and have the status for both units displayed at one time.

The following are items that may appear in the status display, depending on your instrument 
and the operation in progress.

Mode: Displays the type of operation being performed.

SediGraph: Displays the status of the analyzer, such as Analysis 
operation in progress, Idle, Waiting for load, etc.

Sample: Displays the name of the sample file involved in the 
operation. This field also displays for the MasterTech if 
one is being used. 

MasterTech: Displays the status of the MasterTech. This field is visible 
only when a MasterTech is being used.

Time Remaining: Displays the time remaining on the analysis. This field is 
visible only when an analysis is in progress.

Cell Temp.: Displays the temperature of the liquid in the analysis cell.

X-Ray Counts: Displays the intensity of the X-ray in kilocounts/sec.

Mass Percent: Displays the current mass percent in the analysis.
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Show Instrument Log

Select this option to display a log of recent analyses, calibrations, and errors or messages.  By 
default, this information is logged for a 7-day period for analyses and a 30-day period for 
messages and calibrations. You may change the time for which this information is retained in 
the Unit section of the WIN5120.INI file.

You can choose the type of information to display in the window by selecting only the desired 
item(s). For example, check the Analysis box only to restrict the display to analysis 
information.

Diameter: Displays the current particle size in the analysis.

Analysis Time: Displays the approximate time for the analysis.

Mode: Displays the type of operation being performed.

Analysis, Calibration, and 
Message Checkboxes

Enables you to select the log contents to display.

 

Enables you to display on the screen or print a report of 
log entries. The Log Report Settings dialog is displayed.
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Start Date
Enables you to select the start date for log entries to be 
included in the report. You can specify a start date using 
any of the following methods:

• Highlight the field (or press F2 to clear the field) and 
type in the desired date.

• Double-click the field (or press F4) to display a calen-
dar and choose a date.

• Press F2 to clear the field, then F3 to insert the current 
date.

  Copies
If you select Printer or Printer/Plotter for destination, 
allows you to enter the number of reports you wish to 
have printed.

   Destination
Specify a report destination. Choices: Screen, Printer, 
Printer/Plotter, File

File name
If you select File for destination, enter a file name.
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Unit Configuration

Select this option to display baseline information, as well as the software and hardware 
configuration, of the connected analyzer. When you select Unit Configuration from the Unit 
menu, the Unit Configuration dialog box is displayed.

 

Software Versions Group 
Box 

Displays the software versions of the MICBIOS and 
SediGraph analysis program.

Configuration 
Group Box

Displays the number of the port being used to control the 
analyzer and the serial number of the selected analyzer.

Baseline 
Group Box

Displays the date and the average intensity of the last 
baseline performed. 
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Analyses per tubing set 
Group Box

Enable analyses counter
Allows you to enable or disable the analyses counter. The 
analysis program keeps a counter of the number of 
analyses remaining on the instrument before the next 
recommended tubing change. For every sample 
information file for which an analysis is started (does not 
include service tests or baseline measurements) this 
counter is decremented. 

Max Recommended analyses per tubing set
Allows you to enter the maximum number of analyses to 
be performed before the application displays this 
message:

The maximum number of analyses for this tubing 
has been reached. It is time to change the tubing. 
When the tubing has been replaced, reset the 
counter in the unit configuration dialog.

Analyses remaining on current tubing
Displays the number of analyses remaining before the 
maximum recommended number is reached.

Resets the analyses counter to the recommended 
maximum number.

Calibrations Group Box Displays calibration data.

Displays the Board ID dialog, which describes the circuit 
boards in the analyzer.

Board
A drop-down list that enables you to select the board you 
want to view.
512-42801-01 (Rev L) Apr 2022                                                    6-47 



SediGraph 5120 Operator’s Manual Calibration
Calibration

The Calibration option provides a method of storing instrument calibration data. Your 
Micromeritics service representative may use this option to enter calibration data for future 
reference when servicing the analyzer.

This option is enabled only when the analysis program is operating in Service Test mode (refer 
to Service Test Mode in Chapter 8).

Service Test

Certain service tests are included in the operating program, but can be performed only with the 
assistance of a trained Micromeritics service representative. These tests are designed to 
provide your service representative with instrument readouts, as well as to assist him in 
troubleshooting potential problems and, perhaps, eliminating unnecessary repair services. This 
service strategy allows you to conduct expert tests in less time than it would take to be 
properly trained in servicing the instrument.

This option is enabled only when the analysis program is operating in Service Test mode (refer 
to Service Test Mode in Chapter 8)

Enables you to set the target temperature.

Enter the temperature, then click OK.
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Overview

This chapter describes the options contained on the Reports menu and the type of reports 
available; and contains samples of generated reports.

Description

Listed below are brief descriptions of the options contained on the Reports menu. Detailed 
descriptions follow this section.

Start report Allows you to generate a report on a completed sample 
analysis.

Close reports Closes all open report windows.

Baseline Allows you to generate a report on the current baseline for 
the selected unit.

SPC report options Allows you to specify the sample data to be included in 
SPC reports.

Regression report Allows you to generate a regression report.

Control chart report Allows you to generate a control chart report.

PSD history Allows you to generate a particle size distribution history 
report.
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Start Report

Select this option to generate a report on a sample analysis. The Start Report dialog is 
displayed.

File name: The name you select from the Files: list box is displayed 
in this field. If you select multiple files, only the last one 
selected is displayed.

Status Refer to "Selecting Files" in Chapter 2 for a description of 
the Status field and Dates push button.

Settings Refer to "Selecting the Report Destination" in Chapter 3.

Files: list box Displays a list of the available sample files for the choice 
shown in the Status field.

Directories: Displays a list of available drives and directories. The 
drive and directory last accessed is displayed immediately 
above the Directories: list box.

If you choose a single sample file, the Reports to 
Generate dialog is displayed when you click OK. The 
reports selected are the ones you specified in the sample 
file. This dialog allows you to deselect reports or select 
additional ones.
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Close Reports

This option enables you to close all open report windows at one time. This avoids having to 
select Close on each report window. This option is unavailable if reports are being generated.

Double-click on the report(s) you wish to select (or 
deselect). A check mark is placed before each selected 
report. Pressing the Spacebar performs the same 
function. After you make your report selection and click 
OK, the requested reports are sent to the specified 
destination.

If you choose more than one file, this dialog is not 
displayed. The reports you specified in the sample file 
will be generated and sent to the specified destination.

Check marks
indicate a 
report is
selected
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Baseline

This option allows you to generate a baseline report for the specified instrument. The Start 
Baseline Report dialog is displayed.

Instrument Displays a drop-down list of the attached instruments.

Baseline Date and Time Displays the date and time of the last baseline 
measurement.

 Destination Refer to "Selecting the Report Destination" in Chapter 3.
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SPC Report Options

When you select SPC Report Options, the SPC Calculations dialog is displayed.

Test Drop-down list containing analysis choices for SPC 
calculations.

Last reports statistics for the last analysis in the sample 
file(s).

First reports statistics for the first analysis in the sample 
file(s).

Average reports an average based on all analyses in the 
sample file(s).

Distribution Type
Group Box

Allows you to choose the type of distribution data for 
which the SPC variables are to be computed.

Statistics Type
Group Box

Allows you to choose the type of statistics for which the 
SPC variables are to be calculated.

Statistics 
Group Box

Displays a list of the variables available for SPC 
reporting; you may choose as many as you wish.
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Displays the SPC Sample Options dialog, allowing you to 
select the sample parameters you wish to have reported.

Displays the SPC Analysis Options dialog, allowing you 
to select the analysis conditions you wish to have 
reported.

Displays the SPC Percentile Options dialog, allowing you 
to specify up to five sizes at which the percentiles are to 
be reported.

Specific parameters can
be designated in these
fields. Refer to Sample 
Defaults in Chapter 8 
for additional information.
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Displays the SPC Size Options dialog, allowing you to 
specify the percentiles at which the sizes are to be 
reported.

Peaks Enables you to choose the peaks to include in the SPC 
calculations; you can choose up to five. Use the field 
below to enter the minimum percentage of the distribution 
to report.
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 Regression Report

Select this option to generate a regression report. The regression report is used to determine 
the interdependency between two variables. Up to three dependent variables (Y-axis) may be 
plotted against a single independent variable (X-axis). The degree of correlation between the 
variables also is reported. The graphs for the regression report are scaled so that all three fit on 
a single page. If you choose less than three, the graphs are scaled to fill most of the page.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. 

Deselect this option to omit the report title.

Range: 40 characters.

Show graphic Refer to "Including a Graphic in the Report Header" in 
Chapter 3.

X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. 
Click on the down arrow to display a list of variables. The 
variables in this list are the ones you specified in the SPC 
report options.
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With this option, you may plot the regression of up to 
three Y-axis variables against the X-axis variable. The X-
axis specifies the independent variable for the regression, 
while the Y-axes provide the dependent variables.

Axis Range Allows you to specify the beginning and ending values 
for the X- and Y-axis ranges. Data collected outside these 
ranges are not included in the plot. These fields are 
disabled if you choose Autoscale.

Autoscale Allows you to have the X- and/or Y-axes scaled 
automatically. When scaled automatically, both axes 
begin at zero. The analysis program uses the highest 
values collected during analysis as the ending points.

Tabular report Allows you to generate tabular, as well as graphical, data 
of the included samples. A tabular report contains the 
numeric values contributed by each sample.

Label data Allows you to label the points on the plot to correspond 
with the values in the sample files.

Displays the Regression Report Sample Selection dialog, 
allowing you to choose the sample files you wish to have 
reported.
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• Select Use all files in this Dir. to include all files 
from the selected directory in the Regression report.

• Select the file and click Add to move a file from the 
Files list to the Selected Files list. Alternatively, you 
can simply double-click on the desired file(s). You 
can select multiple files by holding down Ctrl while 
making your selections.

• You may choose up to 200 sample files. 

• Use Delete to delete a selected file from the Selected 
Files list and move it back to the Files: list.

• Use the Status drop-down list and/or Dates to limit 
the files displayed in the Files: list.

Saves the current definition of the report as the default.

Recalculate archived SPC 
results

Select this option to have archived SPC values 
recalculated. This ensures that any changes made to the 
SPC Report Options are included in the new report; 
however, it will lengthen the time required to generate the 
report.

Report Settings Refer to "Selecting the Report Destination" in Chapter 3.

Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a statistic.

 

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. 

Deselect this option to omit the report title.

Range: 40 characters.

Show graphic Refer to "Including a Graphic in the Report Header" in 
Chapter 3.

X-axis Order By Allows you to choose whether statistics are placed in 
order by file name or analysis time.
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Allows you to select the statistics to display in the 
report.

a.  Check the statistics you want to display in the report. 
You may select:

•   Mean

•   Standard Deviation

•  Coefficient of Variation - the Standard Deviation
 divided by the Mean

•  Confidence Interval - the confidence interval of 
the mean value shown on the same line below the 
graph on the report.

b.  If you selected Confidence Interval, enter the percent 
in the Confidence Level field.

c.  If you wish to have the number of samples analyzed 
included in the report, check the Number of Samples 
box.

d.  Click OK to save your selections and close the dialog.

Displays the Control Chart Graph [n] Options dialog, 
allowing you to define the Y-axis of each graph. 
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Statistic
This drop-down list displays the SPC variables selected 
on the SPC Report Options dialog. The variable you 
choose will be plotted against time.

Autoscale
Allows you to have the Y-axis scaled automatically. If you 
wish to specify a range, deselect this option and enter 
ranges in the From and To fields.

Center Line
Displays placement options for the variable’s optional 
value. Choose Entered to specify placement of the line.

Limit Lines
Displays the options available for limiting lines. You can 
have the lines placed at some multiple of the standard 
deviation or at specified positions (Entered).

If you select Entered, enter the High and Low limits.

Tabular report Allows you to generate tabular, as well as graphical, data 
of the included samples. A tabular report contains the 
numeric values contributed by each sample.

Recalculate archived 
SPC results

Select this option to have archived SPC values 
recomputed. This ensures that any changes made to the 
SPC Report Options are included in the new report. It also 
lengthens the time required to generate the report.
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Displays the Control Chart Sample Selection dialog, 
allowing you to choose the sample files on which you 
wish to report. 

• Select Use all files in this Dir. to include all files 
from the selected directory in the Regression report.

• Select the file and click Add to move a file from the 
Files list to the Selected Files list. Alternatively, you 
can simply double-click on the desired file(s). You 
can select multiple files by holding down Ctrl while 
making your selections.

• You may choose up to 200 sample files. 

• Use Delete to delete a selected file from the Selected 
Files list and move it back to the Files: list.

• Use the Status drop-down list and/or Dates to limit 
the files displayed in the Files: list.

Saves the current definition of the report as the default.

Report Settings Refer to "Selecting the Report Destination" in Chapter 3.

Generates the report.
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PSD History

This option enables you to report a sequence of full particle size distribution graphs.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. 

Deselect this option to omit the report title.

Range: 40 characters.

Show graphic Refer to "Including a Graphic in the Report Header" in 
Chapter 3.

X-axis Order By Allows you to choose whether statistics are placed in 
order by file name or analysis time.
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Displays the PSD History Sample Selection dialog, 
allowing you to choose the sample files on which you 
wish to report. 

• Select Use all files in this Dir. to include all files 
from the selected directory in the Regression report.

• Select the file and click Add to move a file from the 
Files list to the Selected Files list. Alternatively, you 
can simply double-click on the desired file(s). You 
can select multiple files by holding down Ctrl while 
making your selections.

• You may choose up to 200 sample files. 

• Use Delete to delete a selected file from the Selected 
Files list and move it back to the Files: list.

• Use the Status drop-down list and/or Dates to limit 
the files displayed in the Files: list.

Saves the current definition of the report as the default.

Report Settings Refer to "Selecting the Report Destination" in Chapter 3.

Generates the report.
7-18                                                    512-42801-01 (Rev L) Apr 2022



Report Headers SediGraph 5120 Operator’s Manual
Report Headers

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics, as shown in the following example.

The report header may contain a graphic (such as company logo) and/or title if specified by the 
user. The header also contains: 

• The measurement principle and calculation method used in compiling the report.

• Sample and instrument statistics such as date and time of analysis, analysis conditions, and 
background data for tabular and graphical reports.

• Notes of any changes to the sample file which occur after analysis (excluded in summary 
reports).

• SPC and PSD report headers also display the range of dates of the selected samples in 
addition to the current date. 
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Reports Displayed on the Screen

The window which displays reports provides many options for customizing and manipulating 
reports including: 

• a tool bar
• pop-up menu options
• zoom feature
• axis cross hairs 

When reports are printed to the screen, they are printed in a window like the one shown on the 
following page. Each requested report is listed in the Reports window above the tool bar; they 
are also indicated by selectable tabs across the top of the report header. To view a specific 
report, select its tab or select the report in the Reports window and click Show.

Tool Bar

Header

Displays
tabular or
graphical
data

List of
requested
reports

Toolbar
options

Shows the selected report in the report window. If the 
report has been hidden, it and its associated tab will 
become visible.

Deletes the selected report. A deletion confirmation 
dialog is displayed since this function cannot be undone. 
The deleted report(s) will have to be regenerated if 
deleted in error.
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Hides (removes) the selected report from the report 
window. The report’s associated tab is also removed.

Allows you to open a previously saved report file.

Displays a print dialog so that you can choose an 
appropriate printer for report output. A list of available 
reports is displayed in the window on the right side of the 
dialog.
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For convenience in selecting reports to print, the push 
buttons described below are provided beneath the report 
window. Or, you can make your selection by clicking on 
the desired reports.  

Selects the report displayed in the report window.

Selects only the shown reports; any unhighlighted reports 
indicate they are hidden. You can still select hidden 
reports from this window to print.

 

Selects all reports, including those that may have been 
hidden.

 

Clears all selections.

Saves all reports of the currently open file in a report 
format using the same name as the sample file, only with 
an .rep extension. If you wish to specify a name and/or 
specific reports to save, use the Save As push button.

Allows you to save all or specified reports from the 
currently open file. The push buttons displayed on this 
dialog perform in the same manner as the print dialog 
(explained above).

Reports can be saved in three different formats:

• Report system (*.rep): Saved in a format which 
allows you to reopen the file using the Open push 
button on the Report window tool bar.

• Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

• Ascii Text (*.txt): Saved in ASCII text, which can be 
imported into programs accepting this type of file.
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Displays the Default Fonts dialog so that you can edit 
report fonts.

The window on the left lists the items for which the font 
can be edited.

Enables you to edit the font of a selected item; a font 
dialog is displayed so that you can specify the desired font 
and attributes.

Saves the changes as the default. If you do not click Save, 
the changes will apply to the current report set only. The 
next reports will revert to the default font.

Loads the default font of a selected item.

Closes the dialog.
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Pop-up Menus

Pop-up menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

For Tabular Reports

Resize column Displays a dialog so that you can specify the width of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column to 
the left or to the right.

Align column Enables you to right-align, left-align, or center the data in 
the selected column.

Hide column Displays a list of all columns, enabling you to select the 
one you wish to hide.

Show column Displays a list of all hidden columns, enabling you to 
select the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font 
attributes for the tabular data in the current report.
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For Graphs

Header font Displays a Font dialog, allowing you to change font 
attributes for column headers in the current report.

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns are 
tab-delimited, allowing easy alignment.

Autoscale Autoscales all axes of the graph. This function is useful 
for returning to a full view after having zoomed in.

Show curve Allows you to show curves that have been hidden. This 
option is disabled (greyed) if no curves have been hidden.

Hide curve Allows you to hide (remove) unwanted curves.
512-42801-01 (Rev L) Apr 2022                                                    7-25 



SediGraph 5120 Operator’s Manual Reports Displayed on the Screen
Edit curve Displays a submenu that enables you to select a curve to 
edit.

When you make a selection, the Curve Properties dialog 
is displayed, allowing you to edit curve properties.

Title
Displays the title of the curve you are editing.

Style
Drop-down list containing styles in which collected data 
can be displayed.

Curve group box
Contains options for curves and points. You can edit the 
curve interpolation, the style of curve, and/or points, as 
well as the pen style and color. The options in this group 
box are disabled if Histogram is chosen in the Style drop-
down list.

Histogram group box 
Allows you to specify the type of fill as well as the color 
if Histogram is chosen as the style for collected data.
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Edit axis Displays a submenu that enables you to select an axis to 
edit.

When you make a selection, the Axis Properties dialog is 
displayed, allowing you to edit axis properties.

Title Group Box
Displays the title of the axis you are editing and enables 
you to change the title font if desired.

Scale Group Box
Enables you to:
• select Linear or Logarithmic
• change the Autoscale minimum and maximum values
• choose to invert the scale if desired
• change the scale font

Gridlines
A drop-down list that enables you to select None, Solid or 
Dotted gridlines.

Edit legend Displays the Legend Properties dialog, allowing you to 
edit the placement of the legend.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
detail of the distribution. To use this feature, simply hold down the left mouse button and drag 
the mouse cursor (drawing a box) across the area you wish to view; then release the button. 
The enlarged area immediately fills the graph area. You can return to the normal view by right-
clicking on the graph and selecting Autoscale.

Edit Title Displays the Title Properties dialog, allowing you to edit 
the current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing 
you to paste it into other applications accepting Windows 
metafiles. 

Copy as text Copies the data used to generate the graph as a series of 
tab-delimited columns of text.
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Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, 
simply left-click in the desired area of the graph.

You can remove cross-hair lines and return to the normal view by right-clicking on the graph 
and selecting Autoscale or clicking out of the graph area.

Report Examples

This section contains examples of the types of reports available with the SediGraph 5120 
analysis program.

Y-axis position
Point of Coordination

X-axis position
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Combined Report
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Report by Size Class
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Mass Frequency vs. Diameter Report
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Rosin Rammler Graph
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Summary Report
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Cumulative Surface Area Coarser vs. Diameter
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Surface Area Population vs. Diameter
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Cumulative Particle Number Coarser vs. Diameter
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Particle Number Population vs. Diameter
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Log Probability
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Control Chart Report
7-40                                                    512-42801-01 (Rev L) Apr 2022



 

8 OPTIONS MENU

Overview 8-3

Description 8-3

Service Test Mode 8-5

Option Presentation 8-5

Data Presentation 8-9

Sieves 8-10

Sample Defaults 8-11

Reynolds Number 8-18

Autorinse 8-18

System Configuration 8-19

Parameter Files Directory 8-20
512-42801-01 (Rev L) Apr 2022                                                    8-1 



SediGraph 5120 Operator’s Manual
8-2                                                    512-42801-01 (Rev L) Apr 2022



Overview SediGraph 5120 Operator’s Manual
Overview

The Options menu contains options which allow you to configure the system to your 
laboratory’s requirements. With the options on this menu, you can:

• Switch between basic and advanced mode
• Edit program defaults
• Specify data presentation modes
• Specify printer/plotter options
• Specify a directory for predefined parameter files

Description

Listed below are brief descriptions of the Options menu selections. Detailed descriptions are 
found later in this chapter.

Service Test Mode Enables Service Test Mode, which is used for 
troubleshooting and maintaining the analyzer.

Option Presentation Allows you to display the sample file dialog in the Basic, 
Advanced, or Restricted format.

Data Presentation Allows you to choose the way in which data are presented 
on the screen and in printed reports.

Sieves Allows you to specify the sieve sizes you wish to use 
when sieve data are generated.
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Sample defaults Allows you to specify the parameters you wish to use 
when creating a sample file.

Reynolds number
 

Allows you to specify the Reynolds number you wish to 
use in computing the maximum measurable diameter.

Autorinse Allows you to specify autorinse options.

System configuration Allows you to specify the printer and/or plotter you wish 
to have reports sent to.

Parameter files directory Allows you to specify a location for predefined parameter 
files when using the Basic mode.
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Service Test Mode

Certain service tests are included in the operating program, but can be performed only with the 
assistance of a trained Micromeritics service representative. These tests are designed to 
provide your service representative with instrument readouts, as well as to assist him in 
troubleshooting potential problems and, perhaps, eliminating unnecessary repair services. This 
service strategy allows you to conduct expert tests in less time than it would take to be trained 
in servicing the instrument properly.

When you select Service Test Mode from the Options menu, a dialog box is displayed 
prompting you to enter a password. This password is coded to change on a regular basis and, 
therefore, is known only by your service representative. You will not be able to enter Service 
Test Mode and perform these tests without his guidance.

Option Presentation

The sample editing dialogs for the SediGraph 5120 analysis program may be presented in one 
of three formats: Restricted, Basic, and Advanced. Each format displays sample information 
and menu options differently.

• Basic: displays all parts of the sample file as a single dialog. This format is used to create 
sample files quickly by choosing from predefined parameter files. You can also switch to 
the Advanced format for editing parameters if desired.

• Restricted: displays in the same manner as the Basic format. Certain menu options, how-
ever, become disabled and you cannot switch to the Advanced mode. You must also enter 
a password to enter and exit this mode.

• Advanced: displays all parts of the sample information file in a tabbed dialog as in an 
index card file. You just click on the tab of the parameter you wish to edit. This format is 
used for customizing sample files.
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Basic

The Basic format presents the sample information file and its parameter files as a single 
dialog. You also have access to all menu options. For example, if you have Basic chosen as the 
presentation and open or create a sample information file, the dialog box is displayed in this 
manner.

The Basic format is used to create quickly sample information files using previously defined 
analysis conditions and report options. You also can easily switch to Advanced format, if 
needed, by clicking Advanced.
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Restricted

The Restricted format is identical to the Basic format, except that certain menu options are 
disabled. You also cannot switch to the Advanced format. This format is password-protected 
and is typically used in laboratories where analysis conditions must remain constant, for 
example, in the pharmaceutical industry.

When you select Restricted, a dialog requesting a password is displayed:

Any password (up to 31 characters) can be used to enable the restricted format. The same 
password, however, must be used to exit the Restricted format. For example, if you enter 
“password” to enable the Restricted format, then you must enter “password” to exit the 
Restricted format and before you can enable the Basic or Advanced format. 

If you forget the password, open the system INI file and navigate to the Private section. The 
current password will be shown immediately following “OptionPresentationPassword.” Make 
a note of the password, exit the INI file, and enter the password where requested. Do not 
attempt to delete the password in the INI file.
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Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Each 
tab opens its associated dialog. For example, if you have Advanced chosen as the presentation 
and you open or create a sample information file, the following dialog box is displayed. 

The Advanced format can be used to edit sample parameters and customize files. This format 
typically is used by the more experienced operators.
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Data Presentation

The options on the Data presentation drop-down menu allow you to specify how you wish 
tabular and graphical data to display on the screen and in printed reports. 

Units Allows you to choose how data are to display on the 
screen and in printed reports. When you select this option, 
the Units Selection dialog is displayed.

Invert Size Axis Enables you to invert the size axis if desired.

Solid graph gridlines
Dotted graph gridlines

Allows you to choose graph options.

Show graph gridlines Allows you to specify whether or not you wish to have 
grid lines display on graphs and, if so, what type.

Choices: None, Horizontal, Vertical, Both
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Sieves

Sieves allows you to specify the default sieve sizes you wish to use when sieve data are 
presented; the Sieve Table dialog box is displayed.

To select sizes, move to the desired size, then double-click the left mouse button or press 
Spacebar. A sieve size is selected when it is preceded by a check mark. 
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Sample Defaults

This option allows you to specify default parameters for sample information files. This option 
is presented in two formats: Basic and Advanced.

Basic

When you select Sample defaults while in the Basic format, the Default Basic Sample 
Information dialog is displayed.

Sequence Allows you to specify a default sequence for the sample 
file name. The number you specify is incrementally 
sequenced each time you create a sample file. It is the 
number that appears in the File name field when you 
select File > Open > Sample information.

• Use numbers, letters, or other printable characters, 
such as dashes. At least three numbers must be 
included.

• Use up to eight characters.
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Sample
 

Allows you to enter an additional identification that 
provides more information than the sample file name 
alone.

In the field on the left, you can edit the prompt for 
Sample. For example, you may prefer to use Test or 
Material. The maximum number of characters is 20.

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, 
such as dashes.

• Maximum number of characters is 42, plus the $ sym-
bol.

• Include the automatically generated file name as part 
of the identification by using the $ symbol where you 
want the sequence number to appear.

For example, if the sequence number is 000-001, enter the 
identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

The identification for the second would be:

           Lab #25 - 000-002, and so on.

Analysis Conditions Drop-down list containing the analysis conditions files 
included with the software, as well as any you may have 
created on your own. Choose the file you wish to have as 
the default.

Certain values in the file are displayed below the analysis 
conditions file name.

You may change the density and number of tests to be 
performed if desired.

You can also select or deselect to have a rinse performed 
after each analysis.
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Report Options Drop-down list containing the report options files 
included with the software, as well as any you may have 
created on your own. Choose the file you wish to have as 
the default.

Report Options List Box Contains the reports available for the report options file 
you select as a default. Select the reports you wish to have 
included in generated reports as the defaults.

Enables you to replace the values in the default sample 
file with values in another sample information file. When 
you select Replace, the Open Sample Information File 
dialog is displayed.

Select a file, then click OK.

The values in the selected file are displayed in the Default 
Basic Sample Information dialog. You can change them if 
desired.
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Advanced

When you select Sample defaults while in the Advanced format, the 5120 Sample Defaults 
dialog box is displayed.

Sequence Allows you to specify a default sequence for the sample 
file name. The number you specify is incrementally 
sequenced each time you create a sample file. It is the 
number that appears in the File name field when you 
select File > Open > Sample information.

• Use numbers, letters, or other printable characters, 
such as dashes. At least three numbers must be 
included.

• Use up to eight characters.
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Sample
 

Allows you to enter an additional identification that 
provides more information than the sample file name 
alone.

In the field on the left, you can edit the prompt for 
Sample. For example, you may prefer to use Test or 
Material. The maximum number of characters is 20.

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, 
such as dashes.

• Maximum number of characters is 42, plus the $ sym-
bol.

• Include the automatically generated file name as part 
of the identification by using the $ symbol where you 
want the sequence number to appear.

For example, if the sequence number is 000-001, enter the 
identification as follows:

Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

Lab #25 - 000-001

The identification for the second would be:

           Lab #25 - 000-002, and so on.

Operator
Submitter

These fields contain the name (or other identification) of 
the operator and submitter. 

In the fields on the left, you can change the names of 
these prompts if you wish.

In the fields on the right, enter the operator and submitter 
names you wish to use as the defaults.

• Include the automatically generated file name as part 
of the identification by using the symbol $ where you 
want the sequence number to appear. Refer to the 
example in the previous section.
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• Maximum number of characters for the prompt is 20.

• Maximum number of characters for the identification 
is 42, including the $ symbol.

• Omit this item entirely from the sample information 
file by selecting Omit.

User Parameters Group 
Box

The fields in this group box are used specifically for SPC 
(Statistical Process Control) reporting. They are used to 
specify characteristics of either the sample or its 
manufacturing process.

For example, you may wish to report the relationship of 
the motor speed of a grinder used in the manufacturing 
process to the median diameter of the sample. In the 
parameter field on the left, enter Motor speed. In the field 
on the right, enter a default value (this value may be 
edited if desired in the sample information file). Once 
specified, these parameters display in the SPC Sample 
Options dialog (accessed through the SPC Calculations 
dialog box).

Omit this item entirely from the sample information file 
by selecting Omit.

Comments Enables you to enter comments to be stored in the sample 
information file if desired.

Enables you to replace the values in the default sample 
file with values in another sample information file. When 
you select Replace All, the Open Sample Information 
File dialog is displayed.
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Select the file you wish to copy from the Files: list; then 
click OK. 

The values in the selected file are displayed in the Sample 
Defaults dialog. You can change them if desired.
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Reynolds Number

This option allows you to specify the Reynolds number which is to be used in estimating the 
maximum measurable diameter displayed on the Material Properties dialog box. When you 
select this option, the Default Reynolds Number dialog is displayed.

Autorinse

This option allows you to specify autorinse options. The system default for Autorinse is 3 
cycles of 3 rinses per cycle; a total of 9 rinses. This means the SediGraph will rinse a 
maximum of 9 times in an attempt to reestablish baseline conditions before displaying an error 
message. When you select this option, the Autorinse Options dialog is displayed.

Reynolds number Enter the number you wish to use.

Number of rinses before 
check

Enter the number of rinses per cycle you wish performed 
after each analysis before baseline conditions are 
checked.

Maximum number of 
checks

Enter the maximum number of baseline checks you wish 
performed before you are notified that baseline conditions 
have not been met.
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System Configuration

This option allows you to specify printer and plotter destinations for report output; the System 
Configuration dialog box is displayed.

Printer name
Plotter name
 

The printer and plotter names are shown exactly as they 
appear in the Operating System Print Manager.

Select Default if you wish to use the default printer and 
plotter as designated in the Print Manager. 

If you wish to change the default printer, deselect 
Default. Then choose another printer (or plotter) from the 
drop-down list of installed printers (plotters).
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Parameter Files Directory

This option allows you to select the location for the pre-defined Analysis conditions and 
Report options files displayed in the drop-down lists on the Basic Sample Information dialog 
box. The current directory specified for parameter files is displayed above the directory 
window.

The default directory is Params and includes several parameter files supplied with the analysis 
program. If you specify a different directory, these files will not be included n the drop-down 
lists unless you copy (or move) them to the new directory.

If you wish to continue to use the Params directory for parameter files, be sure to save any files 
you create to this directory; otherwise they will not be included in the lists.
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Overview

The SediGraph 5120 Particle Size Analysis System has been designed to provide efficient and 
continuous service. However, in order to get the best results over the longest period of time, 
certain maintenance and service procedures must be followed. Additionally, when common 
operational problems occur, the appropriate corrective action must be taken. This chapter 
contains information regarding common operational problems and corrective action, along 
with maintenance and service procedures.

Troubleshooting

Most operational problems are caused by deteriorated or blocked tubing, air leaks, or an 
unlevel analyzer. Always check these things first when expected analysis results are not 
obtained. Some common operational problems that are not indicated on the computer screen 
and their respective solutions are provided in the following table. Operational problems that 
are indicated on the computer screen and their respective solutions are provided in Appendix 
A, Error Messages. 

What Happened Why What To Do

—————— SEDIGRAPH 5120 ——————

Cell cannot be filled 
or drained.

Blocked or damaged tubing. Locate and replace blocked or 
damaged tubing. Refer to 
“Replacing Flexible Tubing” on 
page 9-13.

Blocked cell input or output 
port.

Clean analysis cell. Refer to 
“Cleaning the Analysis Cell” on 
page 9-10.

Valve or pump not working 
properly.

From Manual Control screen, 
check pump and valve operation. 
If either is not working properly, 
contact authorized service 
personnel.

Tubing improperly installed. Install the tubing as described 
under “Replacing Flexible 
Tubing” on page 9-13. 

Cell cannot be 
raised or lowered

Elevator which moves cell 
stuck in up position, down 
position, or somewhere in 
between.

Check flexible tubing for 
possible obstruction to elevator 
movement. If necessary, 
reposition tubing. Also check 
for any other obstruction to 
elevator movement.
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What Happened Why What To Do

Mixing chamber 
cannot be filled or 
drained.

Blocked or damaged tubing. Locate and replace blocked or 
damaged tubing. Refer to 
“Replacing Flexible Tubing” on 
page 9-13.

Blocked mixing chamber 
input or output port.

Clean mixing chamber. Refer to 
“Cleaning the Mixing Chamber 
and Bezel” on page 9-8.

Valve or pump not working 
properly.

From Manual Control screen, 
check pump and valve operation. 
If either is not working properly, 
contact authorized service 
personnel.

Tubing improperly installed. Install the tubing as described 
under “Replacing Flexible 
Tubing” on page 9-13.

Mixing chamber 
suspension is 
turning brown

Teflon® coating on stirring 
bar is worn.

Replace stirring bar. Refer to 
Chapter 10, Ordering 
Information for the part number.

X-RAY ON 
indicator on, but 0 
kilocounts shown 
on computer 
display.

Analysis compartment door 
not completely closed.

Close analysis compartment 
door.

Cell is in a position which 
blocks beam.

Move cell to proper operating 
position. Enable Manual Control, 
access the pop-up menu on the 
cell, and select Move Cell 
Position.

Cell is clogged. Remove and clean cell. Refer to 
“Cleaning the Analysis Cell” on 
page 9-10.

Slits in collimator blocked. Clean the collimator. Refer to 
“Cleaning the Collimating Slits” 
on page 9-21.

X-ray source or detector has 
failed.

Contact authorized service 
personnel.
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What Happened Why What To Do

X-RAY STANDBY 
indicator was 
turned on, but when 
keyswitch is placed 
in X-RAY ON 
position, X-RAY 
ON indicator does 
not turn on.

Keyswitch is between 
positions.

Move keyswitch to X-RAY 
STANDBY position and then 
back to X-RAY ON position 
while observing indicator.

X-RAY ON indicator lamp is 
burned out.

Replace lamp. Refer to 
“Replacing the X-Ray Indicator 
Lamps” on page 9-22.

X-ray filament supply not 
available or X-ray unit 
damaged.

Contact authorized service 
personnel in accordance with 
service contract.

Rear panel is off, the top 
cover is off, or the fluid 
module is not fully installed.

Replace all panels.

Bubble elimination 
problem

First refer to “Determining the Cause of Bubbles” on page 9-25 
and perform the outlined procedure. Then return to this table for 
corrective action.

Windows are dirty or 
misaligned.

Clean or replace the windows. 
Refer to “Cleaning the Analysis 
Cell” on page 9-10.

Inlet port on the cell assembly 
is loose.

Replace the cell assembly Refer 
to “Replacing the Analysis Cell 
Assembly” on page 9-24.

A valve has failed. Contact authorized service 
personnel.
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What Happened Why What To Do

——————MASTERTECH ——————

Power failure. Power cable not connected or 
switch not in ON position.

Make sure power cable is 
plugged into the power source 
and the power ON/OFF switch 
is in the ON position.

Input power fuse blown. Replace the fuse. Refer to 
“Replacing the MasterTech 
Input Power Fuse” on page 9-
27.

Stirrer will not 
work.

Stirrer is improperly 
connected.

Check the stirrer’s electrical 
connection.

Turntable will not 
move.

Arm is in the LOAD position. Press the AUTO/LOAD switch 
on the front panel to lower the 
arm.

MasterTech pump 
will not run.

Pump switch on the front 
panel may be in the OFF 
position.

Press the pump AUTO/ OFF 
switch on the front panel.

Ultrasonic probe 
will not work.

Probe improperly connected 
to the MasterTech.

Check the MasterTech 
connector cable.

Ultrasonic agitation 
diminished.

The ultrasonic probe tip may 
need replacing.

Refer to “Replacing the 
Ultrasonic Probe Tip” on 
page 9-26.

MasterTech will not 
initiate commands 
from the computer.

The cable may be connected 
improperly from the 
MasterTech to the computer.

Check the cable connections. 

Pump leaks or is not 
operating 
efficiently.

Tubing is leaking or clogged. Refer to “Replacing Flexible 
Tubing” on page 9-13.
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Preventive Maintenance

The following procedures should be performed every 12 months by a Micromeritics service 
technician. Do not attempt to perform these procedures yourself.

• Clean the high voltage area
• Calibrate the X-ray control system
• Calibrate the fluid control system
• Calibrate the temperature control system

Schedule

The following table lists the preventive maintenance procedures you should perform to keep 
your analyzer operating at peak performance. (These procedures are also performed by your 
service technician at the same time as the ones listed above.) Instructions for each procedure 
follow the table.

Maintenance Required Frequency Refer to Page

Perform a reference material run Every week 9-8

Clean the analyzer Every 30 days* 9-8

Clean the mixing chamber and bezel As needed 9-8

Clean the analysis cell Every 30 days* 9-10

Replace the mixing pump and cell pump tubing Every 30 days* 9-13

Replace the analysis cell tubing As needed 9-16

Clean the air filter Every 30 days* 9-17

Check the operation of the mixing pump Every 30 days* 9-18

Check the operation of the cell pump Every 30 days* 9-19

Check the level of the analyzer Every 30 days* 9-20

Clean the collimating slits As needed 9-21

*Or every 160 analyses, whichever comes first
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Performing a Reference Material Analysis

It’s good practice to perform a reference material analysis every week to ensure that the 
analyzer is operating within specifications. Reference material kits, including instructions for 
performing the reference material analysis, are available from Micromeritics (refer to Chapter 
10, Ordering Information).

Cleaning the Analyzer

A clean cloth, dampened with isopropyl alcohol (IPA), a mild detergent or a 3% Hydrogen 
Peroxide solution may be used to clean the outside casing of the analyzer. It is not necessary to 
remove any control knobs or screws while cleaning. If you have a MasterTech installed on 
your SediGraph 5120, it may be cleaned in the same manner.

Cleaning the Mixing Chamber and Bezel

The mixing chamber bezel should be cleaned periodically to prevent contaminants from 
entering the mixing chamber. To clean the bezel:

• Remove the bezel and clean using a mild detergent. Rinse, then dry thoroughly before 
replacing it on the mixing chamber.

The mixing chamber should be removed and cleaned periodically to remove any residue.

1. Drain the mixing chamber.

a.  Select Unit [n] > Drain and Load.

b.  Select Leave mixing chamber empty; then select Continue.

c.  When prompted to load the sample, select Cancel.

 Isopropyl alcohol (IPA) should not be used to clean the sliding door to the analysis 
compartment.

When cleaning the mixing chamber, avoid getting the electrical connections wet. 
Do not immerse the chamber in liquid. Doing so could damage the system.
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2. Disconnect the flexible tubing from the mixing chamber, exercising caution to prevent 
damage to the tubing. Disconnect the electrical cable.

3. Clean the chamber using IPA or a mild detergent. Rinse thoroughly. All ports should be 
cleaned using an air blower.

4. Reconnect the tubing to the mixing chamber (refer to Reconnecting the Mixing Chamber 
Tubing below).  

Reconnecting the Mixing Chamber Tubing

1. Attach the tubing to the mixing chamber as shown below. 

2. Make sure the tubing is securely fastened at each port.

3. Reconnect the electrical cable.

      Electrical Cable

Flexible Tubing

      

Flexible 
Tubing

I J D

G
H

I

J

H

D

G
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Cleaning the Analysis Cell

The analysis cell should be removed periodically and cleaned to remove any residue.

1. Select Unit [n] menu > Drain and Load.

2. Select Leave mixing chamber empty, then Continue.

3. When prompted to load the sample, select Cancel.

4. Place the PUMP CONTROL switch on the analyzer front panel in the OFF position.

5. Open the transparent sliding door to the analysis compartment. Loosen the cell mounting 
screw and remove the cell from the retaining bracket as shown below. 

6. Carefully remove the flexible tubing from the rigid tubing connector which is mounted 
along the right side of the analysis compartment.

7. Carefully remove the flexible tubing from the two ports on the cell.
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8. Disassemble the cell by removing the ten screws in the cell window retaining plates.

9. Use either IPA or a mild detergent to clean the cell windows. Use an air blower to remove 
any debris from the cell body, window retaining plates, and ports.

10. Assemble the cell by placing a cell window and a cell window retaining plate on each side 
of the cell body. The cell window retaining plate must be positioned so that the sloped part 
matches that of the cell body and other plate. 

11. Insert the ten screws removed in step 8 into the window retaining plates, but do not 
tighten.

Do not use cloth made of a coarse material or abrasive cleansers when cleaning the 
cell windows. Particles may lodge in scratches, which could alter X-ray pulse rates 
and cause invalid analysis results.

Make sure the sloped
portions of the cell body
and retaining plates are
aligned.

When assembling the cell, be sure to alternate the tightening of screws. Failure to 
do so could result in air entering the cell, causing bubble elimination problems.
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12. Using a screwdriver, tighten the screws around the cell by tightening one screw and then 
tightening the screw diagonally opposite that screw. (Refer to the following illustration for 
the tightening sequence.) This sequence helps to ensure uniform closure around the cell.

13. Connect the flexible tubing to the ports on the analysis cell and to the rigid tubing 
connector. The tubing for the front port of the cell connects to the front rigid tubing 
connector and the tubing for the rear port of the cell connects to the rear rigid tubing 
connector.

14. Insert the cell in the retaining bracket and tighten the cell mounting screw.

15. Place the PUMP CONTROL switch in the ON position.

16. Select Unit [n] > Rinse > SediGraph; the SediGraph Rinse dialog box is displayed.

17. Select Autorinse, then Continue to rinse the analysis cell.
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Replacing Flexible Tubing

The SediGraph includes a complete plumbing system for circulation of sedimentation liquid 
and particle suspension between the cell, the mixing chamber, an external rinse container, and 
an external waste container. In order for the system to operate properly, you must replace 
damaged or deteriorated tubing. You can replace tubing from the mixing pump, the cell pump, 
and the analysis cell independently.

When replacing tubing, always drain the system first as described below.

Draining the System

1. Ensure that the outlet tube is in the waste reservoir and the rinse tube is in the rinse liquid 
reservoir.

2. Select Unit [n] > Drain and load; the Drain and Load dialog is displayed.

3. Select Leave mixing chamber empty, then click Continue. A progress message is 
displayed, then the dialog shown below displays.

4. Click Cancel.

The tube installation tool included in the instrument accessories may be used to 
help install the tubing.
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Replacing the Mixing Pump Tubing

1. Place the SediGraph on the edge of a table or flat surface. 

2. Remove the pump chassis cover. 

3. Drain the system. Refer to “Draining the System” on page 9-13.

4. Place the PUMP CONTROL switch on the analyzer front panel in the OFF position.

5. Rotate the mixing pump lever (the mixing pump is the pump on the right) to the left to 
place the mixing pump housing in the open position.

6. Remove the mixing pump flexible tubing from the rigid tubing connectors on both sides of 
the pump; discard the used tubing.

7. Using the tube installation tool supplied in the accessories kit, attach one end of the new 
flexible tubing (labeled F) to the rigid tubing connector on the right side

8. Thread the tubing through the pump as shown below.

9. Attach the other end of the tubing to the rigid connector on the left side.

10. Rotate the mixing pump lever to the right to place the mixing pump housing in the closed 
position.

11. Replace the pump chassis cover.

12. Place the PUMP CONTROL switch on the analyzer front panel in the ON position.

Mixing Pump Lever 
(Open position)

Mixing Pump 
Tubing (F)
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Replacing the Cell Pump Tubing

1. Place the SediGraph on the edge of a table or flat surface. 

2. Remove the pump chassis cover. 

3. Drain the system. Refer to “Draining the System” on page 9-13.

4. Place the PUMP CONTROL switch on the analyzer front panel in the OFF position

5. Rotate the cell pump lever  (the cell pump is the pump on the left) to the left to place the 
cell pump housing in the open position.

6. Remove the cell pump flexible tubing from both connectors; discard the used tubing. 

7. Using the tube installation tool supplied in the accessories kit, attach one end of the new 
flexible tubing (labeled E) to the rigid tubing connector on the left side of the pump. .

8. Thread the tubing through the pump as shown below.

9. Attach the other end of the tubing to the connector on the right side.

10. Rotate the cell pump lever to the right to place the cell pump housing in the closed 
position.

11. Replace the pump chassis cover.

12. Place the PUMP CONTROL switch on the analyzer front panel in the ON position.

Cell Pump Lever 
(Open position)

Cell Pump 
Tubing (E)

    Tubing (E)

Cell Pump
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Replacing the Analysis Cell Tubing

1. Drain the system. Refer to “Draining the System” on page 9-13.

2. Place the PUMP CONTROL switch on the analyzer front panel in the OFF position

3. Open the transparent sliding door to the analysis compartment. 

4. Remove the flexible tubing from the rigid tubing connector in the analysis compartment.

5. Loosen the cell mounting screw and remove the cell from the retaining bracket as shown 
below. 

6. Remove the flexible tubing from the two ports on the cell.

Front Connector 
(for front cell port tubing)

Analysis Cell 
Tubing (K)

Rear Connector 
(for rear cell port tubing)

Analysis
Cell Tubing
(K)
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7. Connect the new flexible tubing (labeled K) to the ports on the new analysis cell and to the 
rigid tubing connector. The tubing for the front port of the cell connects to the front rigid 
tubing connector and the tubing for the rear port of the cell connects to the rear rigid 
tubing connector.

8. Insert the cell in the retaining bracket and tighten the cell mounting screw.

9. Close the analysis compartment door.

10. Place the PUMP CONTROL switch in the ON position.

Cleaning the Air Filter

The air filter on the SediGraph should be cleaned every 30 days (more often in environments 
with increased levels of dust) and replaced once a year. Refer to Chapter 10, Ordering 
Information for the part number of the air filter.

1. Slide out the drip tray on the front of the analyzer.

2. Remove the air filter from drip tray by squeezing the filter while pulling it away from the 
drip tray.

3. Rinse the filter thoroughly and shake out the excess water. Place it aside and allow it to 
dry.

4. Install a new filter or after the filter has dried, replace it.

5. Check to see that the analyzer is level. Refer to “Checking the Level of the Analyzer” on 
page 9-20.

   

Drip Tray

Air Filter
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Checking the Operation of the Mixing Pump

The mixing pump should be checked every 30 days (or every 160 runs, whichever comes first) 
to see if it is operating correctly. To check the operation of the mixing pump:

1. If the instrument schematic is not displayed, select Show Instrument Schematic.

2. Select Unit [n] > Enable manual control.

3. Right-click on the Mixing Pump symbol, then select Turn on from the pop-up menu.

4.  If the pump fails to start, refer to the table on “Resetting the Mixing Pump and Cell 
Pump” on page 9-26 for corrective action.

5. Right-click on the Mixing Pump symbol, then select Turn off from the pop-up. If the 
pump fails to stop, the fluid control board may need replacing; contact your service 
representative.

Mixing
Pump
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Checking the Operation of the Cell Pump

The cell pump should be checked every 30 days (or every 160 runs, whichever comes first) to 
see if it is operating correctly. To check the operation of the cell pump:

1. If the instrument schematic is not displayed, select Show Instrument Schematic.

2. Select Unit [n] > Enable manual control.

3. Right-click on the Cell Pump symbol, then select Turn on from the pop-up.

4. Perform the following steps. If any of these steps fail, refer to the table on “Resetting the 
Mixing Pump and Cell Pump” on page 9-26 for corrective action.

a.  Right-click on the Cell Pump symbol and select Increase speed from the pop-up menu. 

b.  Right-click on the Cell Pump symbol, then select Decrease speed from the pop-up 
menu. 

c.  Right-click on the Cell Pump symbol, then Flow up in cell from the pop-up menu.

d.  Right-click on the Cell Pump symbol, then select Flow down in cell from the pop-up 
menu.

e.  Right-click on the Cell Pump symbol and select Increase speed from the pop-up menu. 

f.  Right-click on the Cell Pump symbol, then select Decrease speed from the pop-up 
menu

5. Right-click on the Cell Pump symbol, then select Turn off from the pop-up menu. If the 
pump fails to stop, the fluid control board may need replacing; contact your service 
representative.

Arrows indicate           Cell pump
flow direction              speed    
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Checking the Level of the Analyzer

An unlevel analyzer may cause inaccurate analyses. Check every 30 days to see if the analyzer 
is level. 

1. Open the analysis compartment door and locate the level indicator.

2. Look straight down at the indicator. The analyzer is level when the bubble is centered 
inside the black circle on the level indicator.

3. If the analyzer is not level, lift the corner of the SediGraph, then turn the appropriate foot 
counterclockwise to raise the unit or clockwise to lower the unit.

4. Set the analyzer back down and observe the indicator. The bubble should be centered 
inside the black circle on the level indicator.

Level Indicator
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Cleaning the Collimating Slits

The collimating slits may become blocked by dust or debris which accumulates in the analysis 
compartment over a period of time, causing inaccurate results.

To clean the collimating slits:

1. Place the analyzer ON/OFF switch in the OFF position.

2. Remove the retaining screws from the top of the analyzer; then remove the top panel.

3. Remove the analysis cell. Refer to Cleaning the Analysis Cell in this chapter for removal 
instructions.

4. Remove the two foam plugs in the top of the analysis module.

5. Use a hex driver with an extension to remove the collimator retaining screws.

6. Reach through the door of the analysis compartment to lift the top collimator out of the 
analysis module.

7. Use a lint-free cloth to clean the shiny area near the center of the collimator you have 
removed and the corresponding area of the collimator remaining in the analysis module.

Collimator Retaining
Screws

Foam Plugs

Do not use cloth made of a coarse material or abrasive cleansers when cleaning the 
collimating slits.
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8.  Replace the top collimator and the retaining screws.

9. Tighten the retaining screws for the top collimator.

10. Replace the two foam plugs in the top of the analysis module.

11. Replace the analysis cell and the top panel.

12. Place the analyzer ON/OFF switch in the ON position.

Routine Maintenance

Replacing the X-Ray Indicator Lamps

The X-RAY STANDBY indicator and the X-RAY ON indicator on the front panel of the 
SediGraph contain an internal lamp. If either of these lamps burn out, perform the following 
steps to replace it.

1. Remove the cover lens from the SediGraph by prying with a flat object as shown below.

Tighten the collimator retaining screws only enough to securely hold the collimator 
in place. Over-tightening the screws can close the collimating slits, reducing the 
intensity of (or completely blocking) the X-rays.

 If the X-RAY ON indicator lamp is burned out or installed incorrectly, the instrument 
will be inoperative.

Disconnect the SediGraph power cord from the AC power source before attempting 
to replace the lamp. Failure to do so could result in electrical shock or damage to 
the instrument.
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2. Using a flat object, pull the lever which raises the lamp socket out of the lamp 
compartment as shown below. This makes the lamp accessible.

3. Remove the lamp by pulling it away from the socket.

4. Push lamp socket lever toward the SediGraph and insert replacement lamp into socket.

5. Replace the indicator cover lens.

6. Connect the SediGraph power cord to an AC power source. Place the ON/OFF switch in 
the ON position and place the keyswitch in the appropriate position. Verify that the lamp is 
working.
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Replacing the Cell Windows

X-ray photons from the X-ray source pass through the cell windows to the X-ray detector on 
the other side of the cell. If cell windows become scratched or damaged, settling particles may 
become entrapped. This could alter X-ray pulses, resulting in invalid analyses. The analysis 
cell windows should be replaced when necessary. Refer to “Cleaning the Analysis Cell” on 
page 9-10.

Replacing the Analysis Cell Assembly

If the analysis cell assembly becomes damaged, it may be necessary to replace it. To replace 
the analysis cell assembly:

1. Select Unit [n] menu > Drain and Load.

2. Select Leave mixing chamber empty; then Continue.

3. When prompted to load the sample, select Cancel.

4. Place the PUMP CONTROL switch on the analyzer front panel in the OFF position.

5. Open the transparent sliding door to the analysis compartment. 

6. Loosen the cell mounting screw and remove the cell from the retaining bracket as shown 
below. 
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7. Carefully remove the flexible tubing from the two ports on the cell.

8. Connect the flexible tubing to the ports on the new analysis cell 

9. Insert the cell in the retaining bracket and tighten the cell mounting screw.

10. Place the PUMP CONTROL switch in the ON position.

Determining the Cause of Bubbles

If bubble problems continue to exist, perform the following steps to determine their source.

1. Install a clean, dry cell assembly in the cell holder (refer to “Replacing the Analysis Cell 
Assembly” on page 9-24).

2. Select Unit [n] > Baseline and perform the steps for collecting baseline data. (Refer to 
"Performing a Baseline Measurement" in Chapter 3 if you need assistance.)

If the analyzer is successful in obtaining a baseline, the cell proceeds to a parked position, 
indicating that bubbles are caused by: improper tubing routing, a failed valve, window 
misalignment, or a loose inlet/outlet port on the cell assembly. Refer to "Bubble 
elimination problem" in the table on page 9-5.  

If the analyzer is unable to obtain a baseline, an error message appears in the lower status 
window. This indicates X-ray detection and/or generation problems may be present. 
Contact your Micromeritics service representative for corrective action. 

If you do not have a spare cell assembly, drain your system, remove and dry the cell 
assembly, then reinstall it for this procedure.
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Resetting the Mixing Pump and Cell Pump

If an electrical overload occurs with the mixing pump or the cell pump, reset the pumps as 
follows:

1. Place the PUMP CONTROL switch on the front panel in the OFF position.

2. Allow the internal varistor to cool down (approximately two to three minutes). 

3. Check the tubing to verify that it is routed properly.

4. Place the PUMP CONTROL switch in the AUTO position.

5. Verify pump operation (refer to “Checking the Operation of the Mixing Pump” on page 9-
18 and “Checking the Operation of the Cell Pump” on page 9-19).

Contact your Micromeritics service representative if the problem continues.

Replacing the Ultrasonic Probe Tip

After extended periods of use, the tip of the ultrasonic probe on the MasterTech may become 
pitted, causing diminished agitation. If this occurs, replace the tip as described below. 

1. Remove the damaged tip from the probe using two 9/16 in. wrenches.

2. Attach the new probe tip to the probe body. Use the wrenches to tighten securely.

Refer to Chapter 10, Ordering Information, to determine the correct part to be used 
with your probe assembly.

Never hold the probe by the tip; doing so may cause damage to the probe.
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Replacing the MasterTech Input Power Fuse

1. Make sure the power cord is disconnected from the MasterTech.

2. Using a pointed object, remove the fuse block and cover assembly from the power 
connector at the rear of the MasterTech.

3. Remove the fuse from the fuse block.

The input power connector can be used with either a single-fuse arrangement or a double-
fuse arrangement, as shown in the following illustration.

The power cord should be disconnected from the MasterTech before removing the 
cover from the power input connector. Failure to disconnect the power cord could 
result in electrical shock.

The fuses used in the MasterTech must be identical in type and rating to that 
specified. Use of other fuses could result in electrical shock and/or damage to the 
MasterTech.
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4. Insert appropriate fuse(s) for the input power source. Refer to the chart below for the 
appropriate fuse rating.

Power Source                 Fuse                                   
100-120 VAC 3AG, 1.25 Amp Slow-Blow
200-240 VAC 5x20 mm, 0.8 Amp Slow-Blow (Type T)

5. Insert fuse block and cover assembly into input power connector (as shown in the 
following illustration) and snap it into place. 
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Ordering Information

The SediGraph 5100 Particle Size Analysis System components and accessories can be 
ordered through our Customer Order Entry Department - (770) 662-3636. When ordering, 
please use the information provided in the following table.

Part Number Item and Description

512-00000-00 SediGraph 5120 analyzer; includes software, operator’s manual, and 
accessories. This represents either the only analyzer in a single-
analyzer system or the first of multiple analyzers in a system.

512-00001-00 SediGraph 5120 analyzer; includes accessories. No software included. 
This represents an additional analyzer in a multiple analyzer system.

052-00000-00 MasterTech 052, for automatic sample preparation. Redisperses 
samples and transfers them to the SediGraph for analysis. Includes 
built-in mechanical stirrer and ultrasonic probe. 

003-60101-06 Power cord, shielded

003-20665-00 Interface cable, shielded

003-39046-00 Lamp for analyzer front panel x-ray status indicators

511-25892-00 SediGraph cell

511-25866-00 High settling velocity cell

510-32801-01 Cell window, set of 2

510-32804-01 Cell window, Homalite®, set of 2

512-27600-01 Filter, air, 10 ppi (washable), for analyzer

512-27600-02 Filter, air, 25 ppi (washable), for analyzer

512-27600-03 Filter, air, 45 ppi (washable), for analyzer

512-32820-01 Tubing set, Tygon®, universal, pre-cut

512-32821-01 Tubing set, Tygon, for mixing chamber pump and cell pump

512-32820-04 Tubing set, Silicone, universal, pre-cut

512-32821-04 Tubing set, Silicone, for mixing chamber pump and cell pump

512-32820-03 Tubing set, Viton, universal, pre-cut

512-32821-03 Tubing set, Viton, for mixing chamber pump and cell pump
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512-32820-02 Tubing set, universal, pre-cut

512-32821-02 Tubing set, universal, for mixing chamber pump and cell pump

512-62600-00 Peristaltic pump head, for cell or mixing chamber pump (no motor)

500-25610-00 Magnetic stirring bar

004-25053-00 Spatula

004-61021-00 Beaker, 100 mL

004-61050-00 Bottle, 10L

004-61050-01 Modified cap for 10L Bottle

512-33601-00 Recommended operating supplies kit, includes: 2 plastic 10-Liter 
bottles, 2 magnetic stirring bars, 8 cell windows, 2 analyzer air filters, 
5 sets Tygon and 2 sets Silicone tubing.

004-16800-00 Sedisperse sampler kit

004-16837-00 Reference material, garnet (~3.77 m) - Traceable to NIST

004-16811-00 Reference material, garnet (~11.0 m)

004-16814-00 Reference material, glass (~1.5 m)

004-16835-00 Reference material, fine particle size (~0.77 m) - Traceable to NIST

512-42801-00 SediGraph 5120 Operator’s Manual

512-33001-00 SediGraph 5120 Operator’s Manual and current software

500-58902-00 Ultrasonic probe, 250 Watts, 115 Volts (not available in countries 
requiring CE certification)

500-58903-00 Ultrasonic probe, 250 Watts, 230 Volts (not available in countries 
requiring CE certification)

500-58904-00 Sound abating enclosure (for use with ultrasonic probe)

003-58601-00 Ultrasonic bath, 115 Volts

003-58602-00 Ultrasonic bath, 230 Volts

511-25870-00 Mixing chamber assembly, standard

511-25870-02 Mixing chamber assembly, stainless, for high pH resistance

512-25807-01 Mixing chamber cover bezel
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                      —————— MASTERTECH ACCESSORIES ——————

004-54134-00 Wrench, 9/16 in., ignition open end

051-14811-00 Evaporation cover

051-14814-00 Turntable assembly

051-32901-00 Tubing set, Tygon®, pre-cut

052-32802-00 Tubing, MasterTech to SediGraph

051-58600-06 Ultrasonic probe tip, for use with units that have ultrasonic probe 
cables with connectors at both ends of the cable. One connects to the 
top of the probe and the other to the MasterTech. 

051-58605-02 Ultrasonic probe tip, for use with units with serial number 151 and 
greater, which have only one connector that connects to the 
MasterTech.

051-61702-01 Beaker, molded, 125 mL without spout, PE

052-54600-00 Key, Tubing loading
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Error Messages

This chapter contains a numerical listing of the error messages associated with the SediGraph 
5120 analysis program. If the Action response for the message instructs you to contact your 
Micromeritics service representative, record the error message and make backup copies (if 
appropriate) of any files involved in the operation. 

2201- Cannot execute report subsystem.

2401- FATAL ERROR: (error message)

2430- Error accessing file (file name), error code = (number).

Cause: Start Report failed to execute the report susbsystem (which is a separate 
process).

Action: Restart the computer. If the problem persists, reinstall the application (this 
will not affect any of your sample files). If the problem continues, contact a 
Micromeritics service representative.

Cause: An internal processing and/or hardware error has occurred. 

Action: Contact your Micromeritics service representative if you continue to receive 
this error message.

Cause A: Diskette may be damaged.

Action A: Clean the diskette drive. If this does not eliminate the problem, attempt the 
operation using a backup copy of the file.

Cause B: Hard disk may be damaged.

Action B: Contact your Information Technology department or perform hard disk 
diagnostics.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your Micromeritics service representative.

Cause D: The name specified contains one or more invalid characters.

Action D: Enter a valid file name; do not use characters such as * or ?.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) - Subset # (number) wrote wrong amount of data.

2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

Cause: The hard disk does not have enough space left to perform the operation.

Action: Copy files not used regularly from the hard disk to diskette, delete them 
from the hard disk, and then try the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to 
receive this error message.

Cause: Several files have been added to this directory by some function other than 
the SediGraph 5120 analysis program.

Action: Click Yes to update the directory information with data from each new 
file. This operation may take a minute. 

Click No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you wish 
to access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to 
receive this error message.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press Enter.

Cause: You entered a file specification that does not exist.

Action: Enter an existing file specification or select a file name from the list box.
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2438- Disk drive (letter): is inaccessible.

2439- Cannot register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

2448- (directory type) File directory (path name) is invalid. Resetting to the installation 
directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

Cause: You selected a disk drive that is not presently accessible.

Action: Ensure that the drive is not write-protected.

Cause: An unrecoverable error occurred when you tried to access a data file.

Action: Contact your Micromeritics service representative.

Cause: A working directory specified in the .INI file is invalid. The directory may 
have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a file, 
use the Directories: list to move to the correct directory.

Cause: You entered an invalid file name.

Action: Enter a valid file name. A file name can contain up to eight 
alphanumeric characters.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the defaults.

Action: Finish your edit session of the defaults and close the dialog. Then restart the 
automatic analysis.
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2452- Attempt to write MICATTR.DIR in read only mode. (file name)
2453- Attempt to append MICATTR.DIR in read only mode. (file name)

2454- Too many selections for a print-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handlers available. Application cannot continue.

Cause: The Read-Only attribute is turned on in the application’s MICATTR.DIR file 
(this file exists in each folder containing sample or parameter files).

Action: Use Windows Explorer to access the folder containing the MICATTR.DIR 
file and disable the Read-Only option.

Cause: You requested a File/Print operation on multiple files with the destination 
specified as a disk file. All of these files cannot be processed in a single 
operation.

Action: Only the number of files indicated in the message will be processed. When 
these are complete, return to the File/Print menu selection and generate the 
reports for the remainder.

Cause: You requested a File/Export operation on multiple files with the destination 
specified as a disk file. All of these files cannot be processed in a single 
operation.

Action: Only the number of files indicated in the message will be processed. When 
these are complete, return to the File/ Export menu selection and generate the 
reports for the remainder.

Cause: The analysis program has attempted to reserve space for the disk files which it 
will require. This attempt has failed.

Action: Modify the “files=” entry in the CONFIG.SYS file to have a value of 80 or 
greater. Re-boot the computer and attempt to restart the application. If this 
message persists, contact your Micromeritics service representative.
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2457- Results cannot be displayed. More than (n) windows are currently displaying or 
printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

2460- Fatal Communications error on (Unit n - S/N: nnnn)

Cause: You requested a report either to the screen or to the printer. This request 
exceeds the maximum number of reports which may be active at one time.

Action: Close some of the report-to-screen displays currently visible. If reports are 
active to the printer, wait until they have completed, then repeat your request 
for a report.

Cause: You tried to exit the WIN5120 analysis program while the instrument is 
performing a critical operation. This operation must be completed before you 
can exit.

Action: Wait a short time and try to exit again.

Cause: You tried to exit the WIN5120 analysis program while an analysis is in 
progress. While this is possible, the data collected while the WIN5120 
analysis program is inactive will not be permanently recorded until the 
analysis program is re-started. A power failure to the instrument could cause 
some data to be lost.

Action: If your are not concerned with potential loss of data if a power failure occurs, 
click Yes to continue with the exit; click No if you wish to wait for the 
analysis to finish.

Cause: There was a fatal error in the serial communications between the WIN5120 
analysis program and the analyzer. All displays for that analyzer will be 
closed.

Action: Ensure that the analyzer is connected to the computer on the
communications port configured by the Setup program. Stop and restart the 
WIN5120 analysis program. If the restarted application cannot establish 
communications with the analyzer, turn the analyzer off, then back on. If this 
error persists, contact your Micromeritics service representative
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2461- No instruments are in operation. This application will unconditionally terminate.

2471- Unit n - S/N: nnnn has an invalid communications port specified. It cannot be 
initialized.

2474- Unit n - S/N: nnnn communications port specified in the program control files is 
already in use. Unit cannot initialize.

2475- Unit n - S/N: nnnn communications port specified in the program control files 
cannot be accessed. Unit cannot initialize.

2476- Unit n - S/N: nnnn startup failed. Cannot initialize the communications port.

2477- Unit n - S/N: nnnn did not properly initialize.

Cause: At least one instrument must be active for the WIN5120 analysis program to 
operate. The initialization of all of the instruments configured with the Setup 
program has failed.

Action A: Usually this message is preceded by another message giving the reason for 
the instrument’s failure to initialize. Refer to the explanation for that message.

Cause: The communications port associated with this unit was not valid.

Action: Run the setup program and set up the unit on a valid port.

Cause: The communications port associated with this instrument is in use by some 
other program in the system.

Action: Close the other program to release the port. Restart the WIN5120 analysis 
program.

Cause: The communications port associated with this unit was not valid.

Action: Run the Setup program and configure the unit on a valid port.

Cause: The communications port associated with this unit was not valid.

Action: Run the Setup program and configure the unit on a valid port.

Cause A: There were communication problems between the computer and the analyzer.

Action A: Check the communication cables and make sure they are connected securely.

Cause B: You selected Cancel during initialization.

Action B: None required.
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2478-   Error copying sequential data segment.

2479- Unit n - S/N: nnnn The instrument is busy performing an operation of which this 
application is unaware. Do you want to cancel?

2480- File (file name) cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file (file name) (Code n).

Cause: An internal processing and/or hardware error occurred while accessing a 
portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for example, 
you may wish to use a utility such as ScanDisk. Contact your Micromeritics 
service representative if you continue to receive this error message.

Cause: During initialization, the instrument was found to be analyzing, but the 
WIN5120 analysis program has no record of it. 

Action: Click Yes to cancel the analysis and synchronize the WIN5120 analysis 
program with the instruments status. Click No to abort the initialization and 
allow the analyzer to continue the analysis.

Cause: You attempted an analysis using a sample file that is being edited.

Action: Save the changes and close the dialog box.

Cause A: You attempted to open a file that is already open, possibly minimized.

Action A: View the minimized icons, locate and maximize the file.

Cause B: Diskette may be damaged.

Action B: Clean the diskette drive. If this does not eliminate the problem, attempt 
operation using a backup copy of the file.

Cause C: Hard disk may be damaged.

Action C: Contact your Information Technology department or perform hard disk 
diagnostics.

Cause D: A software error occurred when the file was accessed.

Action D: Contact your Micromeritics service representative.
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2482- File cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on (file name). It is open for editing and 
contains errors.

2484- The edit session for (file name) must be saved before the analysis. Save 
changes and continue with the analysis?

2485- The service test file has an invalid status and cannot be used for this analysis.

2486- Cannot construct (name) report type. Program will terminate.
2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

Cause: You are attempting to open a file that is currently being used (either by this 
application or another).   

Action: Locate the application using the file (in the Micromeritics application, use the 
Windows menu item to get a list of all windows, one of which may contain 
this file).

Cause: You attempted to use a sample file containing errors that is currently open.

Action: Go to the window containing the file, correct the errors, and save it.

Cause: You attempted an analysis using a sample file that contains unsaved changes.

Action: Select Yes to save the changes and continue with the analysis. Select No to 
abort the analysis and return to the sample file.

Cause: The selected service test file has a status other than No Analysis.

Action: Select a different service test file or create a new one and use Replace All to 
copy parameters from the file you originally selected.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to receive 
this error message.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.
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2489- File (file name) cannot be opened for writing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

2491- Highlighted fields contain errors. Please correct the errors before closing dialog 
box.

2492- This field’s entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII file containing initialization information and system options 
information used during program startup does not exist.

Action A: Restore the WIN5120.INI file from a backup of your system.

Action B: Reinstall the SediGraph 5120 analysis program.  

Cause: The highlighted field(s) contain an invalid entry. You must correct the error 
before you can close the dialog box.

Action: Check the entry and correct the error, then close the dialog box.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range of 
values.

Action: Check the entry and enter or select an appropriate value.
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2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: The value you entered in the highlighted field is outside the valid range of 
values.

Action: Check the entry and enter or select a value within the indicated range.

Cause: You entered an invalid number in the highlighted field.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered) could not be done.

Action: Contact your Micromeritics service representative if you continue to receive 
this error message. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three digits.

Action: Enter a sequence number that contains at least three digits.
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2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (file name). Could not create DIO intermediate file.

2504- Cannot create output file for sample (sample name).

Cause: No more sample information files can be created using the currently entered 
file name sequence number.

Action: Select Options > Sample Defaults from the Main Menu and enter a new 
sequence number.

Cause: A large number of windows are open and consuming the system resources 
available to all applications.

Action: Close one or more windows on the screen. Contact your Micromeritics 
service representative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed in the 
directory specified by the TEMP environment variable. 

Action A: Determine if there is sufficient space on the drive where the TEMP directory 
is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your Micromeritics service representative if you continue to receive 
this error message.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your Micromeritics service 
representative if you continue to receive this error message.
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2505- Error Logger cannot be initialized!! Error code (number).

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

2510- sample file) Error parsing reports from file (name). Reports cannot be produced.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

Cause: The selected output device is not installed in Windows.

Action: Select a different output device in the System Configuration dialog box. 
Install the device using the Control Panel - Printers operation.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay is a valid file.

Cause: An error occurred while the program was opening a file necessary to the 
report operation.

Action: Use the name given in the error message to investigate. Contact your 
Micromeritics service representative if you continue to receive this error 
message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and remove the 
invalid character.

Cause B: The system was unable to create the usual temporary files during the report, 
possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your Micromeritics service representative.
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2511- Print job (name) has been canceled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) canceled. (number)

2513- Unable to read the calibration file (file name).

2514- Unable to write the calibration file (file name).

2515- Warning: Changing the calibration information will affect the performance of the 
instrument. Only qualified service personnel should do this. Do you wish to proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

Cause: The disk drive does not have enough space for the temporary file required by 
the Windows Print Manager. Therefore, printing of the requested report has 
been canceled.

Action: Delete unnecessary files from the disk. You will require at least 5 megabytes 
of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the alleged calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Be sure the media containing the alleged calibration file has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.

Cause: You have performed a calibration operation; a backup copy is recommended.

Action: Perform a calibration Save operation.
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2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

2519- Entered or merged data must have at least two points with unique mass percent 
values.

2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.
2527- Controller CRC error on boot block.
2528- Controller DRAM error.
2529- Controller Com1: error.
2530- Controller Com2: error.
2531- Controller debug port error.

Cause: You have not accepted the calibration you performed.

Action: If the calibration operation was successful, press Accept.

Cause: The entered and/or merged data included in the report being attempted does 
not have sufficient unique mass percent values.

Action: Review the entered or merged data. There must be at least two points and the 
mass percent value of the last point must be different than the mass percent 
value of the first point.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to receive 
this error message.
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2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number).

2549- Error accessing online manual (name).

Cause: The application has discovered a different version of software operating in the 
analyzer. 

Action: If there are no analyzers other than the SediGraph connected to the computer, 
select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to receive 
this error message.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: You attempted to view the online manual but it could not be found.

Action: Reinstall the software. If the problem persists, contact your Micromeritics 
service representative.
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4200- An error occurred while loading the application control information. Data entry 
cannot be performed. (Code # <n>)

4201- No reports selected.

4202- No valid data to report.

4203- The reference file is not valid. ‘Diff. from ref.’ column was deleted.

4204- Coarser specification file is not valid. ‘Out of spec.’ column was deleted.

Cause: An internal error occurred while read control information was being read 
from a disk file.

Action: The disk on which the application is installed may have failed. Contact your 
Micromeritics service representative and report the code number given in the 
message.

Cause: You failed to select reports in the “Reports to Generate” listbox. No output 
could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit the 
sample for reporting.

Cause: The selected analysis in the sample file activated for reporting does not 
contain any valid data.

Action: If the sample is still analyzing, wait until enough data have been collected to 
allow reporting. If the sample is complete, an error or operator intervention 
stopped this analysis before sufficient data could be collected. The analysis 
may be deleted from the file.

Cause: You requested a tabular report with Difference from reference selected as one 
of the columns. This quantity cannot be computed because the reference file 
is invalid.

Action: If no reference file has been specified, select one from the Report Options 
dialog and re-run the reports. If a file has been specified, ensure that it 
contains valid information.

Cause: You requested a tabular report with Out of Specification selected as one of 
the columns. This quantity cannot be computed because the coarse 
specification file is invalid.

Action: If no specification file has been specified, select one from the Report Options 
dialog and re-run the reports. If a file has been specified, ensure that it 
contains valid information.
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4205- Finer specification file is not valid. ‘Out of spec.’ column was deleted.

4206- The tabular report has no valid columns selected. No report produced.

4207- No valid data is available for this report. No report produced.

4208- An overlay file is not valid. It was not included in the report.

4209- The reference file is not valid. The report was not produced.

Cause: You requested a tabular report with the Out of Specification selected as one 
of the columns. This quantity cannot be computed because the finer 
specification file is invalid.

Action: If no specification file has been specified, select one from the Report Options 
dialog and re-run the reports. If a file has been specified, ensure that it 
contains valid information.

Cause: You requested a tabular report with all of the columns set to none.

Action: Edit the options for that table and select a variable in at least one column of 
the table.

Cause: The selected test in the sample file activated for reporting does not contain 
any valid data.

Action: If the sample is still analyzing, wait until enough data have been collected to 
allow reporting. If the sample is complete, an error or operator intervention 
stopped this analysis before sufficient data could be collected. The analysis 
may be deleted from the file.

Cause: The sample file you selected for overlay does not exist or contains invalid 
data.

Action: From the Report Options dialog, click Overlays and remove the sample file.

Cause: You selected the Difference from Reference graph; it cannot be computed 
because the reference file is invalid.

Action: If a reference file has not been specified, select one from the Report Options 
dialog and re-run the reports. If a file has been specified, ensure that it 
contains valid information.
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4210- Coarser specification file is not valid. The report was not produced.

4211- Finer specification file is not valid. The report was not produced.

4212- At least one report item must be selected. Press Cancel if you do not want a 
report.

4213- Are you sure you want to delete the test?

Cause: You selected the Out of Specification graph; it cannot be computed because 
the coarse specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, ensure that 
it contains valid information.

Cause: You selected Out of Specification graph; it cannot be computed because the 
fine specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, ensure that 
it contains valid information.

Cause: You failed to select reports in the “Reports to Generate” listbox. No output 
could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit the 
sample for reporting.

Cause: You selected Delete on the Collected Data editor.

Action: Click Yes to remove the indicated test from the sample file. Click No to have 
the test remain in the sample file.
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6001- An automatic analysis mode is enabled. The sample defaults may not be edited 
while this mode is active.

6002- Error accessing the sample information file (file name). (Code <n>).

6003- File (file name) already has all its tests filled.

6004- File `(file name)` cannot be analyzed. It is currently being edited.

6005- The file (file name) can not be prepared for analysis. It is open for editing and 
contains errors.

Cause: One of the automatic analysis modes is active. Sample defaults may not be 
edited while this mode is active.

Action: End all automatic analysis modes on all attached units and try again.

Cause A: You may  not have full rights to the application’s folders and files..

Action A: Contact your system administrator to have full rights granted.

Cause B: An error occurred when you tried to access a sample file.

Action B: Report the error code number given in the message to your Micromeritics 
service representative.

Cause: You tried to insert a new test into a sample which already contains eight tests.

Action: A single sample file can have a maximum of eight tests. If additional tests are 
required on this sample, you must create another sample file.

Cause: You selected a file which was still open in an editing window for analysis.

Action: Finish the changes to the sample file, then save and close the editing window.

Cause: You selected a file which is currently being edited. Editing cannot be finished 
because the sample contains entry fields with errors.

Action: Correct the errors and finish editing the sample file. Then save, close the 
editing window, and try opening the file again.
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6006- The edit session for `(file name)` must be saved before it is prepared for 
analysis. Save changes and proceed with the analysis?

6007- (Unit n - S/N: nnnn) Bubble elimination failed. Operation cancelled.

6008- (Unit n - S/N: nnnn): Bubble elimination difficulties encountered.

Cause: You selected a file for analysis which is currently being edited. The changes 
to this file must be saved before it can be prepared for analysis. 

Action: Click Yes to save the changes and proceed with the analysis. Click No if you 
wish to review the changes before you save them.

Cause A: A wetting agent may be required to aid in bubble elimination.

Action A: Add one drop of Photo-Flo 200 or other wetting agent to the mixing chamber.

Cause B: Cold suspension fluid was introduced to the heated mixing chamber and cell, 
causing the release of dissolved gases.

Action B: Warm the suspension fluid prior to introduction, or allow it to circulate in the 
mixing chamber for several minutes before starting the analysis.

Cause C: Dispersion indicated in cell is not uniform.

Action C: Wait to see if bubbles are eliminated. Then check tubing for clogs or 
damage. Replace tubing if necessary. 

Cause D: The sample material being analyzed requires more suspension energy.

Action D: Change your analysis options to increase the pump speed specified for the 
full-scale scan operation. After you have changed the sample file, repeat the 
analysis.

Cause E: The sample material being analyzed has a high density.

Action E: Change analysis options to reduce the sensitivity of the bubble detection 
method. After you have changed the sample file, repeat the analysis.

Cause A: A wetting agent may be required to aid in bubble elimination.

Action A: Add one drop of Photo-Flo 200 or other wetting agent to the mixing chamber.

Cause B: Cold suspension fluid was introduced to the heated mixing chamber and cell, 
causing release of dissolved gases.
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6009- (Unit n - S/N: nnnn) Failure reestablishing full scale concentration. Analysis will 
continue.

6010- (Unit n - S/N: nnnn) Sample concentration is low. Analysis will continue.

Action B: Warm the suspension fluid prior to introduction, or allow it to circulate in the 
mixing chamber for several minutes before starting analysis.

Cause C: Dispersion indicated in cell is not uniform.

Action C: Wait to see if bubbles are eliminated. Then check tubing for clogs or damage. 
Replace tubing if necessary.

Cause: D Material under analysis requires more suspension energy.

Action D: Change the cell pump speed in your analysis options, then repeat the analysis.

Cause E: Material under analysis has high density.

Action E: Change the bubble detection method to medium or coarse in your analysis 
options, then repeat the analysis.

Cause A: The system could not reach the same level of sample suspension as during the 
previous full-scale scan.

Action A: Cancel the current analysis. Use manual control to change the cell pump 
speed to 5 and operate the pump for one or two minutes. Repeat the analysis.

Cause B: Sample residue is trapped in the system.

Action B: Check the tubing and fittings for clogs and residue. Squeeze the tubing at all 
locations where residue is trapped. Repeat the analysis.

Cause A: You used too little sample, causing a 13% change in X-ray adsorption.

Action A: Cancel the current analysis. Using manual control, turn on both pumps and 
add more dispersed sample to the mixing chamber. Restart the analysis.

Cause B: The sample requires more suspension energy.

Action B: Cancel the current analysis. Using manual control, operate the cell pump in 
the UP direction at pump speed 5 for one or two minutes. Restart the analysis.
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6011- (Unit n - S/N: nnnn) Sample concentration is high. Analysis will continue.

6012- (Unit n - S/N: nnnn) No x-rays detected.

6013- (Unit n - S/N: nnnn) No x-rays detected due to key at Standby. 
6014- (Unit n - S/N: nnnn) No x-rays detected due to door open. 
6015- (Unit n - S/N: nnnn) No x-rays detected due to panel off. 
6016- (Unit n - S/N: nnnn) No x-rays detected due to X-Ray filament over-current. 
6017- (Unit n - S/N: nnnn) No x-rays detected due to X-Ray lamp off. 

6018- (Unit n - S/N: nnnn) No x-rays detected. Automatic operation will cancel.

6019- (Unit n - S/N: nnnn) No x-rays detected due to key at Standby. Automatic 
operation will cancel.

6020- (Unit n - S/N: nnnn) No x-rays detected due to door open. Automatic operation 
will cancel.

6021- (Unit n - S/N: nnnn) No x-rays detected due to panel off. Automatic operation will 

Cause: You used too much sample, causing more than a 75% change in X-ray 
absorption.

Action: Cancel the current analysis. Using manual control, turn on both pumps and 
add more dispersing liquid to the mixing chamber to dilute the sample 
mixture. Restart the analysis.

Cause A: The solid portion of the cell is blocking the X-rays from the detector.

Action A: Using manual control, move the cell to a different position.

Cause B: The slit in the X-ray source or detector is blocked.

Action B: Clean the slits in the X-ray source to remove any residue. Refer to Cleaning 
the Collimating Slits in Chapter 9.

Cause: No x-rays are detected due to the problem described in the error message.

Action: Correct the problem, then restart the operation.

Cause A: The solid portion of the cell is blocking the X-rays from the detector.

Action A: Using manual control, move the cell to a different position.

Cause B: The slit in the X-ray source or detector is blocked.

Action B: Clean the slits in the X-ray source to remove any residue. Refer to Cleaning 
the Collimating Slits in Chapter 9.
A-24                                                    512-42801-01 (Rev L) Apr 2022



SediGraph 5120 Operator’s Manual Appendix A
cancel.

6022- (Unit n - S/N: nnnn) No x-rays detected due to X-Ray filament over-current. 
Automatic operation will cancel.

6023- (Unit n - S/N: nnnn) No x-rays detected due to X-Ray lamp off. Automatic 
operation will cancel.

6024- (Unit n - S/N: nnnn) Error rinsing system. Cannot reestablish baseline 
concentration.

6025- (Unit n - S/N: nnnn) Cannot find beamsplit.

6026- (Unit n - S/N: nnnn) Cannot find beamsplit. Automatic operation will cancel.

Cause: No x-rays are detected due to the problem described in the error message. The 
automatic operation that is in progress will be canceled.

Action: Correct the problem, then restart the operation.

Cause A: The dispersing liquid you are using is different from the one you used for 
measuring the baseline.

Action A: Perform a baseline measurement using the current dispersing liquid.

Cause B: Sample residue has remained in the cell.

Action B: Cancel the current operation. Using manual control, select the Flow Up in 
Cell direction for the cell pump at pump speed 5 for one or two minutes. Also 
check for clogs in the tubing and crimped tubing as necessary. Visually 
inspect the cell windows, clean or replace as necessary (refer to Chapter 9).

Cause A: The cell has been removed from the analyzer.

Action A: Replace the cell and resume operation.

Cause B: The cell elevator is not operating properly.

Action B: Contact your Micromeritics service representative.

Cause A: The cell has been removed from the analyzer.

Action A: Replace the cell and resume the operation.

Cause B: The cell elevator is operating improperly.

Action B: Contact your Micromeritics service representative.
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6027- (Unit n - S/N: nnnn) Not enough cell travel to perform an analysis.

6028- (Unit n - S/N: nnnn) Not enough cell travel. Automatic operation will cancel.

6029- (Unit n - S/N: nnnn) Upper limit switch not found.

6030- (Unit n - S/N: nnnn) Error moving cell.

Cause A: Cell assembly is assembled improperly.

Action A: Disassemble the cell assembly and reassemble. Be sure the sloped portions of 
the cell body and the retaining plates are aligned. Refer to Cleaning the 
Analysis Cell in Chapter 9.

Cause B: The upper limit switch of the cell elevator must be reset.

Action B: Contact your Micromeritics service representative.

Cause A: Cell assembly is assembled improperly.

Action A: Disassemble the cell assembly and reassemble. Be sure the sloped portions of 
the cell body and the retaining plates are aligned. Refer to Cleaning the 
Analysis Cell in Chapter 9.

Cause B: The upper limit switch of the cell elevator must be reset.

Action B: Contact your Micromeritics service representative.

Cause A: The cell position counter is too far out of position to find the upper limit 
switch. The lower limit switch may have been triggered.

Action A: Using manual control, move the cell to the upper limit switch; this resets the 
cell position counter.

Cause B: The cell elevator is not operating properly.

Action B: Contact your Micromeritics service representative.

Cause C: The upper limit switch is operating improperly.

Action C: Contact your Micromeritics service representative.

Cause A: Some object or the cell tubing is preventing the cell elevator from moving.

Action A: Check for and remove object, or reposition the cell tubing.
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6031- (Unit n - S/N: nnnn) Error moving cell. Automatic operation will cancel.

6032- (Unit n - S/N: nnnn) Temperature is not within the range of the liquid properties 
set.

6033- (Unit n - S/N: nnnn) Liquid density must be less than sample density.

6034- (Unit n - S/N: nnnn) Fan problem (code n,n)

6035- (Unit n - S/N: nnnn) Electronics problem.

Cause B: The cell elevator is operating improperly.

Action B: Contact your Micromeritics service representative.

Cause A: Some object or the cell tubing is preventing the cell elevator from moving.

Action A: Check for and remove any foreign object, or reposition the cell tubing.

Cause B: The cell elevator is operating improperly.

Action B: Contact your Micromeritics service representative.

Cause: The temperature of the analysis compartment at the time of the analysis is not 
within the range defined by the liquid properties specified in the sample file.

Action: Either change the analysis compartment temperature by selecting Unit [n] > 
Unit Configuration, then clicking the Set Temperature button or change the 
liquid properties in the associated sample file.

Cause: The density of the dispersing liquid is too high for the sample being analyzed.

Action: Switch the dispersing liquid to one with density lower than that of the sample.

Cause: One or both of the cooling fans are operating at less than 70% of the normal 
speed. The code values are: 1,0 means the PMT fan has the problem; 0,1 
means the X-ray fan has the problem; 1,1 means both fans have the problem.

Action: Turn off the analyzer. Contact your Micromeritics service representative.

Cause: An electronic component is not operating to specification.

Action: Turn off the analyzer. Contact your Micromeritics service representative.
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6036- (Unit n - S/N: nnnn) Using mixing chamber speed of (n) which differs from 
requested speed of (n). Analysis will continue.

6037- (Unit n - S/N: nnnn) Fan problem (code n,n). Automatic operation will cancel.

6038- (Unit n - S/N: nnnn) Electronics problem. Automatic operation will cancel.

6039- (Unit n - S/N: nnnn) Error moving turntable.

6040- (Unit n - S/N: nnnn) Error moving turntable. MasterTech automatic operation will 
cancel.

6041- (Unit n - S/N: nnnn) Error moving arm assembly.

Cause: The mixing chamber speed specified in the sample file being analyzed 
(requested speed) is not the same as the speed at which the mixing chamber is 
currently operating.

Action: No action required unless the mixing chamber speed needs to be adjusted. In 
this case, enable manual control and adjust the speed.

Cause: One or both of the cooling fans are operating at less than 70% of the normal 
speed. The code values are: 1,0 means the PMT fan has the problem; 0,1 
means the X-ray fan has the problem; 1,1 means both fans have the problem.

Action: Turn off the analyzer. Contact your Micromeritics service representative.

Cause: An electronic component is not operating to specification.

Action: Turn off the analyzer. Contact your Micromeritics service representative.

Cause: The arm is in the Load position or something is preventing the beaker tray 
from moving.

Action: Make sure the arm is not in the Load position or that nothing is preventing the 
beaker tray from moving.

Cause: The arm is in the Load position or something is preventing the beaker tray 
from moving.

Action: Make sure the arm is not in the Load position or that nothing is preventing the 
beaker tray from moving.

Cause: The arm is in the Load position or something is preventing the arm from 
moving.

Action: Make sure the arm is not in the Load position or that nothing is preventing the 
arm from moving.
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6042- (Unit n - S/N: nnnn) Error moving arm assembly. MasterTech automatic 
operation will cancel.

6043- (Unit n - S/N: nnnn) Not present.

6044- (Unit n - S/N: nnnn) Turntable not present.

6045- (Unit n - S/N: nnnn) Turntable not present. MasterTech automatic operation will 
cancel.

6046- (Unit n - S/N: nnnn) Arm assembly at the load position.

Cause: The arm is in the Load position or something is preventing the arm from 
moving.

Action: Make sure that the arm is not in the load position or that nothing is preventing 
the arm from moving.

Cause A: The MasterTech has been turned off.

Action A: Check the power connection and make sure the POWER ON/OFF switch on 
the MasterTech is in the ON (1) position.

Cause B: The MasterTech is not properly connected to the SediGraph.

Action B: Check the control cable from the MasterTech to ensure that it is properly 
connected.

Cause: The turntable is not properly installed on the MasterTech.

Action: Install the turntable as described in the Installation Manual.

Cause: The turntable is not properly installed on the MasterTech.

Action: Install the turntable as described in Installation Manual.

Cause: You tried to perform an operation that is inoperable when the arm is in the 
Load position.

Action: Press the front panel switch to take the arm out of the Load position.
512-42801-01 (Rev L) Apr 2022                                                    A-29



Appendix A SediGraph 5120 Operator’s Manual
6047- (Unit n - S/N: nnnn) Arm assembly at the load position. MasterTech automatic 
operation will cancel.

6048- (Unit n - S/N: nnnn) Cannot find position 1 on the turntable.

6049- (Unit n - S/N: nnnn) No beaker is present in position (n).

6050- (Unit n - S/N: nnnn) No beaker is present in position (n). MasterTech automatic 
operation will cancel.

6051- Conversion has not finished, close anyway?

6052- Cannot read source file (file name).

Cause: You tried to perform an operation that is inoperable when the arm is in the 
Load position.

Action: Press the front panel switch to take the arm out of the Load position.

Cause: The turntable may not be seated properly. If the turntable is moving properly, 
a service problem may be indicated.

Action: Contact your Micromeritics service representative.

Cause: You requested an action, such as a MasterTech rinse, but there is no beaker 
present in the specified position.

Action: Insert a beaker at the specified position and restart the operation.

Cause: You requested an action, such as a MasterTech rinse, but there is no beaker 
present in the specified position.

Action: Insert a beaker at the specified position and restart the operation.

Cause: You tried to close the conversion status window before the conversion of all 
files was complete.

Action: Click Yes to cancel the conversion. Click No to allow conversion of all files 
to finish.

Cause: You tried to convert a non-Windows sample file, but the file could not be read 
from the disk drive.

Action: The conversion of other files will continue; however, the specified file may be 
invalid. If this error occurs on multiple files, the disk drive containing the 
files may have failed.
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6053- Destination file (file name) already exists.

6054- Unable to create destination file (file name).

6055- Unable to load the Liquid Properties for file (file name). Defaults will be used.

6056- Unable to load the Particle Size table for file (file name). Defaults will be used.

6057- Conversion aborted. Unrecoverable error converting (file name) into (file name).

6058- At least one item must be selected for recording.

Cause: You tried to convert a sample file with the same name as an existing file.

Action: Delete the original destination file and repeat the conversion operation.

Cause: You tried to convert a non-Windows file, but the output file cannot be created.

Action: The disk on which the converted file is to be stored may be full or may have 
failed.

Cause: You tried to convert a non-Windows file, but the liquid properties could not 
be located.

Action: The conversion will continue using the default liquid properties. The 
converted data will be valid and usable. To conduct the conversion without 
warnings, ensure that the specified file is located in the `System Directory’ 
specified on the File Conversion dialog and repeat the conversion.

Cause: You tried to convert a non-Windows file, but the user-defined report table 
could not be located.

Action: The conversion will continue using the defaults report table. The converted 
data will be valid and usable. To conduct the conversion without warnings, 
ensure that the specified file is located in the `System Directory’ specified on 
the File Conversion dialog and repeat the conversion.

Cause: An error occurred when you tried to convert a non-Windows file to the 
Windows format.

Action: The file cannot be converted. Contact your Micromeritics service 
representative.

Cause: The Start Recording Service Test step requires that at least one signal be 
selected for recording.

Action: Select a signal or click Cancel.
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6059- An incompatible table with that name already exists.

6060- Unable to read the calibration file (file name).

6061- Unable to write the calibration file (file name).

6062- The instrument (unit number) is not calibrated.

6063- File cannot be opened for writing. It is already in use.

6064- The sample file [name] is not in a valid state to resume the analysis.

Cause: In a Service Test script, data collected have names, each of which must be 
unique.

Action: Specify a different name for the data.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media problems

Action A: Confirm the media containing the alleged calibration file has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: Calibration information for various analyzer components are missing.

Action: Run the application setup program and reinstall calibration information for 
the specified unit.

Cause: A file Save As operation failed because the specified file is already in use.

Action: Specify a different file.

Cause: The status of the sample file has changed since you last used it; it can no 
longer be used as part of an analysis.

Action: Select a new sample file, and restart the analysis.
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6065- You need to choose a sample file.

6066- There is no more room for another test in this sample.

6067- The current baseline does not match the one already in the sample.

6068- The previous tests of this sample were run on a different SediGraph.

6069- The sample has an invalid status and cannot be used for this analysis.

6070- Unit n - S/N: nnnn There is no baseline available for this unit.

6071- Configured serial number does not match instrument.

Cause: You selected OK on a schedule entry dialog, but you did not select a sample 
file.

Action: Click Browse and select a sample file.

Cause: You selected a sample file for analysis that already contains eight tests.

Action: Select a different sample file, or delete one of the previous tests from the file.

Cause: You selected a sample file that contains some analyses that were performed 
using a different baseline.

Action: Select a sample file that either has no tests, or has tests that were performed 
using the current baseline.

Cause: You selected a sample file that contains some analyses that were performed 
using a different SediGraph.

Action: Either perform the new analysis on the same SediGraph, or select a different 
sample file.

Cause: You selected a sample file that cannot be analyzed. 

Action: Select a file that has a status of No Analysis or Complete.

Cause: No baseline has been measured for this unit. 

Action: Measure a baseline before performing sample analyses.

Cause: The serial number stored in the analyzer does not match the serial number 
stored with the software.

Action: Contact your Micromeritics service representative.
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6072- Could not update the Liquid Properties file (file name). It is currently in use.

6073- Could not create the new Liquid Properties file (file name). Properties were not 
saved.

 
6074- Could not delete the Liquid Properties file (file name). It is currently in use.

6075- New data reduction options are currently being applied to the test data. Do you 
wish to cancel the reprocessing?

6076- Application of new data reduction options to (file name) is complete.

Cause: You selected Change on the Material Properties dialog to change a liquid 
properties set. The selected properties cannot be updated because it is being 
edited.

Action: Close the editing session for the named Liquid Properties and try again.

Cause: You selected Add for a liquid properties set on the Material Properties dialog. 
The new properties set cannot be created.

Action: The disk drive on which the liquid properties are stored may be full or may 
have malfunctioned. 

Cause: You selected Delete for a liquid properties set on the Material Properties 
dialog. The selected properties set cannot be deleted because it is being 
edited.

Action: Close the editing dialog and try again.

Cause: You elected to change the material properties for a completed sample. These 
changes are currently being applied to all of the data collected for that sample.

Action: Click Yes to cancel the changes. Click No and the computation will continue.

Cause: You requested a change for the material properties on a completed sample 
file. These changes have been applied to all of the data collected for the 
sample.

Action: Click OK to acknowledge the message. Click Save if the results are as 
expected and you wish to save them.
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6077- All of the test data will be converted to the new data reduction options. Do you 
wish to continue?

6078- The current hardware does not match the calibration.

6079- The Schedule contains duplicate beaker entries. Are you sure you want to 
continue?

6080- Cell nominal temperature value not in the expected range of (nnn.nn).

6081- Error computing particle sizes! The baseline or the fullscale was zero.

6082- Mixing chamber nominal temperature value not in the expected range of (n) to 
(n).

Cause: You requested a change to the material properties for a completed sample 
file. These changes are about to be applied to all of the data collected for that 
sample.

Action: Click No to cancel the changes. Click Yes and the computation will continue.

Cause: One or more calibrated components have been replaced in the analyzer.

Action: Contact your Micromeritics service representative.

Cause: You selected Start on the MasterTech Schedule dialog, and there is more than 
one entry in the schedule that has the same beaker number.

Action: Click No to stop the operation and fix the schedule. Click Yes to continue 
with the schedule.

Cause: During temperature calibration, the value read is outside of the expected 
range.

Action: Confirm that the correct temperature calibration resistor is being used.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action A: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.

Cause: During temperature calibration, the value read is outside of the expected 
range.

Action: Confirm that the correct temperature calibration resistor is being used.
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6083 (Data Reduction) Zero denominator in mass computation.

6084- (Data Reduction) Less than 11 data points collected.

6085- (Data Reduction) Computed a particle size of zero.

6086- (Data Reduction) Insufficient data for mass filter.

6087- The Coarse/Fine specification file is invalid. No results available.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.

Cause: The material properties specified for this sample result in a particle size 
computation which is less than or equal to zero.

Action: The data from this analysis will not be converted into a particle size 
distribution. Edit the material properties for the sample and modify them so 
they are valid. Click Update Properties on the Material Properties dialog to 
reprocess the analysis results.

Cause: Due to insufficient or inadequate analysis results, an error occurred while 
converting the raw data collected by the instrument into a particle size 
distribution.

Action: The data from this analysis cannot be used. The analysis may be deleted from 
the sample file.

Cause: You requested an invalid file for, or forgot to specify, either the coarse or fine 
specification.

Action: If no specification files have been specified, select them from the Report 
Options dialog and re-run the report. If files have been specified, ensure that 
they contain valid data.
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6088- The cell temperature reading of (nnn.nn) is invalid. If an analysis is in progress 
you may choose to cancel it.

Cause: A temperature reading outside of the valid range has occurred.

Action: If the problem persists, contact your Micromeritics service representative.
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6089- The mixing chamber temperature reading of (nnn.nn) is invalid. If an analysis is 
in progress you may choose to cancel it.

6090- The sample is already scheduled to be used for another analysis.

Cause: A temperature reading outside of the valid range has occurred.

Action: If the problem persists, contact your Micromeritics service representative.

Cause: You have requested a sample file for an analysis that is already
scheduled in the MasterTech schedule or the Repeat schedule.

Action A: Select a different sample that is not scheduled in the MasterTech schedule or 
the Repeat schedule.

Action B: Remove the sample from where it is already scheduled and then try
again.
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SAMPLE DISPERSION

Use of the SediGraph requires that each powder be well dispersed in a liquid of known density and 
viscosity and that the difference between the powder and liquid densities be accurately known. Viscosity 
and density data for some common liquids are given in Appendix G. Handbook values for other liquids are 
usually sufficiently accurate, so the latter requirement means that only the powder density must be 
determined if it is unknown and if composition information does not permit calculation from handbook 
values. For this, one of Micromeritics’ pycnometers is recommended. For materials likely to have dead-
end pores into which liquid may not completely penetrate, the effective density* may need to be 
determined using the sedimentation liquid to be employed and a gas pycnometer.

The liquid should be one in which the powder can be completely dispersed (separated into unattached 
particles) for accurate size results to be obtained. Obviously, the liquid should be nontoxic, readily 
available, and one in which the sample is insoluble. Complete insolubility may be difficult to achieve in 
some instances. Solubility problems may be minimized by allowing the liquid to stand in contact with the 
particle material prior to using the liquid for the test sample. This cannot completely eliminate problems, 
however, because particle solubility is a function of particle size. Small particles are more soluble than 
large ones; in a dispersion of different sizes, the smallest particles tend to go into solution while 
precipitation occurs on the larger particles. In making a particle size distribution analysis, particle 
solubility is indicated if the recorded distribution consistently fails to attain zero percent even long after the 
analysis is complete.

There are no established rules or laws by which complete particle dispersion can be assured. Only 
guidelines can be offered. Some powders disperse easily in any of several liquids and remain so while 
others require careful attention to conditions in order to achieve dispersion and are prone to reagglomerate 
if conditions shift a small amount. A few can be dispersed only after extended treatments.

Agitation, resulting in the application of strong shear forces, aids dispersion. The more violent the 
agitation, perhaps carried out in a high-speed blender, homogenizer, or an ultrasonic device, the better 
generally is the dispersion. Stirring a suspension while subjecting it to ultrasonic dispersion generally 
achieves the best dispersion because this ensures that all portions of the mix are brought into the zones of 
greatest energy.

For a few friable materials such agitation can result in comminution of the particles for which 
measurements are desired. This is not likely to be the case with solid particles, particularly when the 
particles are under 50 to 100 m in diameter.

Air bubbles cause misleading results if trapped in the liquid during agitation. Care should be taken to avoid 
bubble entrapment, especially when the liquid is highly viscous. The SediGraph performs bubble 
elimination routines and checks to verify their effectiveness, but the best agitation procedure is one that 
does not introduce them in the first place.

*The procedure for determining the effective density is discussed in Application Note #94. Contact your local sales 
representative or the Micromeritics sales office to request a copy.
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The magnetic stirrer built into the instrument is a convenient means for maintaining a homogeneous 
particle dispersion but will cause flocculation in certain magnetically susceptible materials. With such 
particles, stirring can be accomplished by using the ultrasonic dispersion accessory or the MasterTech 
(refer to “Ordering Information” on page 10-3, for part numbers).

Chemical wetting or dispersing agents also generally aid dispersion. A great variety of such products are 
marketed. Appendices C and H list some of the more useful dispersing aids, as well as sources for some of 
these materials. These agents have been found useful for particle dispersion in Micromeritics’ Materials 
Analysis Laboratory but are not the only agents available. It is to be noted that liquid density and viscosity 
values may need slight adjustment if more than about 0.1% by weight (based on the dry weight of the 
sample) of dispersing agent is added and precise measurements are desired.

Some commercial surfactants are intended for use in specific pH ranges and in particular nonaqueous 
solutions. Slight solution composition differences may alter the effectiveness of any agent. The chemical 
supplier should be contacted about this type of problem. Sometimes merely shifting the pH of an aqueous 
dispersion will yield great improvements in the degree of dispersion. Metal oxides and metals that are 
likely to have oxide layers on their surface ordinarily are most easily dispersed in mildly alkaline media. 
Metal powders with any likelihood of grease on them should always be degreased prior to a dispersion 
attempt. Noble metal powders usually need a wetting agent for good dispersion. Dispersions involving 
hydrocarbon liquids that are immiscible with water are often difficult to make unless the powder is quite 
dry. Sometimes moisture picked up from the air is more than enough to cause difficulties.

Micromeritics offers Sedisperse® liquids in three series for dispersing particles at low solids 
concentrations. A- and P-series are stable, balanced formulations containing highly purified, saturated 
aliphatic hydrocarbons and added surfactants. A-series Sedisperse liquids are colorless while the P-series 
are pale yellow. These liquids produce nearly universal dispersion of powder-liquid systems with solids 
concentrations below three weight percent generally, and as much as five weight percent in some cases. 
Sedisperse liquids solubilize adsorbed moisture.

W-series Sedisperse liquids are slightly anionic, non-foaming, aqueous formulations. They also produce 
nearly universal dispersion of systems with concentrations generally below three weight percent. 
Sedisperse liquids contain built-in surfactants and dispersants so that nothing else needs to be added for the 
dispersion of particles except mechanical and/or ultrasonic energy. These liquids are available over a range 
of densities and viscosities, thus making them applicable to particles of widely varying properties. 
Sedisperse liquids are designed to be used without dilution or the addition of surfactants, and exhibit good 
shelf life and stability. A data sheet is supplied with each liquid giving handling details, density, and 
viscosity data over a temperature range of 24 to 45 °C. 

The A-series Sedisperse liquids are the most widely useful and will disperse most powders, including 
metals, oxides, silicates, pigments, Portland cements, propellants, and many other powders. Those few 
materials not dispersing well in the A-series liquids can usually be dispersed in the P-series Sedisperse 
liquids. These are special formulations, slightly cationic, developed to disperse difficult metal and 
pigmented resin powders. The W-series Sedisperse liquids should be used to disperse those materials 
which are soluble in the organic Sedisperse liquids. See Appendix I for detailed information on Sedisperse 
liquids.

Some powders flocculate upon standing a few moments after having been dispersed. Such flocculation is 
quite readily detected with the SediGraph. The indicated size distribution as plotted by the instrument 
during a test will proceed normally until flocculation starts. The first evidence of flocculation will likely be 
an increase in the indicated particle concentration and this will then be followed by a precipitous drop in 
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the plotted percentage. Flocculation, of course, prevents accurate particle size analysis, and better 
dispersion and stabilization techniques must be sought.

As a general guide, the best dispersing technique (includes agent and procedure) is the one producing 
consistently the finest distribution of sizes by SediGraph analysis. We make this assertion because of the 
high reproducibility of the SediGraph when presented identical samples. If the sample preparation 
technique is deficient in freeing particles one from another or if, though unlikely, is producing particle 
fracture, this will be evidenced by an inconsistency of results.

The rheological behavior of high concentrations of fine powder in a liquid gives a good preliminary 
indication of the suitability of both the liquid medium and the dispersing agent. Some powders containing 
as much as 50 percent liquid act as if they were almost a solid mass, but a few tenths of a percent of wetting 
agent can cause the mass to take on the consistency of soup. This reaction is indicative of a very good 
agent. The effect will not often be so dramatic, but working the mass with a spatula will give a good 
indication of the efficacy of an agent.

A test for the optimum quantity of a dispersing agent is conducted by measuring the sediment volume from 
a slurry of about 5 weight percent concentration. The slurry and agent must be mixed and allowed to stand 
in a sedimentation tube undisturbed by either mechanical vibrations or thermal currents. The minimum 
sediment volume indicates the best agent concentration level. If several dispersing agents are compared at 
the same time, the minimum sediment volume is also a measure of the best dispersing agent.

No particular sample concentration is required in using the SediGraph as long as the dispersed sample 
reduces the radiation beam intensity by 13 to 70 percent. The recommended procedure for initial testing is 
to prepare a dispersion of approximately 5 volume percent concentration. Portions of this preparation are 
added to pure suspending liquid until an adequate concentration for analysis is achieved. The advantage of 
this procedure is that less concentrated dispersions can generally be produced without fear of flocculation 
once the initial preparation is made.
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CHEMICAL AIDS FOR PARTICLE DISPERSION

Name Type Active Ingredient

Aerosol 22 Anionic Tetrasodium N-(1,2-dicarboxyet hyl)-
N-octadecysulfosuccinanate, 35%

Aerosol OT Anionic Dioctyl ester of sodium sulfosuccinic acid, 70%

Atlas G-3300 Anionic Amine salt of alkylaryl sulfonate

Calcium Chloride Cationic CaCl2

Calgon Anionic Sodium hexametaphosphate, unadjusted

Calgon T Anionic Part of sodium replaced by other cations, 
predominantly zinc

Cobaltous Chloride Cationic CoCl2

Cobalt Citrate Anionic Co3(C6H5O7)2

Daxad 23 Anionic Sodium salts of polymerized substituted benzoid 
alkyl sulfonic acid (alkyl, long chain), 84.5%

Daxad 30 Anionic Sodium salt of polymerized carboxylic acid, 25%

FC-134 Cationic Fluorochemical surfactant

FC-161 Anionic Fluorochemical surfactant

FC-170 Nonionic Fluorochemical surfactant

Igepal CO-530 Nonionic Nonylphenoxypoly (ethyleneoxy) ethanol, 100%

Oleic Acid Anionic CH3(CH2)7CH=CH(CH2)7COOH

Renex 648 Nonionic Ethoxylated nonylphenol, 100%

Sodium Silicate Anionic Na2SiO3

Triton X-100 Nonionic Octyl phenoxy polyethoxy ethanol, 100%

Tamol SN Anionic Sodium salt of condensed naphthalene sulfonic 
acid, 100%

TSPOP Anionic Tetrasodiumpyrophosphate, Na4P2O7

Twitchell Base 8240 Anionic Sodium salt of low molecular weight, sulfonated 
oil, parafin oil, water, and diethylene glycol
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Data extracted from McCutcheon’s Detergents and Emulsifiers, McCutcheon Division, MC 
Publishing Co., Glen Rock, NJ, 1980.

Name Type Active Ingredient

Tween 20 Nonionic Polyoxyethylene Sorbitan monolaureate 
(polysorbate 20), 100%

Zonyl S-13 Anionic Fluoroalkyl phosphate

Zonyl A Nonionic Ethylene oxide-ester condensate
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STOKES’ LAW

A particle falling due to gravity in a viscous liquid is acted upon by three forces: a 
gravitational force acting downward, a buoyant force acting upward, and a drag force acting 
upward. The descriptive equation of this motion is

where m is the mass of the particle, mo the mass of a volume of liquid equal to the volume of 
the particle, g the acceleration of gravity, FD the drag force, v the particle velocity, and t the 
time.

Small particles reach a stable, or terminal, velocity very rapidly; hence, dv/dt quickly becomes 
zero. The equation of motion for a sphere of diameter D and density  falling in a liquid of 
density o then becomes

Dimensional analysis reveals that stable particle motion through a liquid is governed by two 
dimensionless groups: the particle Reynolds number Re

where is the liquid viscosity, and a drag coefficient CD expressed by                  

The relationship between Re and CD for laminar (not turbulent) flow conditions is well 

established experimentally for low values of the Reynolds number to be
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Combining equations (2) through (5) yields

which has come to be identified as the Stokes law equation*.

* Stokes, G.G., Mathematical and Physical Paper III, Cambridge University Press, 1891.
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SEDIMENTATION THEORY

Calculations

Sedimentation size analysis is based upon the fact that the measured equilibrium velocity of a 
particle through a viscous medium, resulting from the action of the gravitational force, can be 
related to the size of the particle by Stokes’ law. For spherical particles, Stokes’ law is 
expressed by

where

and D is the diameter of the spherical particle, v its equilibrium sedimentation velocity, and  
its density. The fluid medium is characterized by viscosity   and density  o ; g is the 
acceleration of gravity. These equations apply rigorously as long as the particle Reynolds 
number, Dvo/, is less than 0.3 and they apply up to a Reynolds number of 0.5, with about 
3% error.*

In practice, truly spherical particles are seldom encountered, and Stokes’ law is not exact for 
any other shape. Since irregular shapes cannot in any case be described by a single linear 
dimension, it is accepted practice to specify the size of non-spherical particles in terms of the 
diameter of a sphere of the same material that would have the same sedimentation velocity. 
Thus, for non-spherical particles, the terms “Stokes’ diameter” or “equivalent spherical 
diameter” are universally understood. The term “equivalent spherical diameter” (E.S.D.) is 
sometimes used in a different context to mean the diameter of a sphere of the same material 
that would have the same mass as the particle in question; that is, the results of measurements 
of particle dimensions from electron micrographs are frequently reduced to size distribution 
curves in terms of mass E.S.D. In general, the relationship between these two measures of size 
is given by the inequality

The ratio expressed in equation (3) is usually close to unity.

*Lapple, C.E., et al, Fluid and Particle Mechanics, University of Delaware, Newark, 1956.
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Data on the sedimentation velocity of suspended particles may be obtained in two ways: (a) by 
measuring the concentration of particles remaining in suspension as a function of time, or (b) 
by measuring the quantity of sediment produced as a function of time. The latter approach is 
less desirable mathematically because of the graphical differentiation required to reduce the 
data to a size distribution curve.

Tests based on the first approach are traditionally performed in the following way. A dilute, 
dispersion of the fine particle material is stirred to render it homogeneous and then allowed to 
stand undisturbed while undergoing sedimentation. Time is measured from the beginning of 
the settling period. By Stokes’ law, a particle of diameter D will settle a distance h in time t 
according to the expression

where K is given by equation (2). Consequently, after a given time ti all particles larger than 
the corresponding diameter Di will have fallen below a given distance h from the surface of 

the suspension. If the initial (uniform) concentration of material is Co g/cm3 and the 

concentration after time ti at distance h is Ci g/cm3, then Pi, the weight percent of material finer 
than Di, is given by

By obtaining values of Ci after various times, the corresponding values of Pi and Di may be 
calculated, which when plotted yield an integral, or cumulative distribution of particle size in 
terms of Stokes’ E.S.D.

The SediGraph uses a finely collimated X-ray beam to measure particle concentration in terms 
of the transmitted intensity of the X-ray beam through the suspension relative to the clear or 
particle-free suspending fluid. This transmittance is a function of the weight concentration of 
the suspended solid at the depth of measurement. Since the X-ray beam can be made 
extremely small and because it does not disturb the suspension, it constitutes an ideal 
measuring technique.

If a sample container or cell of rectangular cross section is irradiated from a direction 
perpendicular to one of its sides by a collimated X-ray beam, the fraction of the incident 
radiation transmitted by the cell when filled with the suspension under study is given by
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where: I and Io are the transmitted and incident intensities; a1, as, and ac the X-ray absorption 
coefficients of the liquid, the particulate solids, and the cell walls, respectively; 1 and sthe 

weight fractions of liquid and solid present in the suspension; L1 the internal cell thickness in 
the direction of irradiation; L2 the total thickness of the cell walls. By using the relation 
1=1-s and by defining a transmittance T as the ratio of the transmission of the cell when 

filled with a sample dispersion to its transmission when filled with pure suspending liquid, 
there is obtained

or

where A is a constant for the particular apparatus and suspension components.

By collimating the X-ray beam through horizontal slits with a vertical dimension small 
compared to the sedimentation depth, h, the measured values of T can be used in calculating 
the particle size distribution; that is,

where To refers to the transmittance of the initial suspension.
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Method of Analysis

Generally, the sedimentation method derives its results from the rates that different size 
particles fall in a liquid due to the force of gravity. Rate, as used here, is the distance that a 
particle falls in a certain period of time. The scientific law which describes the rate that 
particles fall in a liquid is called Stokes’ Law. Large particles fall at a faster rate than smaller 
particles, as shown in the following illustration.

Figure E-1. Particle Size Analysis Using Sedimentation

In order to determine particle diameters accurately using the falling rates of particles, the 
density and viscosity of the liquid used must be known as well as the density of the particles. 
Density is the mass of a material that it takes to fill a unit of space. Viscosity may be thought 
of as the resistance of the liquid applied to falling particles. For example, a particle falls much 
slower in syrup than in water because syrup has a higher viscosity. It should also be noted that 
temperature affects both the density and viscosity of liquids; therefore, the temperature of the 
liquid must be known for particle size determinations to be accurate.

The falling rates for various particle sizes are computed before analysis using Stokes’ Law. A 
vertical distance and an elapsed time are selected for each falling rate such that a particle 
falling at a certain rate will fall a certain distance in a selected time. Relative particle 
concentration is then measured at the selected distance and time.

Initially, a completely mixed (homogeneous) suspension of particles is established in a 
container by rapidly circulating the mixture. The circulation is stopped, and the relative 
concentrations of particles are measured at the selected vertical distances from the top of the 
container and at the selected elapsed times after circulation is stopped.

The particle size associated with each concentration measurement is the size of the largest 
particle present at the height and time of the measurement. All particles larger than that size 
have higher falling rates, and have fallen to a lower point in the container. Smaller particles are 
still present at equal concentrations just above and below the specified point. Thus, the 
concentration measured at the specified point is the concentration of particles smaller than or 
equal to that size.

Lowest Falling Rate

Highest Falling Rate
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This series of relative concentrations of particles smaller than various sizes is the particle size 
distribution.

Figure E-2. Particle Size Distribution

Since different particles usually have different shapes, the standard measure used to report 
particle size is Equivalent Spherical Diameter. This is the diameter of a sphere (or perfectly 
rounded mass) of the same material with the same falling rate. 

System Operation

The sedimentation method is used for particle size analysis in the SediGraph. The rates of 
particle fall due to gravity are calculated and X-ray absorption (concentration) of particles at 
different heights and points in time are determined, and the results of those determinations are 
provided as graphs and tabular reports. Sedimentation analysis takes place in the analyzer. 
Data are sent to the computer which provides the graphs and tabular reports.

The material to be analyzed is dispersed in a liquid, according to the type of analysis to be 
performed. (For more information concerning the relationship of dispersion to the type of 
analysis, see appendices B and C.) At the appropriate time, the dispersed mixture is poured 
into the mixing chamber on the front of the analyzer.

A magnetic stirrer located under the mixing chamber keeps the particles suspended (that is, 
keeps the particles from sedimenting) until it is time for the analysis. The stirring speed can be 
adjusted as required to properly suspend the particles. If the particles to be analyzed are 
attracted to the magnetic stirrer, the magnetic stirrer can be replaced with a mechanical stirrer. 
If the dispersion energy required to keep the particles in a dispersed state in the mixing 
chamber is more than can be provided by the stirrer used, an ultrasonic probe can be inserted 
into the mixing chamber.

Sedimentation takes place inside an analysis cell as shown in the following illustration. At the 
appropriate time, the particle mixture is transferred by the analyzer from the mixing chamber 
to the analysis cell. Particle circulation is stopped, and the particles are allowed to sediment (or 

% of Maximum Concentration
at Typical Specified Points
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fall) inside the analysis cell under the influence of gravity. The SediGraph then determines the 
particle size distribution.

Figure E-3. Analysis Cell

An X-ray beam (made up of a number of fine parallel rays) is provided from a source inside 
the analyzer. A unit which detects X-rays is placed directly across from the X-ray source. The 
analysis cell is placed in the path of the X-ray beam, between the X-ray source and the 
detector. The cell contains a window on each side so that the X-rays can pass through the cell 
to the detector. Sedimenting particles (particles falling under the influence of gravity) inside 
the cell cross the path of the X-ray beam. The particles in the path of the beam absorb X-rays 
(that is, the particles keep some X-rays from reaching the detector). The amount of X-ray 
absorption at the point in the cell where the beam is located is determined as a percentage of 
the X-ray absorption with the highest particle concentration for that sample. Based upon 
particle falling rates, this percentage is related to the maximum particle size above that point in 
the cell.

Figure E-4. SediGraph Particle Size Analysis

The SediGraph system uses both particle falling rates and the amount of X-ray absorption for 
particle size analysis. Particle falling rates (according to Stokes’ Law) are used to determine 
the points in the cell beyond which certain size particles have fallen. X-ray absorption is used 
to determine the percentage of total particle mass at different points in the cell. The resulting 
particle size distribution data are processed by the system computer and used to provide 
graphs and tabular reports which provide details of the analysis.

Lowest Falling Rate

Highest Falling Rate

X-Rays

Sample Cell

Particle

X-Ray Detector

X-Ray Source
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Particle Falling Rates

Particle falling rates are very significant in the determination of particle size distribution. 
However, there are several important considerations in the accurate determination of particle 
falling rates. There must be a reference point for measuring particle falling distances. The 
SediGraph uses an automatic beam-split feature for establishing a reference point. Small 
particles have a low falling rate, which could require considerable amounts of time for 
analysis. The SediGraph uses cell movement during analysis to shorten analysis times by 
measuring small particle concentration at very short sedimentation distances. Cell movement 
does not affect particle falling rates within the cell. Particle dispersion also affects falling 
rates; therefore, proper particle dispersion is required when using the SediGraph.

Beam-Split

Figure E-5. Beam-Split

Since the top of the cell is used as the reference point for measuring particle falling rates, the 
exact position of the cell (relative to the X-ray beam) must be known in order for particle 
falling rates to be correct. The SediGraph determines the position of the cell by moving the 
cell to the point where the top edge of the cell splits the X-ray beam (exactly in half), and by 
storing this beam-split data in the system computer so that this position can be located for the 
next analysis. Beam-split is done automatically by the system at the start of any automatic 
scanning operation; no message is displayed on the monitor unless beam-split cannot be 
performed for some reason.

Inside Top of
Cell

50% Beam
Detector

100% Beam

X-Ray Source
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Cell Movement

Figure E-6. Cell Movement

The cell is attached to an elevator assembly which moves the cell down during analysis to 
speed the data collection process. The system computer performs the calculations associated 
with particle falling rates as the distances and times are changed according to the movement of 
the cell. For example, as shown in the cell movement illustration, it might take 30 minutes for 
the particle shown to fall the distance from the top of the cell to the X-ray beam; however, by 
moving the cell down, the particle reaches the beam in, perhaps, three minutes. The system 
computer uses this time and distance in determining the particle falling rate.

Particle Dispersion

The particle falling rates also depend upon how well the particles in the cell are dispersed (or 
separated). Joined particles behave as a single particle with a greater falling rate than if the 
joined particles were separate (as shown in the following illustration).

Figure E-7. Affect of Dispersion on Particle Falling Rate

Cell is Moved Down

Joined Particles Have
Higher Falling Rate 
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X-Ray Absorption

In addition to particle falling rates, the SediGraph uses the relative amount of X-ray absorption 
as part of the analysis process. As falling particles in the cell cross the path of the X-ray beam, 
they absorb X-rays. In order for X-ray absorption to be used for measuring the distribution of 
particle masses in the cell: (1) the minimum and maximum X-ray absorption must be 
determined for each X-ray absorption measurement point in the cell; (2) any bubbles in the 
cell must be detected and eliminated; and (3) the particles must be properly dispersed, as 
explained in Appendices B and C.

Baseline (Minimum) Absorption

In order for the X-Ray absorption values to be accurate, a reference (or baseline) must be used 
with each value. This baseline is the amount of X-ray absorption with no particle mass present. 
However, since the sedimentation liquid also absorbs X-rays, the amount of X-ray absorption 
for the liquid must be included in the baseline. The shape of the cell, or cell profile, affects the 
accuracy of baseline X-ray absorption values. The SediGraph automatically determines the 
baseline and makes baseline corrections for any changes in the shape of the cell. This feature is 
called baseline correction. Let’s look at how it works.

When instructed, the SediGraph performs an X-ray scan of the cell filled only with the 
selected sedimentation liquid. The reason for this scan is to determine the amount of X-ray 
absorption of the cell and liquid alone before any particles are introduced. The scan progresses 
from the bottom of the cell toward the top in exactly the same manner as will be done when 
sample particles are present.

As the cell is scanned, X-ray absorption reference values (referred to as baseline values) are 
determined at many points along the cell. The baseline value is the amount of X-ray absorption 
at that point in the cell. The baseline value is for 0% concentration since the cell contains only 
the sedimentation liquid and no particles.

Figure E-8. Baseline (0% Concentration) Absorption

Slight differences in the cell thickness at the measurement points (up to 250) along the cell 
change the amount of X-ray absorption for those points. The amount of X-ray absorption at 

X-Ray Source

X-Rays

Sample Cell

X-Ray Detector

Clear Liquid in
Cell
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each point is stored in the system computer and recalled during the analysis to adjust the 
baseline at those same points in the cell.

The baseline values do not change unless the sedimentation liquid changes, the shape of the 
cell changes, or the X-ray intensity changes. It is, however, recommended that you obtain a 
baseline measurement at the beginning of each shift or whenever a different dispersant (or a 
new batch) is to be used. This assures accurate analysis results. The baseline operation is 
selected from the Unit [n] menu.

Full-Scale (Maximum) Absorption

Before each analysis, the SediGraph examines the cell filled with particles suspended in liquid 
(particles not allowed to sediment). As the cell is being examined, a full-scale X-ray 
absorption value (or maximum absorption) is determined for each point along the cell as 
shown in the following illustration. This full-scale absorption value is for 100% concentration, 
since the cell contains suspended particles, which represents the highest particle concentration 
for that analysis. The full-scale absorption values change with each analysis since a different 
number and composition of particles is used.

Figure E-9. Full-Scale (Maximum) Absorption

The X-ray absorption is measured at up to 250 positions in the cell. This may be reported on 
the Baseline/Full scale report. The full scale scan used in the analysis is computed as the 
average of 10 readings measured at a fixed position.

The full-scale absorption profile operation is performed automatically by the system. Since 
baseline absorption and full-scale absorption are known for each analysis point in the cell 
before the analysis, the absorption during the analysis is a percentage somewhere between 
baseline and full-scale. Using particle falling rate determinations, the system determines the 
size of the particles which have fallen beyond the specific analysis point in the cell. Therefore, 
the absorption percentage at each specific analysis point in the cell indicates the percentage of 
particles that are below a certain particle size. When this is done for a number of points in the 
cell, the particle size distribution can be determined.

X-Rays

Sample Cell

Particle

X-Ray Detector

X-Ray Source
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Bubble Detection/Elimination

If air bubbles are formed in the cell during analysis, the amount of X-ray absorption at those 
points will be detected as a sharp, discrete change. This would make the analysis results 
invalid. In order to prevent this, the SediGraph has a built-in bubble detection and elimination 
feature. This feature automatically detects and removes bubbles from the cell. A message is 
displayed on the screen indicating this operation is in process.

Figure E-10. Bubble Detection/Elimination

Bubbles

Cell Tilted for
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SEDIGRAPH RESULTS RELATIVE TO OTHER METHODS

The SediGraph 5100 Analyzer, sieve analysis, and hydrometer measurements yield particle 
size distributions on a mass (weight) basis. Microscopic measurements result in size data as a 
function of the number of particles. Measurements that involve light scattering, transmission, 
or diffraction relate size most appropriately to particle cross sectional area. Particle counting 
systems, electric zone sensing, gives size in terms of particle volume.

Mass-based measurements can be expected to be in agreement with respect to their reliability 
and the applicability to the size range involved, provided the particles are spherical and solid. 
When the particles are irregular, close agreement should not necessarily be anticipated. Sieve 
analysis, for example, must be very carefully performed with fine particles to ensure complete 
separation according to size without damaging the sieves. Even so, the size determined is not 
necessarily the same as that measured by the SediGraph. The SediGraph determines the size of 
all particles in terms of the E.S.D. (equivalent spherical diameter). Since sieve openings are 
usually square, elongated particles sometimes pass a given sieve in one orientation and at other 
times are retained. These differences obviously lead to differences in results.

Light-based instruments incorporate various means for tuning, calibrating, and data reduction, 
which can make them agree satisfactorily for some materials with most any one of the other 
techniques. Any setting is dependent to a degree on the refractive index of the measured 
particles, however, so agreement cannot be general or over all particle size ranges. The shape 
of the particles also influences all results.

Mass and volume measurements are equivalent numerically. Therefore, analyses with the 
SediGraph and the electric sensing zone can be expected to agree if the particles are spherical, 
solid, and if their size range is sufficiently narrow for all of them to be accurately detected by 
the electric sensing zone. Again, precise agreement is not to be expected with irregular 
particles, for the electric sensing zone measures something closely akin to the diameter an 
irregular particle would assume were it melted into a sphere. This is not necessarily the 
equivalent spherical diameter.

Microscopic measurements yield particle diameters that, for spheres, are essentially E.S.D. As 
before, measured sizes will deviate from E.S.D. when the particles are irregular— the greater 
the irregularity, the greater the deviation. The numbers will not correspond even 
approximately because, as noted above, the measurements are on a different basis. However 
number-based measurements are readily converted into mass-based (or volume-based) results 
by applying the relationship to incremental sizes,

where Y is the mass percent of particles having the diameter D and n the number of particles 
of that diameter. The denominator, therefore, represents the entire spectrum of sizes. The 
following tabulation presents number-based data and calculations leading to the number-based 
and mass-based diameter distributions.

Y nD
3

 nD
3 

-------------------=
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        Comparison of Number and Mass (volume) Size Distributions

Particle 
Diameter 

Range 
(m

D
Largest 

Diameter 
Within 
Range 
(m

n
Number 

of 
Particles 
Within 
Range

Percent 
By 

Number 
Less Than 
Diameter

Percent 
by Mass 

Less Than 
Diameter

5.4 - 5.0 5.4 10 100.0 1575 0.0481 100.0

4.9 - 4.5 4.9 51 99.2 6000 0.1833 95.2

4.4 - 4.0 4.4 65 95.3 5537 0.1692 76.9

3.9 - 3.5 3.9 70 90.3 4152 0.1269 59.9

3.4 - 3.0 3.4 133 84.9 5227 0.1597 47.3

2.9 - 2.5 2.9 160 74.6 3902 0.1192 31.3

2.4 - 2.0 2.4 288 62.3 3981 0.1216 19.4

1.9 - 1.5 1.0 271 40.1 1859 0.0568 7.2

1.4 - 1.0 1.4 162 19.2 445 0.0136 1.5

0.9 - 0.5 0.9 72 6.7 52 0.0016 0.2

0.4 - 0 0.4 14 1.1 1 0.0000 0.0

nD
3 nD

3

 nD
3 

-------------------

1296 n= 32731 nD
3

=

F-4                                                    512-42801-01 (Rev L) Apr 2022



 

G LIQUID DENSITY AND VISCOSITY DATA
512-42801-01 (Rev L) Apr 2022                                                    G-1 



Appendix G SediGraph 5120 Operator’s Manual
G-2                                                    512-42801-01 (Rev L) Apr 2022



SediGraph 5120 Operator’s Manual Appendix G
LIQUID DENSITY AND VISCOSITY DATA

Density and viscosity of pure liquids and solutions (aqueous, by weight) as functions of 
temperature at atmospheric pressure.

Liquid or Solution Temperature
(°C) 

Density

(g/cm3)

Viscosity
(mPa•s)

Ethanol (absolute) 25
30
35

0.7851
0.7808
0.7764

1.096
1.003
0.914

Ethylene Glycol 25
32
40

1.1100
1.1051
1.0995

16.10
12.18
  9.13

Glycerol (10%) 25
30
35

1.0206
1.0192
1.0178

1.1530
1.0240
0.9150

Glycerol (20%) 25
30
36

1.0452
1.0436
1.0400

1.5430
1.3590
1.1743

Glycerol (40%) 25
30
35

1.0970
1.0948
1.0926

3.1860
2.7280
2.3400

Glycerol (50%) 25
30
35

1.1238
1.1211
1.1182

5.041
4.247
3.540

Hexane (n) 25
30
35

0.6550
0.6504
0.6459

0.3046
0.2900
0.2828

Isopropanol 30
32
35

0.7769
0.7752
0.7728

1.7800
1.6800
1.5400

Sucrose (20%) 20
30
40

1.0810
1.0777
1.0737

1.945
1.493
1.184

Sucrose (30%) 20
30
40

1.1270
1.1232
1.1189

3.187
2.373
1.833
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Data extracted from (with interpolation in some cases):

Honig, P., Principles of Sugar Technology, p. 31, Elsevier Publishing Co., New York, 1953.

Swindells, J.F., Snyder, C.F., Hardy, R.C. and Golden, P.E., Viscosities of Sucrose Solutions at 
Various Temperatures: Tables of Recalculated Values, Supplement to N.B.S. Circular 440, 
U.S. Government Printing Office, Washington, 1958.

CRC Handbook of Chemistry and Physics, 59th Edition, The Chemical Rubber Co., 
Cleveland, OH, 1978-79.

The Merck Index, 9th Edition, Merck & Co., Rahway, NJ, 1976.

Liquid or Solution Temperature
(°C) 

Density

(g/cm3)

Viscosity
(mPa•s)

Sucrose (40%) 20
30
40

1.1765
1.1721
1.1676

6.167
4.375
3.241

Sucrose (50%) 20
30
40

1.2296
1.2250
1.2200

15.43
10.11
  6.991

Water 26
32
38

0.9968
0.9951
0.9930

0.8737
0.7679
0.6814

n-Butanol 25
32
40

0.8058
0.8003
0.7940

2.59
2.18
1.78
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SOURCES OF DISPERSING AIDS

Dispersant Source

Aerosol OT  
Aerosol 22

American Cyanamid Company, Process Chemicals 
Department, One-T Cyanamid Plaza, Wayne, NJ 07470

Calcium Chloride Can be purchased at most laboratory supply houses.

Calgon
Calgon T

Calgon Corporation, Water Management Division, Calgon 
Center, P. O. Box 1346, Pittsburgh, PA 15230

Cobalt Citrate Shepherd Chemical Company, Cincinnati, OH 45212

Cobaltous Chloride Can be purchased at most laboratory supply houses.

Daxad 23, 30 Hampshire Chemical Corporation, 55 Hayden Avenue, 
Lexington, MA 02173

Dispex 40 Allied Colloids, 2301 Wilroy Road, Suffolk, VA 23434

FC-134, -161 and -170 3M Company, Chemical Division, St. Paul, MN 55141

Igepal CO-530 GAF Corporation, 1361-T Alps Road, Wayne, NJ 07470

Lomar D Henkel, 300 Brookside Avenue, Ambler, PA 19002

Oleic Acid Can be purchased at most laboratory supply houses.

Renex 648 
Tween 20
Atlas  G-3300 

ICI Americas, Inc., Chemical Division, New Concordville 
Pike, Wilmington, DE 19897

Triton X-100 
Tamol SN

Rohm and Haas Company, Independence Mall West, 
Philadelphia, PA 19105

Sodium Silicate 
“N” Brand

Philadelphia Quartz Company, 1301-T E. Fort Avenue, 
Baltimore, MD 21230

Pyrophosphate (TSPP) Can be purchased at most laboratory supply houses.

Zonyl A, S-13  E. I. DuPont de Nemours and Company, Dyes and Chemical 
Division, 1000-T Market Street, Wilmington,  DE 19898
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SEDISPERSE® PARTICLE DISPERSION LIQUIDS

Description 

Sedisperse A-series and P-series liquids are stable, balanced formulations for dispersing 
insoluble particles. These liquids are primarily saturated aliphatic hydrocarbons. Sedisperse 
A- series liquids are colorless while P-series liquids are pale yellow. These liquids produce 
nearly universal dispersions of powder-liquid systems with solids concentrations below three 
weight percent and to as much as five weight percent in some cases. Sedisperse liquids 
solubilize adsorbed moisture.

Sedisperse W-series liquids are slightly anionic, non-foaming, aqueous formulations for 
dispersing insoluble particles. They also produce nearly universal dispersions of systems with 
solids concentrations generally below three weight percent.

Sedisperse liquids are non-irritating, non-toxic, non-carcinogenic and non-explosive. The 
organic Sedisperse liquids will burn, but will not support combustion at room temperature.

Storage Requirements  

Keep containers closed. Keep containers from freezing. If a container develops a leak during 
storage, transfer it to another clean container. Spillage may be cleaned using detergent and 
water. Sometimes particles may crystallize and settle out of Sedisperse liquids during storage. 
This is usually a result of exposure to cold temperatures. It is corrected by warming the 
Sedisperse to 40-50 °C and then vigorously shaking the liquid in a closed container to re-
dissolve the particulates. Micro-organisms may also begin to grow in Sedisperse W-series 
liquids. These can usually be removed by filtering and the liquid is again usable for particle 
dispersion.

Technical Data  

Recommended techniques for using these liquids:  

1. Disperse particles using energy from an ultrasonic bath or probe accompanied by 
continuous, moderate mechanical agitation to force particles through the nodes of the 
standing ultrasound waves.
512-42801-01 (Rev L) Apr 2022                                                   I-3 



Appendix I SediGraph 5120 Operator’s Manual
2. For sedimentation particle size analysis, first disperse the powder in Sedisperse and 
estimate the size of the largest particles using a microscope. Next, calculate the liquid 
viscosity needed by using the relationship

where

 = minimum viscosity permitted in mPa•s (or cp), 

Dmax = equivalent spherical diameter of the largest particles in m, and 

 = density of the particles in g/cm3.  

This calculation assumes a particle Reynolds number of 0.1. To convert mPa•s to poise, divide 

by 102.  

Material Properties

A Material Safety Data Sheet (MSDS) is supplied with each purchase. It should be consulted 
for the following information:

1. Oral Toxicity.
2. Local effect on eyes.
3. Local effect on skin.
4. Shock Sensitivity.
5. Decomposition characteristics.
6. Heat generation characteristics.
7. Recommended extinguishing agents.
8. Hazard by inhalation.

First Aid Treatment

The Material Safety Data Sheet (MSDS) supplied with each liquid should be consulted for the 
following first aid information:

1. Skin contact.
2. Eye contact.
3. Inhalation.
4. Antidote in case of swallowing.

 0.0023Dmax Dmax  1– =
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DATA REDUCTION

Data Acquisition

The basic data acquired are in the form of cumulative mass percent finer vs. diameter. An 
explanation of the method for acquiring the data is provided below.

Diameter

Diameter for a given set of sedimentation conditions is given by Stokes equation as follows:

where
D = diameter (cm, multiply by 10000 for micrometers)

 = liquid viscosity (poise, multiply by 0.01 for cp)
h = sedimentation height (cm)

 = sample density (g/cm3)

o = liquid density (g/cm3)
g = acceleration due to gravity (981 cm/s/s)
t = sedimentation time (sec)

All data are acquired at one of 220 predetermined sedimentation heights, ranging from 2.54 
cm to 0.0079375 cm. 

Sample density is user-entered. Liquid viscosity and density are user-entered, or they are 
calculated using the sedimentation cell temperature and interpolating from the user-selected 
Liquid Properties Set (see Liquid Properties Interpolation).

Target diameters for data collection are determined as follows:

Up to 250 target diameters are selected, evenly spaced on a log diameter basis, between the 
user-selected starting diameter and ending diameter. Note that this gives the operator some 
choice in the resolution of the data relative to the log diameter axis: selecting a narrower range 
of analysis provides more data points in a given range of diameters. Maximum resolution is 
obtained by selecting starting and ending diameters spanning only one decade (factor of 10), 
providing 250 data points per decade resolution.

D
18

 o g–
-------------------------

1 2 h
t
---

1 2
=
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Target sedimentation heights and times are selected based on run type (high speed, standard, or 
high resolution) and Stokes’ equation.

During analysis, mass % data will be taken at these target heights, and as close to these target 
times as possible, allowing for cell movement, data acquisition delay time, and sequential 
collection of data points. The actual time of data collection will be recorded for each point, so 
that actual diameter may be calculated later.

Height, time, density, and viscosity data are stored separately, so that corrections to density 
and viscosity can be made after the analysis and diameters are recalculated.

Liquid Properties Interpolation

The density and viscosity of the sedimentation liquid at the time of analysis are interpolated as 
follows, using a liquid properties table of three points of density and viscosity versus 
temperature, and the cell temperature reading at the start of analysis.

Density

where
t1, t2, t3 = temperatures from liquid properties table (degrees C)
d1, d2, d3 = densities at t1, t2, t3 respectively (g/cc)
A = first order coefficient
B = second order coefficient
tc = cell temperature reading at start of analysis (degrees C)

o = liquid density at analysis temperature (g/cc)

B ((d2 d1)– (d3– d1) ((t2 t1) / (t3-t1)))––
d1 2 t3 – 

--------------------------------------------------------------------------------------------------------=

A 1 (d2/d1) + B (t2 t1)
2  t2 t1– ––=

o d1 1 A tc t1––  B tc t1–  2 +=
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Viscosity

where
t1, t2, t3    = 1/(t + 273.15) for t = each of the 3 temperatures in the liquid properties

table (t in degrees C)
v1, v2, v3 =  ln(v) for v = each of the 3 viscosities (cp)
A, B, C     = 0th, 1st, and 2nd order coefficients, respectively
tk     = cell temperature at start of analysis (degrees K, i.e. 273.15 + 

degrees C)

     = viscosity at analysis temperature (cp)

Mass Percent

The mass percent of sample present at a given sedimentation height after a given time is 
determined by relating the x-ray transmission intensity at that point to the intensity with no 
sample present (baseline), and the intensity with all of the sample present (full scale):

  mass % =  ( log(Im) - log(Ib) ) / ( log(If) - log(Ib) ) x 100 

where

Im =   intensity at data point (mass % being determined)

Ib =   intensity at baseline (mass % = 0)

If =   intensity at full scale (mass % = 100)

The Ib and If values are average values to minimize random variations in the X-ray intensity. 
The average of these values is used to compute the mass percent.

One set of baseline data may be used for scaling multiple analyses until another set of baseline 
data are collected.

C (v1 (1 ( t1 t2– – t1 t3–    v2– v3 (t1 t2) t1 t3 – – (t1 t2–  (t2 t3))–+=

B v1 v2– C (t1
2

t2
2

–– ))  (t1-t2 )=

A v1 B t1 – C t1
2 –=

 e
A B tk )  +  (C tk

2  +
=

512-42801-01 (Rev L) Apr 2022                                                    J-5 



Appendix J SediGraph 5120 Operator’s Manual
After the sample is loaded while the cell pump is still on and the sample fully suspended and 
evenly distributed throughout the cell, bubble elimination data are collected at between 110 
and 220 predetermined analysis heights, based on the type of bubble elimination selected. In 
addition, a single average full-scale value is computed at the starting analysis height.

Mass percent data appearing on the ‘Analysis Results’ screen has been smoothed with an 11-
point evenly weighted running average.

When data are saved permanently after all analyses on a sample are completed, the mass 
percent values are smoothed before storage in the sample file as follows:

The mass percent values are smoothed with an 11-point running average, just as for the 
‘Analysis Results’ screen. From these data, a set of mass percent values are interpolated at 250 
evenly spaced intervals on a log diameter basis, using linear interpolation between the two 
adjacent collected points to get each evenly spaced point. This is done because the next 
smoothing step requires evenly spaced data points, and the collected data can vary from even 
log diameter spacing due to limitations on time of collection, as noted above.

The evenly spaced mass percent values are smoothed using a digital filter which removes 
high-frequency variations from the data. The final, stored mass percent values are obtained by 
interpolating to a standard size table with 40 logarithmicly, evenly-spaced sizes per decade.
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Reduction of Collected Data

Mass Data

In order to obtain cumulative mass percent data, the smoothed mass percent data scaled to the 
specified full scale value:

For each of the total number of points collected,

Cumulative mass percent coarser data are simply the difference of scaled mass percent finer 
data from 100:

For each of the total number of points collected,

These cumulative mass data (finer and coarser) are represented directly in tabular form and as 
y-axis data in the CUMULATIVE MASS FINER VS. DIAMETER and CUMULATIVE 
MASS COARSER VS. DIAMETER plots (cumulative mass distribution curve). Also, 
cumulative mass data are used to derive mass frequency and log probability data.

Mass Frequency Data

The mass frequency of a particle size interval is the difference between the cumulative mass 
percent interpolated at the end points of the interval. The interpolation is performed using a 
spline fit to the cumulative mass data.

Cumulative Data

Any cumulative quantity can be expressed as Coarser or Finer (Retained or Passed on the 
Tabular Report by Sieve Size). 

For data defined by the standard class sizes (Summary, Tabular Defined by Size Class, and 
Graphs):

   CumFracCoarseri =  FreqFrack for all classes k such that AvgDiamk > AvgDiami

CumMassFiner (%) MassFiner
FullScale

100.0
-------------------------=

CumMassCoarser (%) 100.0 (%) CumMassFiner (%)–=
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   CumFracFineri =  FreqFrack for all classes k such that AvgDiamk < AvgDiami

   CumFracRetaini =  FreqFrack for all classes k such that AvgDiamk > = AvgDiami

   CumFracPassi =  FreqFrack for all classes k such that AvgDiamk < AveDiami 

or equivalently,

   CumFracFineri = 1.0 - CumFracCoarseri-1

   CumFracRetaini = CumFracCoarseri-1

   CumFracPassi = 1.0 - CumFracCoarseri-1

For Tabular Defined by SizeTable or by Sieve Sizes:

CumFrac (Coarser or Finer, Retained or Passed) is calculated for the standard size classes as 
defined above. CumFrac is then interpolated from CumFrac vs. Particle Size at each particle 
size in the Size table or aperture size in the Sieve table.

Peak Report Data

Peak report data are calculated as:

Starting at the small particle size end of the frequency distribution:

1. Scan DiffFreqFraci for a local maximum, i.e.,

DiffFreqFrack > DiffFreqFrack+1, and

DiffFreqFrack > DiffFreqFrack-1

AvgDiamk is the mode of the candidate peak.

2. Scan DiffFreqFraci from class k toward smaller particle sizes to find a local minimum, i.e.,

DiffFreqFracm = 0, or

DiffFreqFracm < DiffFreqFracm+1 and DiffFreqFracm < DiffFreqFracm-1

LowDiamm is the low diameter of the candidate peak.

DiffFreqFraci
FreqFraci

HighDiami

LowDiami
-----------------------------









log

--------------------------------------------=
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3. Scan DiffFreqFraci from class k toward larger particle sizes to find a local minimum, i.e.,

DiffFreqFracn = 0, or

DiffFreqFracn < DiffFreqFracn+1 and DiffFreqFracn < DiffFreqFracn-1

HighDiamn is the high diameter of the candidate peak.

4. Sum values of FreqFraci from i=m to i=n.

If the sum is greater than or equal to the Minimum Fraction to Report, the candidate peak 
is qualified and the sum is the Fraction of Distribution. Other peak quantities are 
calculated using the same formulas as for the entire distribution, except the only range 
from class m to class n isused.

Otherwise, the candidate peak is disqualified.

In either case, peak identification repeats from step 1, starting with class n. When the end of 
the distribution is reached by scanning in either step 1 or step 3, peak identification is 
complete.

In step 1 if the end of the distribution is reached on an increasing frequency slope, i.e., 
DiffFreqFrack > DiffFreqFrack-1, then class k is treated as the mode of a candidate peak and as 
the high size end of the candidate peak.

If the beginning or end of the distribution is reached while scanning for a local minimum in 
step 2 or 3, the beginning or ending class is treated as the local minimum.

For calculating Standard Deviation for N tests, peaks from the various tests are simply 
matched by their order, i.e., peak 1 from test 1 is matched with peak 1 from test 2, etc. If all 
tests do not have the same number of peaks, Standard Deviation for N tests is reported as N/A 
(not available). If the peak numbers are not the same and the user chose average of n tests, a 
single row is filled in with all N/A (including the peak number).

Number Frequency Data

The number frequency is computed from the mass frequency distribution as defined by the 
standard size classes.

For each class:

where

NumFreqN =   NumberfFrequency for class N

NumFreqi

MassFreqi AvgDiami
3

MassFreq AvgDiamk
3

---------------------------------------------------------------=

k
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MassFreqN =  Mass frequency for class N

AvgDiam    =  Average diameter for class N

The cumulative number percent for a class is computed as the summation of the non-negative 
frequencies for all smaller classes.

Surface Area Frequency Data

The surface area frequency is computed from the mass frequency distribution as defined by 
the standard size classes.

For each class:

where

AreaFreqN =   NumberfFrequency for class N

MassFreqN =  Mass frequency for class N

AvgDiam    =  Average diameter for class N

The cumulative number percent for a class is computed as the summation of the non-negative 
frequencies for all smaller classes.

AreaFreqi

MassFreqi AvgDiami

MassFreq AvgDiamk
-------------------------------------------------------------=

k
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Size Statistics

Standard Deviation of Quantity for N Tests

For quantity, substitute the variable name for which the standard deviation is being 
determined. The subscript k refers to the test number.

If NumTests < = 1, StdDevTestQuantity = 0.

Otherwise,

Mode

In order to do a mode calculation, the definition of the standard classes is extended over the 
range of input for all the data; frequencies are calculated for these classes. It is this frequency 
data that is used in determining the peak quantities so that all the classes are of the same width.

  ModeDiam = AvgDiami such that DiffFreqFraci is the maximum DiffFreqFrac

Median

MedianDiam = Diameter interpolated from HighDiam vs. CumFracCoarser at 
CumFracCoarser = 0.5. 

If the calculation is being performed on a peak, the interpolation point is at CumFracCoarser = 
(CumFracCoarserm + CumFracCoarsern)/2.

MeanTestQuantity
Quantityk

NumTests
----------------------------=

StdDevTestQuantity
(Quantityk MeanTest Quantity)

2
–

NumTests 1–
---------------------------------------------------------------------------------------=
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Arithmetic Calculations

Mean

Standard Deviation (of the distribution)

Coefficient of Variation:

Skewness:

Kurtosis

MeanDiam
FreqFrac AvgDiami

FreqFraci

--------------------------------------------------------=

StdDevDiam
FreqFraci (AvgDiam MeanDiam)

2
–

FreqFraci

-----------------------------------------------------------------------------------------------=

CoefVar StdDevDiam
MeanDiam

----------------------------------=

Skew
FreqFraci (AvgDiami MeanDiam)

3
/FreqFraci–

(FreqFraci (AvgDiami MeanDiam)
2
/FreqFraci)

3 2
–

-----------------------------------------------------------------------------------------------------------------------------------------------=

Kurt
FreqFraci (AvgDiami MeanDiam)

4
/FreqFraci–

(FreqFraci (AvgDiami MeanDiam)
2
/FreqFraci)

2
–

------------------------------------------------------------------------------------------------------------------------------------------ 3–=
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+x

where x is a user-selected number.

-x

where x is a user-selected number.

PlusNSig MeanDiam x STdDevDiam+=

MinusNSig MeanDiam x StdDevDiam–=
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Geometric Calculations

Mean 

Standard Deviation (of the distribution)

Standard Deviation of Log

Skewness of Log

Kurtosis of Log

 FreqFracilog(AvgDiami 

FreqFraci

--------------------------------------------------------------------

GeoMeanDiam = 10

10
StdDevLogDiam

StdDevLogDiam
FreqFraci (log(AvgDiam) (GeoMeanDiam))log

2
–

FreqFraci

-----------------------------------------------------------------------------------------------------------------------------------=

SkewLog
FreqFraci (log (AvgDiami) log (GeoMeanDiam))

3
/FreqFraci–

(FreqFraci (log (AvgDiami) log (GeoMeanDiam))
2
/FreqFraci)

3 2–
-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

KurtLog
FreqFraci (log (AvgDiami) log (GeoMeanDiam))

4
/FreqFraci–

(FreqFraci (log (AvgDiami) log (GeoMeanDiam))
2
/FreqFraci)

2
–

------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 3–=
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+x

-x

PlusNSigLog 10
log(GeoMeanDiam) x log (GeoStdDevDiam)+

=

MinusNSigLog 10
log(GeoMeanDiam) x log (GeoStdDevDiam)–

=

512-42801-01 (Rev L) Apr 2022                                                    J-15 



Appendix J SediGraph 5120 Operator’s Manual
Specification/Reference Quantities

Out of Spec

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

CoarseSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Coarse Specification distribution interpolated if the bins are of different size. This is always 
the average of all tests in the named sample file.

FineSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
FineSpecification distribution interpolated if the bins are of different size. This is always the 
average of all the tests in the named sample file.

If {SampCumFracCoarseri-1 > CoarseSpecCumFracCoarseri-1}

OutSpecFracCoarseri = SampCumFracCoarseri-1 - CoarseSpecCumFrac

Coarseri-1

If {SampCumFracCoarseri-1 < FineSpecCumFracCoarseri-1}

OutspecFracCoarseri = SampCumFracCoarser - FineSpecCumFrac

Coarseri-1

or,

OutSpecFracFineri = -OutSpecFracCoarseri-1

OutSpecFracRetaini = OutSpecFracCoarseri-1

OutSpecFracPassi = OutSpecFracCoarseri-1
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Difference from Reference

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

RefSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Reference Specification distribution interpolated if the bins are of different size. This is always 
the average of all the tests in the named sample file.

DiffRefCoarseri = SampCumFraci - RefCumFraci

or,

DiffRefFineri = DiffRefCoarseri-1

DiffRefRetaini = DiffRefCoarseri-1

DiffRefPassi = DiffRefCoarseri-1

Maximum Out of Spec

MaxOutSpecFrac = maximum (abs value (OutSpecFraci))

Pass/Fail by Specification

If MaxOutSpecFrac = 0, PassFail = Passed by Specification

Otherwise, PassFail = FAILED by Specification
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SPC Report Variables

Regression Chart

The line of best for the Regression Chart is calculated by the usual least squares method. If 
there is only a single point, or all N points have the same x-value, there can be no line of best 
fit in the standard form.

The coefficient of correlation for this line also is calculated in the usual way.*

* Mathematical Handbook for Scientists and Engineers, G.A., Korn and T.M. Korn, McGraw Hill, Sec. 
18.4 (1968).

XAve
xi

N
---------=

YAve
yi

N
---------=

Slope
 xi XAve  yi YAve ––

 xi XAve 2–
--------------------------------------------------------------------=

YIntercept YAve Slope XAve–=

x

 xi XAve 2–

N
---------------------------------------=

y

 yi YAve 2–

N
---------------------------------------=
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Control Chart

Cov (x,y) 
 xi XAve  yiAVe –

N
-----------------------------------------------------------=

CorrelationCoef Cov x y 
xy

-------------------------=

Mean
yi

N
---------=

StdDev
 yi Mean 2–

N 1–
--------------------------------------=

CoefVar StdDev
Mean

-------------------=

PlusNSig Mean n STdDev+=

MinusNSig Mean n StdDev–=
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Reynolds Number

The Reynolds Number is calculated as follows:

where  
D = specified starting diameter,

o = liquid density,

 = sample density,

 = liquid viscosity,
g = acceleration due to gravity, and
K = Stokes’ constant = 18.

The Reynolds Number is displayed on the tabular report.

Log Probability Data

Log probability data are a transformation of cumulative mass finer data as a means of 
determining how well cumulative and differential mass data represent statistical normal 
distributions. Since cumulative mass finer data are essentially data indicating the probabilities 
of finding particles of mass finer at given diameters, log normal probability data are a fit of the 
cumulative mass data to the defined, symmetrical probabilities tabulated for a normal 
distribution. 

The log probability table used is a subset of 99 points, ranging from (-2.88, 0.2%) to (0.0, 
50.0%) to (+2.88, 99.8%), from a standard normal distribution table (see log probability 
interpolation table). The x-axis and y-axis data which are plotted on a log probability graph are 
calculated as follows:

1. X-axis boundaries are determined by the spline interpolation at 0.2% and 99.8% from 
cumulative mass finer vs. log diameter. This gives Xprob_beg and Xprob_end, 
respectively.

2. For each of the number of points collected,

If Diameter value is between Xprob_beg and Xprob_end and

if CumMassFiner value is between 0.2% and 99.8%, then

Xprob value = Diameter value

Yprob value = Spline interpolation at CumMassFiner values of the x  vs. y log probability 
table values

Reynolds Number
D m 

10000 m cn 
--------------------------------------

3
o g/cc)  o–  g cc  g cm s s 

K  cp  0.01 (poise/centipoise)) 2
2

-------------------------------------------------------------------------------------------------------=
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Log Probability Interpolation Table

X (%)    Y X (%)    Y  X (%)   Y

0.20 -2.88 33.00 -0.44 68.08 0.47

0.99 -2.33 34.83 -0.39 69.15 0.50

2.02 -2.05 35.94 -0.36 69.85 0.52

3.01 -1.88 37.07 -0.33 70.88 0.55

4.01 -1.75 37.83 -0.31 71.90 0.58

4.95 -1.65 38.97 -0.28 72.91 0.61

5.94 -1.56 40.13 -0.25 73.89 0.64

6.94 -1.48 40.90 -0.23 74.86 0.67

7.93 -1.41 42.07 -0.20 76.11 0.71

9.01 -1.34 42.86 -0.18 77.04 0.74

10.03 -1.28 44.04 -0.15 77.94 0.77

10.93 -1.23 44.83 -0.13 79.10 0.81

11.90 -1.18 46.02 -0.10 79.95 0.84

12.92 -1.13 46.81 -0.08 81.06 0.88

14.01 -1.08 48.01 -0.05 82.12 0.92

14.92 -1.04 48.80 -0.03 82.89 0.95

16.11 -0.99 50.00 0.00 83.89 0.99

17.11 -0.95 51.20 0.03 85.08 1.04

17.88 -0.92 51.99 0.05 85.99 1.08

18.94 -0.88 53.19 0.08 87.08 1.13

20.05 -0.84 53.98 0.10 88.10 1.18

20.90 -0.81 55.17 0.13 89.07 1.23

22.06 -0.77 55.96 0.15 89.97 1.28

22.96 -0.74 57.14 0.18 90.99 1.34

23.89 0.71 57.93 0.20 92.07 1.41

25.14 -0.67 59.10 0.23 93.06 1.48

26.11 -0.64 59.87 0.25 94.06 1.56

27.09 -0.61 61.03 0.28 95.05 1.65

28.10 -0.58 62.17 0.31 95.99 1.75

29.12 -0.55 62.93 0.33 96.99 1.88

30.15 -0.52 64.06 0.36 97.98 2.05

30.85 -0.50 65.17 0.39 99.01 2.33

31.92 -0.47 67.00 0.44 99.80 2.88
512-42801-01 (Rev L) Apr 2022                                                    J-21 



Appendix J SediGraph 5120 Operator’s Manual
                                          Standard Report Tables

Standard Diameter Standard Mass %

300 95

250 90

200 85

150 80

100 75

80 70

60 65

50 60

40 55

30 50

25 45

20 40

15 35

10 30

8 25

6 20

5 15

4 10

3 5

1.5

1

0.8

0.6

0.5

0.4

0.3

0.2

0.1
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SEDIGRAPH X-RAY SAFETY INFORMATION

In a continuing effort to provide maximum safety to operators of Micromeritics equipment, 
and to ensure full compliance with all known government safety regulations regarding X-rays, 
Micromeritics provides a high level of X-ray safety on its SediGraph line.

General

The SediGraph Particle Size Analysis System employs soft X-rays to detect relative particle 
concentration because X-ray absorption is directly proportional to particle mass. This X-ray 
beam is inaccessible to the operator at all times due to cabinet construction, a door enclosing 
the cell compartment, a mechanical shutter that blocks the beam’s entry into the cell 
compartment when that door is opened more than 12 mm (0.5 in.), and electrical interlocks 
that interrupt power to the X-ray tube when the cell compartment door or top panel is opened.

X-ray Source

X-rays are generated by a small, air-cooled tube having a tungsten target inclined at 55o
 to a 

thin beryllium window. It is operated at a potential of 13,600 VDC with a power input of less 
than 41 Watts. The greatest value the anode voltage can attain in a malfunction is 15,000 
VDC. Only the tungsten L-lines are excited, of which the L is primary. This primary radiation 
has an energy of approximately 10,000 eV and a corresponding wavelength of 0.125 nm (1.25 
Angstroms). The integrated radiation density of the direct, unattentuated beam over a 25-mm 
circular aperture is between 300 and 400 milliroentgens per hour. The X-ray beam is, for 
example, 60% blocked by a 51-m (0.002-in.) thick film of the plastic polyvinyl chloride and 
essentially completely blocked by 130-m (0.005-in.) thick steel. Nevertheless, the shutter 
mechanism should never be defeated.

Radiation levels outside the instrument or in the cell compartment when the compartment door 
is open are well below 0.5 milliroentgen per hour. Most jurisdictions require the 
registration of radiation producing devices regardless of kind or intensity level. Check 
with the appropriate authority in your area*.

Since a potential of 13,600 VDC and a current of up to 3 mA generate the X-rays, the 
instrument should be unplugged before any panel is removed for any purpose. This ensures 
that X-ray generation ceases and high voltages are eliminated.

*Based on the above information, SediGraph users in the State of Georgia have regularly been granted waivers to the 
State of Georgia “Rules and Regulations for X-Ray” by the Radiological Health Section of the Georgia Department 
of Human Resources.
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Warning/Indicator Lights

The SediGraph control switches and indicators are located on the front panel of the analytical 
unit and include a keyswitch to turn the X-ray tube on. The key is held captive when the 
keyswitch is on. There are two warning lights: An amber X-RAY STANDBY light and a red 
X-RAY ON light. With the analytical unit connected to the electric mains and the power 
switch on, the amber X-RAY STANDBY light is lit. Turning the keyswitch to the ON position 
causes the red X-RAY ON light to illuminate signaling that power is applied to the X-ray tube. 
When the X-RAY ON light is illuminated, power is applied to both the filament and anode of 
the X-ray tube. If the X-RAY ON lamp filament burns out, then power is interrupted to both 
the filament and anode of the X-ray tube. In order for power to be supplied to the X-ray tube 
filament and anode when a failure (open circuit) occurs in the X-RAY ON light, concurrent 
failures must occur in two independent circuits such that these circuits continue to supply 
power to the X-ray tube.

The SediGraph has magnetically actuated reed switches. These switches are in series with the 
X-RAY ON lamp filament. Whenever the top or back panel of the SediGraph is removed, the 
cell-compartment door is opened, the fluid module is removed, or the X-RAY ON lamp 
filament burns out (opens), both filament and anode power to the X-ray tube are interrupted.

These switches are in addition to the mechanical shutter which operates when the cell 
compartment door is opened, blocking X-rays and and removes filament power when the top 
cover is removed. During the last 12 mm (0.5 in.) of travel of the cell compartment door to the 
fully closed position, the sliding pin actuates the gravity-operated, spring-assisted shutter so 
that the shutter is opened to allow X-rays to enter the cell compartment. When the cell 
compartment door is opened from the fully closed position, the shutter is actuated during the 
first 12 mm (0.5 in.) of travel to close and block x-rays from entering the cell compartment. As 
long as the cell compartment door remains open, the shutter blocks X-rays from entering the 
cell compartment and the X-Ray Detection Indicator remains off.

Now, when the cell compartment door is opened, not only does the shutter block the X-ray 
beam but the power to the X-ray tube also is interrupted.
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MasterTech Installation

The MasterTech should be correctly installed and checked to make sure that it is operating 
properly before actual analyses are attempted. 

Removing Packing Material From the Unit

After removing the MasterTech from the shipping carton, remove all foam packing material 
from the unit before proceeding with installation.

Selecting the Voltage

The MasterTech 052 leaves the factory set for 120 VAC and with the line fuse removed. The 
correct setting of the universal power entrance must be checked and the appropriate fuse 
installed before the MasterTech can be operated. The MasterTech is designed to operate with 
either 100, 120, 220 or 240 VAC at 50 or 60 Hz. Voltage selection and fusing are made at the 
power connector which is located on the rear panel of the unit.

1. Make sure the power cord is disconnected from the MasterTech.

2. Using a pointed object, remove the fuse block and cover assembly from the power 
connector at the rear of the MasterTech.

The power cord should be disconnected from the MasterTech before removing the 
cover from the power input connector. Failure to disconnect the power cord could 
result in electrical shock.
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3. Pull the voltage selector card straight out of the power connector housing.

4. Orient the voltage selector card so that the desired voltage is indicated at the bottom. 
Orient the indicator pin so that it points upward as shown in the following illustration.

5. Insert the voltage selector card into the power connector housing with the edge containing 
the desired voltage first and with the printed side facing the power ON/OFF switch.
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6. Fuse the input power line according to local safety practices. The input power connector 
can be used with either a single-fuse arrangement or a double-fuse arrangement, as shown 
in the following illustration.

a. Observe the position of the fuse block, using the previous figure for reference. If the 
single-fuse arrangement is desired, position the fuse block so that the side with the 
single-fuse slot and the jumper bar is away from the cover. 

If the double-fuse arrangement is desired, position the fuse block so that the side with 
the double-fuse slots is away from the cover.

b. If the fuse block is positioned properly for the fusing desired, proceed to Step c. 

If the fuse block is not positioned properly for the fusing desired:

1) Remove the fuse block retaining screw.
2) Lift the fuse block from the cover.
3) Rotate the fuse block.
4) Mount the fuse block to the cover.
5) Replace the retaining screw.

The power cord should be disconnected from the MasterTech when installing or 
replacing fuses. Failure to do so could result in electrical shock.

The fuses used in the MasterTech must be identical in type and rating to that 
specified. Use of other fuses could result in electrical shock and/or damage to the 
MasterTech.
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c. Insert appropriate fuse(s) for the input power source. Refer to the chart below for the 
appropriate fuse rating.

Power Source                    Fuse                    
100-120 VAC 3AG, 2.00 Amp Slow-Blow
200-240 VAC 5x20 mm, 1.00 Amp Slow-Blow (Type T)

7. Insert fuse block and cover assembly into input power connector (as shown in the 
following illustration) and snap it into place. Once the fuse block and cover assembly are 
in place, the position of the indicator pin shows the input power selected.
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Turning on the MasterTech

1. Make sure the proper operating voltage and fuse are selected and in place.

2. Place the POWER ON/OFF switch, located on the MasterTech rear panel, in the ON ( | ) 
position. The +5 and +24 LEDs on the rear panel and some of the LEDs in the front panel 
switches should illuminate.

3. Press the ARM AUTO/LOAD switch on the front panel of the MasterTech. The arm 
should rise to the Load position, which is used for removal and replacement of the tray.

The ultrasonic probe should not be turned on at this point. Observe the indicator on 
the ULTRASONIC PROBE AUTO/ON switch on the front panel of the MasterTech 
(shown in the following illustration). If the indicator below ON is illuminated, press 
the switch to turn off the probe. The indicator below AUTO should illuminate.

+5 and +24 VDC Indicators

      Power ON/OFF Switch
 

RS232 Connector

Power Display
Intensity Control

Pump Auto/Off
Switch

Ultrasonic Probe     Arm Auto/Load
Auto/On Switch       Switch
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Installing the Beaker Tray

1. Make sure the arm of the MasterTech is in the Load (uppermost) position. When the arm is 
in the Load position, the Load LED is illuminated. If the LED is not illuminated, press the 
ARM AUTO/LOAD switch.

2. Hold the tray firmly by the outside edge. Notice that the bottom of the tray has small slots 
positioned radially outward from the inside edge. Place the tray on the MasterTech so that 
the arm passes through the center opening of the tray.

3. Make sure the drive pin is lined up into a radial slot on the bottom of the tray. The position 
of the tray does not matter at this point.
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Connecting Cables

1. Position the MasterTech next to the SediGraph, making sure that the units are level and 
their bases are at the same height. Alternately, the MasterTech may be placed on top of the 
SediGraph.

2. Make sure that the power switches on the SediGraph and MasterTech are in the OFF 
position.

3. Insert one end of the serial cable into the MasterTech connector on the side panel of the 
SediGraph. 

4. Insert the other end of the cable into the connector labeled RS232 on the back of the 
MasterTech. 

MasterTech connector 
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Installing the Ultrasonic Probe

1. Make sure that the power ON/OFF switch on the rear panel of the MasterTech is in the 
OFF (O) position.

2. Attach the probe cable to the connector labeled Ultrasonic Probe.

3. Ensure that the probe tip is attached to the probe; if not, attach it. A 1/4-in. probe tip is 
supplied with the MasterTech 052. A 1/8-in. tip is also available. (Refer to Chapter 10 for 
ordering information.)

4. Insert the cylinder into the arm, positioning it so that the longer slots slide over the 
protrusions inside the arm. 

5. Insert the probe into the cylinder.

Make sure that no power is supplied to the unit before starting this procedure

Cable Ultrasonic Probe

Cylinder

Arm

Position the shorter slots of the cylinder over the protrusions if you are using the  
1/8-in. probe.
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Installing Sample Transfer Tubing

This section contains one set of instructions for installing the sample transfer tubing in a 
MasterTech with serial number 500 or below, and one set of instructions for a MasterTech with 
serial number 501 or above. Follow the instructions for your unit.

MasterTech with Serial Number 500 or Below

1. Ensure that the MasterTech POWER switch is in the ON position and that the the arm is in 
the LOAD (uppermost) position; the LOAD LED is illuminated. If the LED is not 
illuminated, press the ARM AUTO/LOAD switch.

2. Several segments of flexible tubing are supplied with the MasterTech. Press the end of one 
segment of flexible tubing over the sample transfer tube until there is at least 1/2-in. (1.27 
cm) overlap.

3. Unlatch the pump housing and unscrew the plastic knob on the rear of the pump. 

4. Thread the tubing through the pump as shown above and attach it to the rigid tubing 
labeled L (left) or R (right). Choose the rigid tubing labeled with the side of the 
MasterTech from which you want the fluid to be discharged.

5. Close and latch the housing. Tighten the plastic knob on the rear of the pump sufficiently 
to prevent tubing slippage but not enough to restrict flow through the tubing.

Sample Transfer tube

Flexible Tubing

Arm

Rigid Tubing

Pump

Pump Housing Latch

Plastic knob

Pump Housing
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6. Open the pump chassis cover on the SediGraph by pulling it forward.

7. Drain the system. 

8. Cut the flexible tubing labeled F midway between the mixing pump and the rigid tubing 
connector on the SediGraph; remove and discard the segment remaining on the rigid 
tubing connector.

9. Remove a segment of flexible tubing from the accessories kit and cut a length of 
approximately 1 1/2 inches (3.81 cm) of tubing. 

10. Attach the end of another segment of tubing to the Discharge Tube connector on the front 
of the MasterTech.

11. Thread the other end of the tubing through the hole in the analyzer lower front panel.

12. Attach tubing to the Y-connector as shown below.

13. Attach the tubing from the Y-connector to the rigid tubing connector on the anaylyzer.

14. Close the pump chassis cover.

If the MasterTech is located on top of the SediGraph, use the longer segment of 
tubing (P/N 052-32802-00).

Y-Connector

MasterTech
Mixing Pump Tubing (F)

Tubing Segment
cut in step 7 - 
connects to rigid
tubing connector

Tubing

Y-Connector Mixing Pump
Tubing (F)

Mixing Pump

MasterTech
Tubing

Rigid Tubing
Connector
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MasterTech with Serial Number 501 or Above

1. Make sure that the arm is in the Load (uppermost) position. When the arm is in the Load 
position, the Load LED is illuminated. If the LED is not illuminated, press the ARM 
AUTO/LOAD switch.

2. Unscrew the two thumbscrews from the cover of the pump housing, then remove the 
cover.

3. A 21-in. segment of flexible tubing is shipped with the MasterTech. Remove the cover 
from one of the steel tubes labeled L (Left) or R (Right). Choose the steel tube labeled 
with the side of the MasterTech from which you want the fluid to be discharged. Then 
attach one end of the flexible tubing to the steel tube.

Load position

A                                                        B

A                                                                B
512-42801-01 (Rev L) Apr 2022                                                    L-13



Appendix L SediGraph 5120 Operator’s Manual
4.  Loop the tubing around the pump rollers in a clockwise direction, using one hand to hold 
the two ends of the tubing loop in the two grooves at the base of the pump.

5. Insert the key between the pump rollers near the left side of the pump base, with the key 
blade between the tubing and the plate on the top of the rollers. 

6. Turn the key clockwise so the tubing presses into the groove until the key is stopped by the 
peg in the right side of the pump body.
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7. Slide the key out, then place the cover over the pump, wiggling it slightly to align it with 
the pump body and press it into place. Then insert and tighten the two thumbscrews only 
tight enough to secure the cover.

8. Attach the other end of the flexible tubing to the Sample Transfer tube on the front of the 
MasterTech as shown below.

9. With the instrument schematic displayed, enable Manual Mode. Right-click the 
MasterTech Pump icon and select Turn On.

10. The pump should begin operating. If the pump does not start or is sluggish, pull on the 
long end of the tubing to create tension and pull excess tubing out of the pump, no more 

                                                                            A                                                                   B  
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than 1/4-in. should be required. (Loosen the thumbscrews if necessary.) When the pump is 
operating freely, hand-tighten the two thumbscrews, then turn the pump off.

11. Press the ARM AUTO/LOAD switch to place the arm in the AUTO position.

12. Open the pump chassis cover on the SediGraph by pulling it forward.

13. Drain the system. 

14. Cut the flexible tubing labeled F midway between the mixing pump and the rigid tubing 
connector on the SediGraph; remove and discard the segment remaining on the rigid 
tubing connector.

15. Remove a segment of flexible tubing from the accessories kit and cut a length of 
approximately 1 1/2 inches (3.81 cm) of tubing. 

16. Attach the end of another segment of tubing to the Discharge Tube connector on the front 
of the MasterTech.

17. Thread the other end of the tubing through the hole in the analyzer lower front panel.

If the MasterTech is located on top of the SediGraph, use the longer segment of 
tubing (P/N 052-32802-00).
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18. Attach tubing to the Y-connector as shown below.

19. Attach the tubing from the Y-connector to the rigid tubing connector on the anaylyzer.

20. Close the pump chassis cover.

Y-Connector

MasterTech
Mixing Pump Tubing (F)

Tubing Segment
cut in step 7 - 
connects to rigid
tubing connector

Tubing

Y-Connector Mixing Pump
Tubing (F)

Mixing Pump

MasterTech
Tubing

Rigid Tubing
Connector
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Verifying Operation

To verify operation, manually move each subsystem using the manual control option of the 
SediGraph 5120 analysis program.

1. Make sure that the SediGraph and MasterTech are turned on, and start the SediGraph 
analysis program if it has not been started.

2. Fill at least one of the supplied beakers with approximately 80 mL of water.

3. Place the beaker in the position numbered 1 on the tray.

4. To test the ultrasonic probe, remove it from the holder and insert the tip of the probe well 
into the water.

5. While holding the probe tip underwater, press the ULTRASONIC PROBE AUTO/ON 
switch. You will hear a high-pitched sound, indicating that the probe is working properly.

6. Press the ultrasonic probe AUTO/ON switch again to turn off the probe.

7. Place the probe back into the holder.

NEVER operate the ultrasonic probe without having the tip immersed into a liquid. 
Doing so may harm the probe and/or the driving electronics. DO NOT let the tip of 
the probe come in contact with a glass beaker. Doing so may shatter the beaker.

DO NOT press the ultrasonic probe AUTO/ON switch unless the probe and its cable 
are properly connected to the MasterTech. Doing so may harm the driving 
electronics.
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8. From the Unit [n] menu, select Enable manual control. If the instrument schematic is not 
displayed, select Show instrument schematic.

9. If the arm is in the Load position, press the ARM AUTO/LOAD switch on the front panel 
of the MasterTech to release it.

10. From the Unit [n] menu, select Initialize MasterTech.

A message is displayed indicating that initialization is in process. The tray on the 
MasterTech rotates in a counterclockwise direction for one position, and the arm lowers to 
the Rinse position and returns.

The tray then continues to rotate until position 1 is reached. The beaker inserted in the tray 
in Step 2 should now be directly under the head of the MasterTech. Make sure that the 
beaker contains approximately 80 mL of water.

11. On the instrument schematic, select the symbol representing the MasterTech arm.

MasterTech portion
of the Instrument
Schematic

MasterTech Arm

                Beaker

MasterTech
Pump

 When manual mode is enabled, components on the instrument schematic have 
pop-up menus displaying the options available for that component. Select the 
component, then click the right mouse button to access pop-up menus.
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In each instruction for this step, first access the pop-up menu:

a. Select Move Arm Down; then repeat the step.

b. Select Ultrasonic On; you will hear a high-pitched sound, indicating that the probe is 
operational. Now select Ultrasonic Off.

c. Select Stirrer On; the stirrer begins to operate.

d. Select Speed.

e. Select Move Arm Up.

f. Select Stirrer Off.

g. Select Move Arm Up.

h. Select Move To Next Beaker; note that the display is updated to reflect the position of 
the beaker tray. The picture on the screen should reflect whether or not a beaker is 
present.

12. Select the MasterTech pump. In each instruction in this step, first access the pop-up menu:

a. Select Turn On; the MasterTech pump should begin operating (you will hear a 
whirring sound and the pump will begin to operate).

b. Check the direction of the flow of the MasterTech pump:

Select Flow Direction Load; allows suspension to flow from the MasterTech to the 
SediGraph. This direction is used to load the sample into the mixing chamber of the 
SediGraph.

Select Flow Direction Rinse; allows suspension to move from the SediGraph to the 
MasterTech. This direction is used to rinse the sample from the stirrer and transfer 
tube on the MasterTech.

This concludes verification of operation of the MasterTech. If everything performed as 
described above, the system should be fully operational. If you encountered any problems, 
refer to Chapter 9 for troubleshooting procedures.
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DATA FORMAT FOR UNREDUCED DATA
(OR RAW DATA) REPORTS

This appendix gives the format for sample files exported in ASCII text. All character strings 
are delimited with quotation marks; columns are separated with a comma and white space.

Data can be exported as:

• Smoothed (used in reports)
• Unsmoothed (collected by the instrument)
• Raw (time, height, and mass fraction)

The sizes and mass percents are computed from the raw data collected by the instrument per 
the formulas given in Appendix J.

Header information is displayed first as:

<sample type> //integer, 1=Complete, 2=Analyzing, 4=Entered,
8=No Analysis

<sample ID> //quoted string
<typed of data> SMOOTHED or UNSMOOTHED or RAW
<instrument serial #> //quoted string
<sample material> //quoted string
<liquid> //quoted string

After the header, the following are repeated for each test (analysis) contained in the sample 
file:

<blank line>
<test number> //integer
<start time> //quoted string
<end time> //quoted string
<sample density> //number (g/cc)
<liquid density> //number (g/cc)
<liquid viscosity> //number (cp)
<baseline //number (kilocounts/second)
<full scale> //number (kilocounts/second)
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The following apply to either Smoothed or Unsmoothed:

<size 1>  <percent finer 1> //number (microns), number (fraction)
<size 2>  <percent finer 2>
.
.
.
<size n> <percent finer n>

Instead of the previous information, Raw Data columns are displayed as:

<Height 1> <Time 1> <Counts 1> <Mass Percent 1> <Size 1>
<Height 2> <Time 2> <Counts 2> <Mass Percent 2> <Size 2>
.
.
.
<Height n> <Time n> <Counts n> <Mass Percent n> <Size n>
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Symbols
$ symbol, 3-12, 8-12, 8-15

A
About SediGraph III command, 2-17
Absorption

baseline, E-11
full scale, E-12
X-ray, E-11

Accelerator keys
list of, 2-10
using, 2-9

Add an analyzer command, 4-11
Add button

in liquid properties, 5-16
in material properties, 5-14
in Regression reports, 7-12

Add Log Entry button, 3-19, 5-12
Add Log Entry dialog, 5-12
Advanced command, 3-12, 3-17
Advanced format, 3-14

creating sample information files, 3-17
default sample information file, 8-14
editing default sample information file, 3-12
sample information files, 5-11
selecting, 8-5, 8-8

Air filter, cleaning, 9-17
Air valve

changing position in manual control mode, 6-38
All button, 7-22
Analyses

See also Analyses, performing
high resolution, 6-18
high speed, 6-18
preparing for, 3-4
reference material, 9-8
results relative to other methods, F-3
selecting number to perform, 5-8, 5-21, 5-27, 6-7
selecting report options, 6-11
selecting type, 5-16, 6-18
standard, 6-18
time, 5-17
viewing operation, 6-10

Analyses counter, 6-47
resetting, 6-47

Analyses, performing, 3-5, 3-34, 3-35
MasterTech Automatic method, 3-5, 3-42, 6-20
MasterTech Schedule method, 3-5, 3-44, 6-22
Quick Start method, 3-5, 3-39, 6-14
Repeat Schedule method, 3-5, 3-41, 6-17
Sample Analysis method, 3-5, 3-35, 6-6

Analysis cell
cleaning, 9-10
current conditions, 5-15
draining, 3-30
entering the position in manual control mode, 

6-39
movement, E-10
moving in manual control mode, 6-39
replacing assembly, 9-24
replacing tubing, 9-16
replacing windows, 9-24
rinsing, 6-32
zeroing position in manual control mode, 6-40

Analysis conditions command, 3-22
Analysis conditions files

defining, 3-22
field descriptions, 5-13
opening, 5-5
selecting default, 8-12

Analysis liquids
See Liquids

Analysis log, 3-7
entering comments, 5-12
entering information, 3-19
viewing, 6-10

Analysis options, 3-22, 5-20
Analysis Options dialog, 3-24, 5-20
Analysis program

installing, 4-4
installing new versions, 4-9
uninstalling, 4-17

Analyzer
adding, 4-11
changing setup, 4-15
cleaning, 9-8
controls and indicators, 2-4
description, 1-7
dimensions, 1-15
draining, 6-11, 6-30
front panel, 2-4

     INDEX
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leveling, 9-20
maintaining, 9-7
moving from one computer to another, 4-12
operating in manual control mode, 6-36
ordering parts, 10-3
removing from a computer, 4-14
rinsing, 3-46, 6-32
routine maintenance, 9-22
RS232 connector, 2-5
side panel, 2-5
specifications, 1-15
troubleshooting, 9-3
turning on and off, 2-8

Application setup, 4-8
Apply Changes button

in material properties, 5-19
ARM AUTO/LOAD switch, 2-6
Autorinse, 3-47, 6-32

specifying options, 8-18
Autorinse Options dialog, 8-18
Autoscale, 5-10

in Control Chart reports, 7-15
in reports, 7-28, 7-29
selecting options, 5-30, 6-9, 7-11
when merging data, 5-34

Axis Cross-hair feature, 7-29
Axis Properties dialog, 7-27
Axis range

specifying beginning and ending values, 5-31

B
Baseline

displaying date and average intensity of latest, 
6-46

displaying graph during analysis, 6-12
latest, 3-33
measuring, 3-32, 6-27
measuring alternately with samples, 6-22
performing a series of measurements, 6-22
previous, 3-33
report, 7-6
selecting, 5-18
viewing measurement, 6-28

Baseline command, 3-32, 3-58, 6-4, 7-3
Baseline Measurement dialog, 3-32, 6-27
Baseline report, 3-58
Basic command, 3-10, 3-15
Basic format, 3-14, 8-6

default sample information file, 3-10, 8-11

sample information files, 3-14, 5-7
selecting, 8-5

Beaker
entering number containing sample, 6-23
redispersing sample in, 6-20
starting beaker in automatic analysis, 6-20

Beaker tray, 1-8
aligning, 6-35
installing, L-8

Beamsplit, E-9
finding in manual control mode, 6-40

Bezel, cleaning mixing chamber, 9-8
Board ID button, 6-47
Board ID dialog, 6-47
Boards

See Circuit boards
Bookmarks tab, 1-9
Browse command, 2-12
Bubble detection, 5-22, 9-25
Bubbles

detection, E-13
determining cause, 9-25
elimination, E-13

C
Calculations

arithmetic, J-12
data, J-3
geometric, J-14

Calibration
displaying data, 6-47

Calibration command, 6-5, 6-48
Calibration files

reinstalling, 4-16
Cancel button, 3-8
Cancel command, 2-12
Cautions, 1-5
Cell pump

changing flow direction in manual control 
mode, 6-38

changing speed in manual control mode, 6-38
checking operation, 9-19
replacing tubing, 9-15
resetting, 9-26
selecting speed, 5-22, 6-33, 6-34
turning on and off in manual control mode, 6-38

Change analyzer setup command, 4-15
Check boxes, 2-12
Circuit boards
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displaying identification, 6-47
Cleaning

air filter, 9-17
analysis cell, 9-10
analyzer, 9-8
collimating slits, 9-21
mixing chamber, 9-8
mixing chamber bezel, 9-8

Clear button, 5-9, 7-22
in MasterTech Schedule analysis, 6-25
in particle size or sieve table, 5-33, 6-8
in report options, 5-29

Close All command, 5-3
Close button, 3-8
Close command, 5-3, 5-37
Close reports command, 7-3
Closing

files, 5-37
reports, 7-5

Collected data, 5-32
Collected Data dialog, 5-32
Collimating slits

cleaning, 9-21
Commands

menu, 1-5
push button, 1-6

Comments
entering in default sample information file, 8-16
entering in sample information file, 5-12

Communications port, 4-5
Computer

moving analyzer to another computer, 4-12
specifications, 1-16

Control Chart
calculations, J-19

Control chart command, 3-61
Control Chart Graph Options dialog, 7-14
Control Chart report, 3-61, 7-13

defining the Y-axis, 7-14
recalculating archived results, 7-15
selecting statistics, 7-14

Control chart report command, 7-3
Control Chart Sample Selection dialog, 7-16
Convert command, 3-52, 5-4, 5-42
Converting files, 5-42
Cross-references, 1-12
Cumulative Data

calculation, J-7
Cumulative percent, 6-9
Current button, 7-21, 7-22

Curve Properties dialog, 7-26
Curves

editing in reports, 7-26

D
Data

selecting display options, 8-9
Data entry fields, 2-11
Data points table, 5-29
Data presentation command, 8-9
Dates

selecting range, 2-13
Dates dialog, 2-13
Decrease button, 6-11
Default Basic Sample Information dialog, 3-10, 8-11
Default Fonts dialog, 7-23
Default Reynolds Number dialog, 8-18
Default sample information file, 3-9, 8-11

advanced format, 3-12
basic format, 3-10
editing, 3-10

Delete button, 5-9
in liquid properties, 5-16
in material properties, 5-14
in particle size or sieve table, 5-33, 5-35, 6-8
in Regression reports, 7-12
in report options, 5-29
in reports tool bar, 7-20

Density, 5-8, 5-16, 5-24, 6-7
editing, 6-7
values, G-3

Dialog boxes, 2-11
Diameter

maximum, 5-17
particle range, 1-15
starting and ending, 5-17

Dimensions
MasterTech, 1-16
SediGraph, 1-15

Directory
parameter files, 5-42, 5-43, 8-20

Dispersant
Sedisperse, I-3
sources, H-3

Dispersants, changing during analysis, 6-24
Dispersion

chemical aids, C-3
methods, B-3

Drain and load command, 3-30, 6-4
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Drain and Load dialog, 6-30
Drain and load operation, 3-30, 6-11

methods of performing, 6-30
Draining the system, 9-13

E
Edit button

in MasterTech Schedule analysis, 6-25
in Repeat Schedule analysis, 6-18
in report options, 5-28, 5-30

Enable Manual Control command, 6-4
Entered data, 5-35
Exit command, 5-4, 5-44
Exiting the analysis program, 5-44
Export command, 3-51, 5-4
Exporting files, 5-40
External data

entering, 5-35
merging, 3-16, 5-8, 5-32, 6-8

External Data button, 5-9, 5-33, 6-8

F
File list, 3-50
File menu

description, 5-3
options, 5-3

File names, 2-13
conventions, 2-15
default sequence, 8-11, 8-14
extensions, 2-13, 2-15
sequence numbers, 3-10
valid entries, 5-5
wildcard characters, 2-13

File status, 2-14
Files

selecting, 2-13
selecting status, 2-14

Files list box, 2-13
Filter

See Air filter
Find command, 1-13
Flexible tubing

See Tubing
Frequency

MasterTech, 1-16
SediGraph, 1-15

Full scale mass percent, 5-10, 5-34, 6-9
Full-scale scan

displayed during analysis, 6-12

Fuse
MasterTech, 1-16

G
Graphical report, 3-57
Graphics

adding to a report header, 3-29, 3-54
showing in report headers, 5-26

Graphs, 7-25
editing, 5-30
mass percent vs. particle size, 6-13
selecting grid line type, 8-9
showing and hiding gridlines, 8-9

H
Help menu, 2-17
Hide button, 7-21
Humidity, 1-15

I
Increase button, 6-11
Index, online, 1-12
Initialize MasterTech command, 6-4, 6-35
Insert button, 3-41, 3-44

in MasterTech Schedule analysis, 6-23
in particle size or sieve table, 5-33, 5-35, 6-8
in Repeat Schedule analysis, 6-18
in report options, 5-29

Insert command, 5-9
Installing

analysis program, 4-4
beaker tray, L-8
MasterTech, L-3
new software versions, 4-9
ultrasonic probe, L-10

Instrument log
displaying, 6-44
printing a report, 6-44
selecting information to display, 6-44

Instrument schematic, 6-36
description, 6-42
displaying, 6-42

INTENSITY control, 2-6

K
Keyboard accelerator keys

See Accelerator keys
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L
Legend Properties dialog, 7-27
Level indicator, 9-20
Leveling analyzer, 9-20
Links, 1-11
Liquid properties, 3-22

changing, 5-16, 5-23
entering, 5-23
Interpolation calculations, J-4
values, 5-16, 5-24

Liquid properties command, 3-26
Liquid Properties dialog, 3-26, 5-15, 5-23
Liquid properties files

defining, 3-26
opening, 5-5

Liquids, 1-16
See also Sedisperse dispersing liquids
adding in analysis program, 5-16
adding properties in analysis program, 5-15
analysis, 5-14
suspending, 1-15, 1-16

List command, 3-50, 5-4
Listing

files, 5-39
Lists

generating, 3-50
selecting items, 2-11

Log
See Analysis Log
See Instrument log

Log Probability Data, J-20
Log Probability Interpolation Table, J-21

M
Main Menu bar, 2-16
Maintenance schedule, 9-7
Manual control mode

enabling, 6-36
pop-up menus, 6-36
selecting components, 6-36

Mass Data
calculation, J-7

Mass Frequency Data, J-7
Mass Percent

calculation, J-5
Mass percent

specifying ending percent finer, 5-21
stop at specified, 5-21

MasterTech

+5 and +24 VDC indicators, 2-7
ARM AUTO/LOAD switch, 2-6
connecting cables, L-9
connecting to SediGraph, L-9
controls and indicators, 2-6
description, 1-8
dimensions, 1-16
front panel, 2-6
fuse type, L-6
initializing, 6-35
installing beaker tray, L-8
installing sample transfer tubing, L-11
installing ultrasonic probe, L-10
INTENSITY control, 2-6
moving arm to next beaker in manual control 

mode, 6-41
moving arm up or down in manual control 

mode, 6-40
Power Display, 2-6
POWER ON/OFF switch, 2-7
PUMP AUTO/OFF switch, 2-7
rear panel, 2-7
replacing input power fuse, 9-27
rinsing, 3-48, 6-33
RS232 connector, 2-7
selecting stirrer time and stirrer speed, 5-20
selecting voltage, L-3
specifications, 1-16
troubleshooting, 9-6
turning on, L-7
Warnings, L-3, L-5

MasterTech Automatic analysis method, 3-42
MasterTech Automatic command, 3-42
MasterTech Automatic Mode dialog, 6-20
MasterTech Schedule analysis method, 3-44
MasterTech Schedule command, 3-44, 6-4
MasterTech Schedule Edit dialog, 6-25
MasterTech Schedule Mode dialog, 6-22
Material properties, 3-22, 5-13

updating, 5-18
Material Properties dialog, 3-23
Mean

calculation, J-11
Mixing chamber, 2-5

cleaning, 9-8
cleaning bezel, 9-8
draining, 3-30
increasing or decreasing stirrer speed, 6-11, 6-31
rinsing, 6-32
selecting speed in manual control mode, 6-37
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stirrer speed, 5-21
Mixing pump

checking operation, 9-18
replacing tubing, 9-14
resetting, 9-26
turning on and off in manual control mode, 6-37

Mode
calculation, J-11

Mouse, 2-9
Move an analyzer from one PC to another PC

command, 4-12

N
Notes, 1-5
Number Frequency Data

calculation, J-9

O
ON/OFF switch, analyzer, 2-5
ON/OFF switch, MasterTech, 2-7
Online manual

cross references, 1-12
index, 1-12
printing options, 1-14
using, 1-9
See also Operator’s manual

Open button, 7-21
Open command, 5-3, 5-5
Open Sample Information File dialog, 3-15
Opening

files, 5-5
reports, 7-21

Operator field
changing name, 8-15
omitting, 8-15

Operator’s manual
online, 1-9

Operator’s Manual command, 2-17
Option Presentation command, 8-3
Options menu

description, 8-3
options, 8-3

Ordering
analyzer parts and accessories, 10-3

Out of Spec calculations, J-16
Overflow tube, 3-46, 3-48
Overlays

creating multiple graphs from one sample file, 
3-64

creating the same graph for all tests from one 
sample file, 3-68

creating the same graph for multiple samples, 
3-66

generating, 3-63
selecting files, 5-27
selecting type, 5-31

Overlays button, 3-29, 5-27

P
Parameter files, directory, 5-43, 8-20
Parameters, user, 8-16
Particle diameter, 6-9
Particle size distribution graph, 7-17
Particle size distributions, F-4
Particle size table, 5-9, 5-33, 5-35, 6-8
Parts

ordering, 10-3
Password, restricted format, 8-7
Peak Report Data

calculation, J-8
Plot type, 5-30
Port

See Communications port
Power

MasterTech, 1-16
SediGraph, 1-15

Print button, 7-21
Print command, 5-3, 5-38
Printer

specifying, 8-19
Printing

files, 5-38
instrument log report, 6-44
reports, 7-21

Probe
See Ultrasonic probe

Properties button, 5-15
PSD History command, 3-63, 7-3
PSD History report, 3-63, 7-17
PSD History Sample Selection dialog,, 7-18
PUMP AUTO/OFF switch, MasterTech, 2-7
Pump Control Off/Auto switch, analyzer, 2-5
Pump, MasterTech

changing flow direction in manual control 
mode, 6-41

turning on and off in manual control mode, 6-41
Pumps

See also Cell pump
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See also Mixing pump
displayed in instrument schematic, 6-42
operating in manual control mode, 6-36
symbols in instrument schematic, 6-36

Push buttons, 1-6, 2-11

Q
Quick Start command, 6-4
Quick Start Mode dialog, 6-14

R
Radio buttons, 2-12
Reference button

in report options, 3-29, 5-26
Reference material analysis, 9-8
Reference Quantities, J-16
Reference Sample dialog, 5-26
Regression Chart

calculations, J-18
Regression report, 3-60, 7-10

archiving SPC results, 7-12
selecting axis range, 7-11
selecting X- and Y-Axes variables, 7-10

Regression report command, 3-60, 7-3
Regression Report Sample Selection dialog, 7-11
Re-install calibration files for an analyzer

command, 4-16
Remove an analyzer command, 4-14
Repeat Analysis command, 6-4
Repeat Schedule analysis method, 3-41
Repeat Schedule command, 3-41
Replace All button, 3-20, 5-12

in default sample information file, 8-16
Replace button, 3-14, 3-19, 3-20, 5-10

in default sample information file, 8-13
in material properties, 5-14
in report options, 5-25
in Start Analysis dialog, 6-9

Replace command, 2-12
Replacing

analysis cell assembly, 9-24
analysis cell windows, 9-24
MasterTech input power fuse, 9-27
ultrasonic probe tip, 9-26
X-ray indicator lamps, 9-22

Report button, 6-13, 7-12, 7-18
Report options

changing, 5-25
entering, 5-25

ID, 5-25
Report options command, 3-28
Report Options dialog, 3-28, 5-25
Report options files, 6-7

defining, 3-28
opening, 5-5
selecting default, 8-13

Report Settings button, 3-41, 3-45, 6-25
Reports

adding a graphic to header, 3-54
Baseline, 3-58, 7-6
calculations, J-3
closing, 7-5
Control Chart, 3-61, 7-13
copying as a metafile, 7-28
copying as text, 7-28
deleting, 7-20
displayed on computer screen, 7-20
displaying during an analysis, 6-13
editing axis, 7-27
editing curves, 7-26
editing legends, 7-27
editing title, 7-28
entering title, 3-53
examples, 7-29
generating, 3-6, 3-53
generating automatically after an analysis, 6-11
graphical, 3-57
header, 3-53, 7-19
ordering by ascending or descending data, 5-28
overlays, 3-63
pop-up menus, 7-24
PSD History, 3-63, 7-17
Regression, 3-60, 7-10
removing, 7-21
saving, 7-22
selecting, 5-27, 7-5
selecting a destination, 3-55
selecting defaults, 8-13
selecting fonts, 7-23
selecting scale options, 7-27
selecting type of data, 5-28
showing and hiding gridlines, 7-27
showing graph, 5-26
showing title, 5-25
starting, 7-4
Statistical Process Control (SPC), 3-59, 7-7
tabular, 3-57
tool bar, 7-20
viewing axis coordinates, 7-29
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zooming in and out, 7-28
Reports button, 7-16
Reports List Box, 6-7
Reports menu

description, 7-3
options, 7-3

Resolution, 1-15
Restricted format, 3-14

creating sample information files, 3-14
entering password, 8-7
selecting, 8-5

Resuspension parameters, 6-20
Reynolds number, 3-24, 5-17

calculation, J-20
specifying default, 8-18

Reynolds number command, 8-4, 8-18
Rinse

See also Rinse operation, performing
after analysis, 5-8, 5-22, 6-7, 6-13
cycles, 6-32

Rinse Both command, 3-49
Rinse command, 6-4
Rinse container

adding surfactant, 3-46
Rinse MasterTech command, 3-48
Rinse operation, performing, 3-46, 6-32

both SediGraph and MasterTech, 3-46, 3-49
MasterTech, 3-46, 3-48
SediGraph, 3-46

Rinse SediGraph command, 3-47
Rinse tube, 3-46, 3-48
Rinse valve

changing position in manual control mode, 6-37
RS232 connector, 2-5, 2-7

S
Safety information

X-ray, K-3
Sample

See also Samples, analyzing
beaker tray capacity, 1-16
default identification, 8-12, 8-15
dispersion, B-3
loading, 3-30, 6-11
size, 1-15, 1-16
transfer tubing, installing, L-11

Sample Analysis command, 3-35, 6-4, 6-6
Sample Analysis dialog box, 6-6
Sample analysis window

resizing, 6-13
Sample defaults, 8-11
Sample defaults command, 3-10, 3-12, 8-4, 8-11
Sample Defaults dialog, 3-12
Sample file

See Sample information files
Sample Information command, 3-15, 3-17, 3-19
Sample information files

See also Default sample information file
advanced format, 3-17, 5-11, 8-8, 8-14
basic format, 3-14, 5-7, 8-6
converting, 3-5, 3-52, 5-42
copying, 3-19
creating, 3-3, 3-14
creating automatically in QuickStart, 6-14
defined, 3-3
defining, 3-3
entering default comments, 8-16
exporting, 3-51
field descriptions, 5-6
listing, 3-5
opening, 5-5
organizing and storing, 5-6
replacing, 3-19
restricted format, 3-14, 8-7

Sample materials
adding properties in analysis program, 5-14

Samples, analyzing
a series, 6-14
a series with different conditions, 6-22
a series with the same conditions, 6-20
alternately with baseline collection, 6-22
individual samples, 6-6
the same sample multiple times, 6-17

Save All command, 5-3, 5-37
Save as button, 7-22
Save As command, 5-3, 5-36
Save as Default button, 7-16, 7-18
Save button, 7-22
Save command, 2-12, 5-3, 5-36
Saving

all open files, 5-37
changes in a file, 5-36
files under a different name, 5-36

SediGraph
See Analyzer

SediGraph 5120 application
See Analysis program

Sedimentation
method of analysis, E-6
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theory, E-3
Sedimentation liquids

See  Liquids
Sedisperse dispersing liquids, I-3

material properties, I-4
storage requirements, I-3
technical data, I-3

Service test
performing, 8-5

Service Test command, 6-5, 6-48
Service Test mode, 6-48
Service Test Mode command, 8-3, 8-5
Set Baseline button, 5-18
Set point, temperature, 6-37
Setup

changing, 4-8
Shortcut keys

See Accelerator keys
Show button, 7-20
Show Date Range radio button, 2-14
Show Instrument Schematic command, 6-4
Show Status command, 6-5, 6-43
Shown button, 7-22
Sieve table, 5-9, 5-33, 5-35, 6-8

specifying defaults, 8-10
Sieves command, 8-3
Size axis, inverting, 8-9
Size Statistics

calculation, J-11
Software version

displaying, 6-46
SPC Analysis Options dialog, 7-8
SPC Calculations dialog, 7-7
SPC Percentile Options dialog, 7-8
SPC report options command, 3-59, 7-3
SPC reports, 3-59, 7-7

Control Chart report, 3-59
Regression report, 3-59
selecting analysis conditions, 7-8
selecting parameters, 7-8
selecting peaks, 7-9
selecting percentiles, 7-8
user parameters, 8-16

SPC Sample Options dialog, 7-8
Specification button, 3-29, 5-26
Specification Samples dialog, 5-26
Specifications

analyzer, 1-15
computer, 1-16
MasterTech, 1-16

Standard Report Tables, J-22
Start button, 3-7, 3-43, 3-45, 6-17, 6-21, 6-26
Start report button, 3-57
Start Report command, 7-4
Start Report dialog, 3-57
Status display, 3-3

lower display, 3-9
upper display, 3-7

Stirrer, MasterTech
changing the speed in manual control mode, 6-41
selecting speed, 5-20, 6-21, 6-24
selecting time, 5-20, 6-20, 6-24
turning on and off in manual control mode, 6-41

Stirrer, mixing chamber
increasing or decreasing speed, 6-11

Stokes' Law, D-3
Stop button, 3-43, 3-45, 6-21, 6-26
Subdialog boxes, 2-11
Submitter field

changing name, 8-15
omitting, 8-15

Summary Statistics button, 7-13, 7-14
Surface Area Frequency Data

calculation, J-10
Suspending liquids

See Liquids
System Configuration command, 8-19

T
Table of Contents, online, 1-11
Tables

data points, 5-29
editing, 5-28
particle size, 5-33, 5-35, 6-8
sieve, 5-33, 5-35, 6-8

Tabular reports, 3-57, 7-11, 7-15, 7-24
Temperature

displayed, 5-17
MasterTech, 1-16
SediGraph, 1-15
set point, 6-37
setting target, 6-37, 6-48

Temperature stabilization, 5-21
Thumbnails tab, 1-14
Troubleshooting, 9-3
Tubing

analyses remaining on current set, 6-47
entering number of analyses per set, 6-47
replacing, 9-13, 9-16
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replacing cell pump, 9-15
replacing mixing pump, 9-14
rinsing both SediGraph and MasterTech, 6-34
rinsing MasterTech, 6-33
rinsing SediGraph, 6-32

U
Ultrasonic probe, 1-8

AUTO/ON switch, 2-6
Caution, L-7
entering resuspension time, 6-21
installing, L-10
replacing tip, 9-26
selecting time, 5-21, 6-24
turning on or off in manual control mode, 6-40

Uninstall command, 4-17
Unit configuration

displaying, 6-46
Unit Configuration command, 6-5, 6-46
Unit menu, 6-3

description, 6-3
options, 6-3

Units Selection dialog, 8-9
Units, selecting, 8-9
Update Material Properties dialog, 5-18
Update Properties button, 5-18
User parameters, 5-12, 8-16

omitting, 8-16
specifying, 8-16

V
Valves

in instrument schematic, 6-42
operating in manual control mode, 6-36

Verifying operation
MasterTech, L-18

View
selecting, 3-7, 6-10

Viewing
analysis log, 6-10
instrument schematic, 6-10
operation, 6-10

Viscosity, 5-16, 5-24
calculations, J-5
values, G-3

Voltage
MasterTech, 1-16
SediGraph, 1-15

Voltage, selecting
MasterTech, L-3

W
Warnings, 1-5
Waste tube, 3-46, 3-48
Waste valve

changing position in manual control mode, 6-37
Wetted materials, 1-15, 1-16
Wildcard characters, 2-13
Windows command, 2-17
Windows menu, 2-17

X
X-Axis

selecting how values are displayed, 5-30
X-ray

absorption, E-11
assembly, 1-7
safety information, K-3
source, K-3
warning and indicator lights, K-3

X-ray indicator lamps, replacing, 9-22
X-ray intensity

low, 5-16, 5-24
normal, 5-16, 5-24
reduction, 3-31, 6-12, 6-31
selecting, 3-27, 5-16, 5-24
selecting in manual control mode, 6-39, 6-40

X-Ray Keyswitch, 2-4
X-RAY ON indicator, 2-4
X-Ray STANDBY indicator, 2-4

Z
Zoom feature, 7-28
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